
 

HEC-SSP 
Statistical Software Package 
 

 
 

User’s Manual 
 
 
Version 2.0 
October 2010 
 
 
Approved for Public Release.  Distribution Unlimited.  CPD-86 



 Standard Form 298 (Rev. 8/98) 
 Prescribed by ANSI Std. Z39-18 
 

REPORT DOCUMENTATION PAGE Form Approved OMB No. 0704-0188 
The public reporting burden for this collection of information is estimated to average 1 hour per response, including the time for reviewing instructions, searching 
existing data sources, gathering and maintaining the data needed, and completing and reviewing the collection of information.  Send comments regarding this 
burden estimate or any other aspect of this collection of information, including suggestions for reducing this burden, to the Department of Defense, Executive 
Services and Communications Directorate (0704-0188).  Respondents should be aware that notwithstanding any other provision of law, no person shall be 
subject to any penalty for failing to comply with a collection of information if it does not display a currently valid OMB control number. 
PLEASE DO NOT RETURN YOUR FORM TO THE ABOVE ORGANIZATION. 
1.  REPORT DATE (DD-MM-YYYY) 
October 2010 

2.  REPORT TYPE 
Computer Program Documentation 

3.  DATES COVERED (From - To) 

4.  TITLE AND SUBTITLE 
HEC-SSP 
Statistical Software Package 
Version 2.0 

5a.  CONTRACT NUMBER 

5b.  GRANT NUMBER 
5c.  PROGRAM ELEMENT NUMBER 

6.  AUTHOR(S) 
Gary W. Brunner and Matthew J. Fleming 

5d.  PROJECT NUMBER 
5e.  TASK NUMBER 
5F.  WORK UNIT NUMBER 

7.  PERFORMING ORGANIZATION NAME(S) AND ADDRESS(ES) 
US Army Corps of Engineers 
Institute for Water Resources 
Hydrologic Engineering Center (HEC) 
609 Second Street 
Davis, CA  95616-4687 

8.  PERFORMING ORGANIZATION REPORT NUMBER 
CPD-86 

9.  SPONSORING/MONITORING AGENCY NAME(S) AND ADDRESS(ES) 10.  SPONSOR/ MONITOR'S ACRONYM(S) 

11.  SPONSOR/ MONITOR'S REPORT NUMBER(S) 

12.  DISTRIBUTION / AVAILABILITY STATEMENT 
Approved for public release; distribution is unlimited. 
13.  SUPPLEMENTARY NOTES 
14.  ABSTRACT 
The Hydrologic Engineering Center's Statistical Software Package (HEC-SSP) allows the user to perform statistical 
analyses of hydrologic data.  The current version of HEC-SSP can perform flood flow frequency analysis based on Bulletin 
17B, a general frequency analysis using any type of hydrologic data, a volume frequency analysis, a duration analysis, a 
coincident frequency analysis, and a curve combination analysis.  Data storage and management is handled either through 
the use of text files (ASCII, XML), as well as the Hydrologic Engineering Center's Data Storage System (HEC-DSS). 
 
 
 
 
 
 
 
 
 
 
 
15.  SUBJECT TERMS 
HEC-SSP, flood frequency, statistics, Bulletin 17B, flow, stage, computer program, hydrologic data, volume-duration, 
statistical analysis, data storage, reporting tools, frequency curves, confidence limits, low outliers, high outliers, regional 
skews 

16. SECURITY CLASSIFICATION OF: 17. LIMITATION  
 OF 
 ABSTRACT 
 UU 

18. NUMBER 
 OF 
 PAGES 
 313 

19a.  NAME OF RESPONSIBLE PERSON 
 a.  REPORT 

 U 
b.  ABSTRACT 
 U 

c.  THIS PAGE 
 U 

19b.  TELEPHONE NUMBER 
 



 
 
 
 
 
 
 
 
 

HEC-SSP 
Statistical Software Package 
 
 
 
 
 
 
 
 
 

User’s Manual 
 
 
 
 
 

October 2010 
 
 
 
 
 
 
 
 
 
US Army Corps of Engineers 
Institute for Water Resources 
Hydrologic Engineering Center 
609 Second Street 
Davis, CA  95616 
 
(530) 756-1104 
(530) 756-8250 FAX 
www.hec.usace.army.mil CPD-86 



 

 

Statistical Software Package, HEC-SSP 
Software Distribution and Availability Statement 

 

The HEC-SSP executable code and documentation are public domain and were developed by 
the Hydrologic Engineering Center for the U.S. Army Corps of Engineers.  The software was 
developed with United States Federal Government resources, and is therefore in the public 
domain.  This software can be downloaded for free from the HEC internet site 
(www.hec.usace.army.mil).  HEC does not provide technical support for this software to 
non-Corps users.  However, we will respond to all documented instances of program errors. 
Documented errors are bugs in the software due to programming mistakes not model 
problems due to user-entered data. 

 



HEC-SSP User's Manual Table of Contents 
 

 i 

Table of Contents 
CHAPTER  1 ................................................................................................................................. 1-1 

Introduction .................................................................................................................................... 1-1 
Contents ............................................................................................................................ 1-1 

General Philosophy of the HEC-SSP ..................................................................................... 1-2 
Overview of Program Capabilities .......................................................................................... 1-2 

User Interface .................................................................................................................... 1-2 
Statistical Analysis Components ....................................................................................... 1-3 
Data Storage and Management ........................................................................................ 1-3 
Graphical and Tabular Output ........................................................................................... 1-4 

Overview of This Manual ........................................................................................................ 1-4 

CHAPTER  2 ................................................................................................................................. 2-1 

Installing HEC-SSP ....................................................................................................................... 2-1 
Contents ............................................................................................................................ 2-1 

Hardware and Software Requirements .................................................................................. 2-2 
Installation Procedure ............................................................................................................ 2-2 

To install the software onto your hard disk do the following: ............................................. 2-2 
Uninstall Procedure ................................................................................................................ 2-3 

CHAPTER  3 ................................................................................................................................. 3-1 

Working With HEC-SSP - An Overview ........................................................................................ 3-1 
Contents ............................................................................................................................ 3-1 

Starting HEC-SSP .................................................................................................................. 3-2 
To Start HEC-SSP from Windows: .................................................................................... 3-2 

Overview of the Software Layout ........................................................................................... 3-2 
Steps in Performing a Bulletin 17B Frequency Analysis ......................................................3-10 

Starting a New Study ....................................................................................................... 3-10 
Adding a Background Map .............................................................................................. 3-11 
Importing, Entering, and Editing Data ............................................................................. 3-13 
Performing the Bulletin 17B Flow Frequency Analysis ................................................... 3-17 
Viewing and Printing Results ........................................................................................... 3-18 

CHAPTER  4 ................................................................................................................................. 4-1 

Using the HEC-SSP Data Importer ............................................................................................... 4-1 
Contents ............................................................................................................................ 4-1 

Developing a New Data Set ................................................................................................... 4-2 
Importing Data from an HEC-DSS File .............................................................................. 4-3 
Importing Data from the USGS Website ........................................................................... 4-4 
Importing Data from an Excel Spreadsheet ...................................................................... 4-7 
Entering Data Manually ................................................................................................... 4-10 
Importing Data from a Text File ....................................................................................... 4-11 

Metadata ..............................................................................................................................4-15 
Plotting and Tabulating the Data ..........................................................................................4-17 

CHAPTER  5 ................................................................................................................................. 5-1 

Performing a Bulletin 17B Flow Frequency Analysis .................................................................... 5-1 
Contents ............................................................................................................................ 5-1 

Starting a New Analysis ......................................................................................................... 5-2 
General Settings, Options, and Computations ....................................................................... 5-3 

General Settings ................................................................................................................ 5-3 
Generalized Skew .......................................................................................................... 5-3 
Expected Probability Curve ............................................................................................ 5-4 



Table of Contents HEC-SSP User's Manual 

ii 

Plotting Positions ............................................................................................................ 5-4 
Confidence Limits ........................................................................................................... 5-5 
Time Window Modification .............................................................................................. 5-5 

Options ............................................................................................................................... 5-5 
Low Outlier Threshold..................................................................................................... 5-6 
Historic Period Data ........................................................................................................ 5-7 
User Specified Frequency Ordinates .............................................................................. 5-8 

Compute ................................................................................................................................ 5-8 
Viewing and Printing Results ................................................................................................. 5-8 

Tabular Output ................................................................................................................... 5-9 
Graphical Output .............................................................................................................. 5-10 
Viewing the Report File .................................................................................................... 5-12 

CHAPTER  6 ................................................................................................................................. 6-1 

Performing a General Frequency Analysis ................................................................................... 6-1 
Contents ............................................................................................................................. 6-1 

Starting a New Analysis ......................................................................................................... 6-2 
General Settings and Options ................................................................................................ 6-3 

General Settings ................................................................................................................ 6-3 
Log Transform ................................................................................................................ 6-3 
Plotting Positions ............................................................................................................ 6-4 
Confidence Limits ........................................................................................................... 6-4 
Time Window Modification .............................................................................................. 6-5 

Options ............................................................................................................................... 6-5 
Low Outlier Threshold..................................................................................................... 6-6 
Historic Period Data ........................................................................................................ 6-7 
User Specified Frequency Ordinates .............................................................................. 6-8 
Output Labeling .............................................................................................................. 6-8 

Analytical Frequency Analysis ............................................................................................... 6-8 
Settings .............................................................................................................................. 6-9 

Distribution .................................................................................................................... 6-10 
Generalized Skew ......................................................................................................... 6-10 
Expected Probability Curve .......................................................................................... 6-11 

Compute .............................................................................................................................. 6-11 
Tabular Results ................................................................................................................ 6-11 
Plot ................................................................................................................................... 6-13 

Graphical Frequency Analysis ............................................................................................. 6-15 
Viewing and Printing Results ............................................................................................... 6-16 

Tabular Output ................................................................................................................. 6-16 
Graphical Output .............................................................................................................. 6-17 
Viewing the Report File .................................................................................................... 6-19 

CHAPTER  7 ................................................................................................................................. 7-1 

Performing a Volume Frequency Analysis .................................................................................... 7-1 
Contents ............................................................................................................................. 7-1 

Starting a New Volume Frequency Analysis ......................................................................... 7-2 
General Settings and Options ................................................................................................ 7-3 

General Settings ................................................................................................................ 7-3 
Log Transform ................................................................................................................ 7-3 
Plotting Positions ............................................................................................................ 7-4 
Maximum or Minimum Analysis ...................................................................................... 7-5 
Year Specification ........................................................................................................... 7-5 
Time Window Modification .............................................................................................. 7-6 

Options ............................................................................................................................... 7-7 
Flow-Durations ................................................................................................................ 7-8 
User Specified Frequency Ordinates .............................................................................. 7-9 



HEC-SSP User's Manual Table of Contents 
 

 iii 

Output Labeling .............................................................................................................. 7-9 
Low Outlier Threshold .................................................................................................. 7-10 
Historic Period Data ..................................................................................................... 7-10 

Extracting The Volume-Duration Data .................................................................................7-12 
Analytical Frequency Analysis .............................................................................................7-14 

Settings ............................................................................................................................ 7-15 
Distribution ................................................................................................................... 7-15 
Expected Probability Curve .......................................................................................... 7-16 
Skew ............................................................................................................................ 7-16 

Compute ...............................................................................................................................7-17 
Tabular Results ............................................................................................................... 7-17 
Plot ................................................................................................................................... 7-18 
Statistics .......................................................................................................................... 7-19 

Graphical Frequency Analysis .............................................................................................7-20 
Curve Input ...................................................................................................................... 7-21 
Plot ................................................................................................................................... 7-21 

Viewing and Printing Results – Volume Frequency Analysis ..............................................7-22 
Tabular Output ................................................................................................................. 7-22 
Graphical Output ............................................................................................................. 7-23 
Viewing the Report File ................................................................................................... 7-24 

CHAPTER  8 ................................................................................................................................. 8-1 

Performing a Duration Analysis ..................................................................................................... 8-1 
Contents ............................................................................................................................ 8-1 

Starting a New Analysis ......................................................................................................... 8-2 
General Settings and Options ................................................................................................ 8-3 

General .............................................................................................................................. 8-3 
Method ........................................................................................................................... 8-3 
X-Axis Scale ................................................................................................................... 8-3 
Y-Axis Scale ................................................................................................................... 8-4 
Time Window Modification ............................................................................................. 8-4 
Duration Period .............................................................................................................. 8-4 

Options .............................................................................................................................. 8-5 
Output Labeling .............................................................................................................. 8-6 
Plotting Position Formula ............................................................................................... 8-6 
User-Specified Exceedance Ordinates .......................................................................... 8-7 
Bin Limits ........................................................................................................................ 8-7 

Compute ................................................................................................................................. 8-8 
Results ................................................................................................................................... 8-9 

Tabular Results ................................................................................................................. 8-9 
Plot ................................................................................................................................... 8-10 
Manual Duration Analysis ................................................................................................ 8-11 

Viewing and Printing Results ...............................................................................................8-12 
Tabular Output ................................................................................................................. 8-12 
Graphical Output ............................................................................................................. 8-13 
Viewing the Report File ................................................................................................... 8-14 

CHAPTER  9 ................................................................................................................................. 9-1 

Performing a Coincident Frequency Analysis ............................................................................... 9-1 
Contents ............................................................................................................................ 9-4 

Starting a New Analysis ......................................................................................................... 9-4 
General Settings .................................................................................................................... 9-5 

Variable A .......................................................................................................................... 9-5 
Variable B .......................................................................................................................... 9-5 
Output Labeling ................................................................................................................. 9-6 



Table of Contents HEC-SSP User's Manual 

iv 

Y-Axis Scale ....................................................................................................................... 9-6 
User Specified Frequency Ordinates ................................................................................. 9-6 

Variable A .............................................................................................................................. 9-7 
Variable B .............................................................................................................................. 9-8 
Response Curves ................................................................................................................ 9-11 
Compute .............................................................................................................................. 9-14 
Results ................................................................................................................................. 9-15 
Viewing and Printing Results ............................................................................................... 9-16 

Tabular Output ................................................................................................................. 9-16 
Graphical Output .............................................................................................................. 9-16 
Viewing the Report File .................................................................................................... 9-18 

CHAPTER  10 ............................................................................................................................. 10-1 

Performing a Curve Combination Analysis ................................................................................. 10-1 
Contents ........................................................................................................................... 10-2 

Starting a New Analysis ....................................................................................................... 10-2 
General Settings .................................................................................................................. 10-3 

Number of Curves ............................................................................................................ 10-3 
Output Labeling ................................................................................................................ 10-3 
Data Type ......................................................................................................................... 10-4 
Y-Axis Scale ..................................................................................................................... 10-4 
Confidence Limits Method ................................................................................................ 10-4 
Frequency of PMF ............................................................................................................ 10-5 
Confidence Limits ............................................................................................................. 10-6 
User Specified Frequency Ordinates ............................................................................... 10-7 

Frequency Curves................................................................................................................ 10-7 
Confidence Limits ................................................................................................................ 10-9 
Compute ............................................................................................................................ 10-12 
Results ............................................................................................................................... 10-12 
Viewing and Printing Results ............................................................................................. 10-13 

Tabular Output ............................................................................................................... 10-13 
Graphical Output ............................................................................................................ 10-13 
Viewing the Report File .................................................................................................. 10-15 

References ................................................................................................................................... A-1 
Example Data Sets ...................................................................................................................... B-1 

Example 1: Fitting the Log-Pearson Type III Distribution ..................................................... B-4 
Example 2: Analysis with High Outliers .............................................................................. B-12 
Example 3: Testing and Adjusting for a Low Outlier ........................................................... B-20 
Example 4: Zero-Flood Years ............................................................................................. B-28 
Example 5: Confidence Limits and Low Threshold Discharge ........................................... B-36 
Example 6: Use of Historic Data and Median Plotting Position .......................................... B-44 
Example 7: Analyzing Stage Data ...................................................................................... B-52 
Example 8: Using User-Adjusted Statistics ........................................................................ B-59 
Example 9: General Frequency – Graphical Analysis ........................................................ B-69 
Example 10: Volume Frequency Analysis, Maximum Flows .............................................. B-76 
Example 11: Volume Frequency Analysis, Minimum Flows ............................................... B-87 
Example 12: Duration Analysis, BIN (STATS) Method ....................................................... B-98 
Example 13: Duration Analysis, Rank All Data Method .................................................... B-104 
Example 14: Duration Analysis, Manual Entry ................................................................. B-110 
Example 15: Coincident Frequency Analysis, A and B can be Assumed Independent ... B-113 
Example 16: Coincident Frequency Analysis, A and B can not be Assumed IndependentB-120 
Example 17: Curve Combination Analysis, Combine Flow Frequency Curves ................ B-127 
Example 18: Curve Combination Analysis, Combine Stage Frequency Curves .............. B-132 

 



HEC-SSP User's Manual Foreword 

 v 

Foreword 

The U.S. Army Corps of Engineers’ Statistical Software Package (HEC-
SSP) is software that allows you to perform statistical analyses of 
hydrologic data.   

The first official version of HEC-SSP (version 1.0) was released in 
August of 2008.  Version 1.1 was released in April, 2009 and included 
improvements to data entry, results visualization and reporting, and 
added capability to the volume frequency analysis.  These new 
features are discussed in the User’s Manual and in the release notes 
for Version 1.1.  Version 2.0 was released in October 2010 and 
included three new analyses: a duration analysis, a coincident 
frequency analysis, and a curve combination analysis.  These new 
features are discussed in the User’s Manual and in the release notes 
for Version 2.0.   

The HEC-SSP software was designed by Mr. Gary Brunner, Mr. Jeff 
Harris, Dr. Beth Faber, and Mr. Matthew Fleming.  The HEC-SSP user 
interface was programmed by Mr. Mark Ackerman, and the 
computational code was programmed by Mr. Paul Ely.  This manual 
was written by Mr. Gary Brunner and Mr. Matthew Fleming.   
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C H A P T E R   1   

Introduction 

Welcome to the U.S. Army Corps of Engineers Statistical Software 
Package (HEC-SSP) developed by the Hydrologic Engineering Center.  
This software allows you to perform statistical analyses of hydrologic 
data.  The current version of HEC-SSP can perform flood flow 
frequency analysis based on Bulletin 17B, "Guidelines for Determining 
Flood Flow Frequency" (1982), a generalized frequency analysis on not 
only flow data but other hydrologic data as well, a volume frequency 
analysis on high and low flows, a duration analysis, a coincident 
frequency analysis, and a curve combination analysis.   

The HEC-SSP software system was developed as a part of the 
Hydrologic Engineering Center's "Next Generation" (NexGen) 
development of hydrologic engineering software.  The NexGen project 
encompasses several aspects of hydrologic engineering, including 
rainfall-runoff analysis, river hydraulics, reservoir system simulation, 
flood damage analysis, and real-time river forecasting for reservoir 
operations. 

This chapter discusses the general philosophy of HEC-SSP and gives a 
brief overview of the capabilities of the software system.  An overview 
of this manual is also provided. 

Contents 
• General Philosophy of the HEC-SSP 

• Overview of Program Capabilities 

• Overview of This Manual 
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General Philosophy of the HEC-SSP 

HEC-SSP is an integrated system of software, designed for interactive 
use in a multi-tasking environment.  The system is comprised of a 
graphical user interface (GUI), separate statistical analysis 
components, data storage and management capabilities, mapping, 
graphics, and reporting tools. 

Over a period of many years, the Hydrologic Engineering Center has 
supported a variety of statistical packages that perform frequency 
analysis and other statistical computations. Historically, the programs 
that received the most use within the Corps of Engineers were HEC-
FFA (Flood Frequency Analysis) and STATS (Statistical Analysis of Time 
Series Data).  FFA incorporates Bulletin 17B procedures that have 
been adopted by the Corps for flow frequency analysis.  The STATS 
software package is used for statistical analysis of time series data.  
STATS can provide either analytical or graphical frequency analysis, 
specified by the user.  STATS has the capability of computing monthly 
and annual maximum, minimum, and mean values along with 
computing a volume-duration analysis.  Two other packages that have 
received a lot of use within the Corps of Engineers are REGFRQ 
(Regional Frequency Computation) and MLRP (Multiple Linear 
Regression Program).  REGFRQ performs regional frequency analysis 
and MLRP is a multiple linear regression analysis tool. 

The goal of HEC-SSP is to ultimately combine all of the statistical 
analyses capabilities of HEC-FFA, STATS, REGFRQ and MLRP.  The 
current version of HEC-SSP supports performing flood flow frequency 
analyses based on Bulletin 17B Guidelines, general frequency 
analyses, volume frequency analyses, duration analyses, coincident 
frequency analyses, and curve combination analyses.  New features 
and additional capabilities will be added in future releases.   

Overview of Program Capabilities 

HEC-SSP is designed to perform statistical analyses of hydrologic data.  
The following is a description of the major capabilities of HEC-SSP. 

User Interface 

The user interacts with HEC-SSP through a graphical user interface 
(GUI).  The main focus in the design of the interface was to make it 
easy to use the software, while still maintaining a high level of 
efficiency for the user.  The interface provides for the following 
functions: 
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• File management 

• Data entry, importing, and editing 

• Statistical analyses 

• Tabulation and graphical displays of results 

• Reporting facilities 

Statistical Analysis Components 

Flow Frequency Analysis (Bulletin 17B) – This component of the 
software allows the user to perform annual peak flow frequency 
analyses.  The software implements procedures in Bulletin 17B, 
"Guidelines for Determining Flood Flow Frequency", by the Interagency 
Advisory Committee on Water Data. 

General Frequency Analysis – This component of the software allows 
the user to perform annual peak flow frequency analyses by various 
methods.  Additionally the user can perform frequency analysis of 
variables other than peak flows, such as stage and precipitation data. 

Volume Frequency Analysis – This component of the software allows 
the user to perform a volume frequency analyses on daily flow or 
stage data. 

Duration Analysis – This component of the software allows the user to 
perform a duration analysis on any type of data recorded at regular 
intervals.  The duration analysis can be used to show the percent of 
time that a hydrologic variable is likely to equal or exceed some 
specific value of interest.   

Coincident Frequency Analysis – This component of the software 
assists the user in computing the exceedance frequency relationship 
for a variable that is a function of two other variables. 

Curve Combination Analysis 

Data Storage and Management 

– This component provides a tool for 
combining frequency curves from multiple sources into one frequency 
curve. 

Data storage is accomplished through the use of "text" files (ASCII and 
XML), as well as the HEC Data Storage System (HEC-DSS).  User input 
data are stored in flat files under separate categories of study, 
analyses, and a data storage list.  Gage data are stored in a project 
HEC-DSS file as time series data.  Output data is predominantly stored 
in HEC-DSS, while a summary of the results is written to an XML file.  
Additionally, an analysis report file is generated whenever a 
computation is made.  This report file is written to a standard ASCII 
text file. 
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Data management is accomplished through the user interface.  The 
modeler is requested to enter a Name and Description for each study 
being developed.  Once the study name is entered, a directory with 
that name is created, as well as a study file.  Additionally, a set of 
subdirectories is created with the following names: Bulletin17bResults, 
GeneralFrequencyResults, VolumeFrequencyAnalysisResults, 
DurationAnalysisResults, CoicidentFreqResults, 
CurveCombinationAnalysis, Layouts, and Maps.  As the user creates 
new analyses, an analysis file is created in the main project directory.  
The interface provides for renaming and deletion of files on a study-
by-study basis. 

Graphical and Tabular Output  

Graphics include a map window, plots of the data, and plots of analysis 
results.  The map window can be used to display background map 
layers.  Locations of the data being analyzed can be displayed on top 
of the map layers.  Once data are brought into HEC-SSP, they can be 
plotted for visual inspection.  The frequency curve plots show the 
results of the analyses, which include the analytically computed curve, 
the expected probability curve, confidence limits, and the raw data 
points plotted based on the selected plotting position method.  Tabular 
output consists of tables showing the computed frequency curves, 
confidence limits, and summary statistics.  All graphical and tabular 
output can be displayed on the screen, sent directly to a printer (or 
plotter), or passed through the Windows Clipboard to other software, 
such as a word-processor or spreadsheet. 

A report file is available for each analysis.  This report file includes the 
input data, preliminary results, all of the statistical tests (Low and High 
Outliers, Broken Record, Zero Flows Years, Incomplete Record, 
Regional Skews, and Historic Information), and final results.  This 
report file is similar to the FFA output file. 

 Overview of This Manual 

This user's manual is the primary documentation on how to use HEC-
SSP.  The manual is organized as follows: 

• Chapters 1-2 provide an introduction and overview of HEC-SSP, 
as well as instructions on how to install the software. 

• Chapter 3 provides an overview on how to use the HEC-SSP 
software in a step-by-step procedure, including a sample problem 
that the user can follow.   

• Chapter 4 explains in detail how to enter and view data. 

• Chapter 5 provides a detailed discussion on how to perform the 
Bulletin 17B flow frequency analysis.  Additionally, this chapter 
describes all of the output capabilities available for displaying and 
printing the results. 

• Chapter 6 provides a detailed discussion on how to use the 
general frequency analysis editor. 
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• Chapter 7 provides a detailed discussion on how to use the 
volume frequency analysis editor. 

• Chapter 8 provides a detailed discussion on how to use the 
duration analysis editor. 

• Chapter 9 provides a detailed discussion on how to use the 
coincident frequency analysis editor. 

• Chapter 10 provides a detailed discussion on how to use the 
curve combination analysis editor. 

• Appendix A contains a list of references. 

• Appendix B has a series of example analyses that demonstrate 
the various capabilities of performing a Bulletin 17B flow 
frequency analysis, a general frequency analysis, a volume-
duration frequency analysis, a duration analysis, a coincident 
frequency analysis, and a curve combination analysis. 
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C H A P T E R   2   

Installing HEC-SSP 

You install HEC-SSP using the program installation package available 
from HEC’s web site.  The setup program installs the software, 
documentation, and the example applications.  This chapter discusses 
the hardware and system requirements needed to use HEC-SSP, how 
to install the software, and how to uninstall the software. 

Contents 
• Hardware and Software Requirements 

• Installation Procedure 

• Uninstall Procedure 
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Hardware and Software Requirements 

Before you install the HEC-SSP software, make sure that your 
computer has at least the minimum required hardware and software.  
In order to get the maximum performance from the HEC-SSP 
software, recommended hardware and software is shown in 
parentheses.  This version of HEC-SSP will run on a computer that has 
the following: 

• Intel Based PC or compatible machine with Pentium processor or 
higher (a Pentium 4 or higher is recommended).  

• A hard disk with at least 100 megabytes of free space  

• A CD-Rom drive (or CD-R, CD-RW, DVD), if installing from a CD. 

• A minimum of 512 megabytes of RAM (1 Gigabyte or more is 
recommended). 

• A mouse. 

• Color Video Display (Recommend running in 1280x1024 or higher 
resolution, and as large a monitor as possible).  Recommend at 
least a 17" monitor. 

• Microsoft Windows NT 4.0, 2000, XP, or Vista (or later versions).  

Installation Procedure 

Installation of the HEC-SSP software is accomplished through the use 
of the Setup program.   

To install the software onto your hard disk do the 
following: 

1. Insert the HEC-SSP CD into your CD drive (or download the 
software from our web site: www.hec.usace.army.mil). 

2. The setup program should run automatically if installing from a 
CD.  When downloading from the web page you will need to save 
the setup file in a temporary directory and then execute the “HEC-
SSP_2_Setup.exe” file to run the setup program. 

3. If the setup program does not automatically run from the CD, use 
the windows explorer to start the HEC-SSP_2_Setup.exe program 
on the CD. 

4. Follow the setup instructions on the screen. 
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The setup program automatically creates a program group called HEC.  
This program group will be listed under the Programs menu, which is 
under the Start menu.  The HEC-SSP program icon will be contained 
within the HEC program group, within the HEC-SSP subdirectory.  The 
user can request that a shortcut icon for HEC-SSP be created on the 
desktop.  If installed in the default directory, the HEC-SSP executable 
can be found in the C:\Program Files\HEC\HEC-SSP\2.0 directory with 
the name "HEC-SSP.EXE".   

The HEC-SSP User’s Manual and example data sets are also installed 
with the software.  The User’s Manual can be viewed by selecting 
User’s Manual from the Help menu.  You must have Adobe Acrobat 
Reader to view the user’s manual.  This viewer can be obtained for 
free from the Adobe web page.   

A zip file containing the example data sets described in Appendix B 
have been installed in the "…\Examples" folder within the program 
directory. You can install the example data sets by selecting the 
Install Example Data option from the Help menu.  After selecting 
the Install Example Data menu option, a window will open for you to 
choose a location to install the example data sets.  The program will 
create a subdirectory within your chosen folder called SSP_Examples.  
A project file called "SSP_EXAMPLES.ssp" will be contained in the 
SSP_Examples folder.  You can load the test data sets by using the 
Open Study option from the File menu and then use the file chooser 
to select this file. 

Uninstall Procedure 

The HEC-SSP Setup program automatically registers the software with 
the Windows operating system.  To uninstall the software, do the 
following: 

• From the Start Menu select Control Panel. 

• Select Add/Remove Programs from within the Control Panel folder. 

• From the list of installed software, select the HEC-SSP program 
and press the Remove button. 

• Follow the uninstall directions on the screen and the software will 
be removed from your hard disk.   

 

 





HEC-SSP User's Manual Chapter 3 - Working with HEC-SSP – An Overview 

 3-1 

C H A P T E R   3   

Working With HEC-SSP - An Overview 

HEC-SSP is an integrated package of statistical analysis modules, in 
which the user interacts with the system through the use of a 
Graphical User Interface (GUI).  The current version is capable of 
performing flow frequency analyses based on Bulletin 17B "Guidelines 
for Determining Flood Flow Frequency", dated March 1982, general 
frequency analyses, volume frequency analyses, duration analyses, 
coincident frequency analyses, and curve combination analyses.  This 
chapter provides an overview of how a Bulletin 17B flow frequency 
analyses can be performed with the HEC-SSP software.  General 
frequency and volume-duration frequency analyses can be developed 
in a similar manner as outlined for the Bulletin 17B analysis.    

In HEC-SSP terminology, a Study is a set of files associated with a 
particular set of data and statistical analyses being performed.  The 
files for a study are categorized as follows:  study information, data 
list, and analysis data. 

Contents 
• Starting HEC-SSP 

• Overview of the Software Layout 

• Steps in Performing a Bulletin 17B Frequency Analysis 
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Starting HEC-SSP 

When you run the HEC-SSP Setup program, a new program group 
called HEC and a program icon called HEC-SSP are created.  They 
should appear in the start menu under the section called All 
Programs.  The user also has the option of creating a shortcut on the 
desktop.  If a shortcut is created, the icon for HEC-SSP will look like 
the following: 

 
Figure 3-1.  The HEC-SSP Icon. 

To Start HEC-SSP from Windows:  

• Double-click on the HEC-SSP Icon.  If you do not have an HEC-
SSP shortcut on the desktop, go to the Start menu and select All 
Programs  HEC  HEC-SSP  HEC-SSP 2.0. 

Overview of the Software Layout 

When you first start HEC-SSP, you will see the main window as shown 
in Figure 3-2, except you will not have any study data on your main 
window.  As shown in Figure 3-2, the main window is laid out with a 
Menu Bar, a Tool Bar, and four window panes.   
 
The upper right pane (which occupies most of the window area) is the 
Desktop Area (Referred to as the "Desktop" from this point in the 
manual).  This area is used for displaying maps, data editors, and 
analysis windows.   

The upper left pane is called the Study Explorer.  The Study Explorer 
acts like an explorer tree for the study.  The top level of the tree is the 
study (SSP Examples in this example).  Below the study is an analysis 
branch, a data branch, and a map branch.  Under the analysis branch, 
the first level is the type of analysis.  Under each analysis type will be 
the current user-defined analyses for that type.  The data branch lists 
all of the available data sets that have been brought into the current 
study.  Generally, a data set represents a piece of data at a specific 
gage location.  For example, all of the peak annual flows at a single 
gage would be stored as a single data set.  When an analysis is 
created, the user selects a data set to be used for that particular 
analysis.  The map branch of the tree contains any maps the user has 
put together for the study.  By default there is automatically a "Base 
Map" listed under the maps folder.   
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The lower left pane, and associated tabs, also belongs to the study 
explorer.  This window is used to show additional information about 
items selected in the study explorer.  The tabs are used to switch to 
different views within the study explorer window.  The first tab, labeled 
Study, shows the explorer view of the study.  The second tab, labeled 
Maps, lists the available maps and map layers associated with each 
map.  The last tab, labeled Files, shows all of the files that make up 
the current study. 

The lower right pane is called the Message Window.  This window is 
used to display messages from the software as to what it is doing.   

 
Figure 3-2.  The HEC-SSP Main Window. 

 

 

 

 

 

 

 

Study Explorer 
Desktop Area 

Message Window 
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At the top of the HEC-SSP main window is a Menu bar with the 
following options: 

File:  This menu is used for file management.  Options available under 
the File menu include New Study, Open 
Study, Save Study, Save Study As, Close 
Study, Study Properties, Export, Recent 
Studies, and Exit.  The Study Properties 
option is used to describe the study and to 
set the units system.  The Export option is 
used to export HEC-SSP results, stored in 
the study DSS file, to another DSS file. The 
Recent Studies option lists the most recently 
opened studies, which allows the user to 
quickly open a study that was recently 
worked on. 

 

 

 

Edit:  This menu is used for applying the Cut, Copy, and Paste 
clipboard features to data in editable fields and 
tables.   

 

 

 

View:  The View menu allows the user to control display of the 
toolbars and the study windows. The 
user can also toggle between viewing 
all of the panes or just the Main View 
Pane.  The View menu also has options 
for saving the current layout (currently 
opened windows and their sizes and 
locations) and restoring a previously 
saved layout.  The Set Study Display 
Units option allows the user to switch 
output between English and metric 
units.  The Select Working Sets menu 
option allows the user to group items 
in each folder and then display only 
those items in the user interface.  For 
example, Figure 3-3 shows the Bulletin 
17B folder in the study explorer.  The 
Edit Working Set editor, Figure 3-4, 
was used to group all Bulletin 17B 

analyses that started with “FFA” into one working set.  The working set 
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was named “FFA Analyses”.  This working set was activated by right 
clicking on top of the Bulletin 17B folder in the study explorer and 
selecting Select Working SetsFFA Analyses, as shown in Figure 
3-5.  Only the Bulletin 17B analyses within the working set will then be 
displayed in the study explorer, as shown in Figure 3-6.  To display all 
Bulletin 17B analysis, right click on top of the Bulletin 17B folder in the 
study explorer and select Select Working SetsNo Working Set.  

 
Figure 3-3.  Study Explorer before Defining a Working Set. 

 

 
Figure 3-4.  Edit Working Set Editor. 
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Figure 3-5.  Activate a Working Set from the Study Explorer. 

 

 
Figure 3-6.  Bulletin 17B Folder Only Displays Analyses in Working Set. 

 

Maps:  This menu is used to set the Default Map Properties 
(Coordinate system, extents,  
etc…), define a new map, add map 
layers to the study, and remove a 
map.   Additionally, this menu has 
the following options available: 
Map Window Settings (allows the 
user to turn map layers on and 
off), Zoom To Entire Map Extents, 
Save Map Image, Import, and 
Export.  The Zoom To Entire Map 
Extents option displays the entire 
set of map layers within the map 
window.  The Save Map Image 
option can be used to save the 
current view of the map to a file.   
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Data:  This menu allows the user to define a new data set, open the 
metadata editor, and delete any existing 
data sets from the data list.  Other options 
include opening a plot and table of the data. 

 

 

 

 

 

 

 

Analysis:  This menu is used to create the various statistical analyses 
available in the software.  Each statistical 
analysis is saved as a separate file 
containing the information that is pertinent 
to that specific analysis type.  The current 
options under this menu item include New, 
Open, Delete from Study, Save, Save As, 
Rename, and Compute Manager.  The 
compute manager allows the user to select 
one, several, or all of the analyses, and 
then have them all recomputed. 

 

 

Results:  This menu allows the user to graph and tabulate any of the 
existing analyses that have been computed.  
Additionally, the user can request to view the 
report file from a analysis.  Users must select 
at least one analysis in the Study Explorer 
before selecting Graph, Table, Report, or 
Summary Report.  If more than one analysis 
of the same type are selected (this is 
accomplished by holding down the control 
key while clicking on the various analyses), 

the Graph and Summary Report options will include results from all 
analyses that are selected.  However, when multiple analyses are 
selected, the Table and Report option bring up separate windows for 
each of the selected analyses.  The Default Plot Line Styles menu 
option lets the user change the default line styles applied to different 
data types that are plotted in a graph.  For example, the user can 
change the default line style for high outliers so that they are 
displayed as black triangular data points when a plot is opened.           
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Tools:  This menu includes HEC-DSSVue, Plot Probability Lines, 
Options, Console Output, and Memory 
Monitor.  The HEC-DSSVue option brings up 
the HEC-DSSVue program and automatically 
loads the current study DSS file.  HEC-
DSSVue is a DSS utility to tabulate, graph, 
edit, and enter data into DSS.  The Plot 
Probability Lines option opens an editor, 
shown in Figure 3-7, that lets the user add, 
delete, or edit the probability lines and axis 
labels that are displayed in all frequency 

curve plots.   The Options menu item opens the Options editor that 
allows the user to set default HEC-SSP options.  The Results tab in 
the Options editor, shown in Figure 3-8, allows the user to set the 
number of decimal digits that are displayed in all results.   

 
Figure 3-7.  Plot Probability Lines Editor. 
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Figure 3-8.  Dialog for Controlling the Number of Decimal Digits Shown in 
Result Tables and Reports. 

 

Window:  This menu includes Tile, Cascade, Next Window, Previous 
Window, Window Selector, and 
Window.  These options are 
used to control the appearance 
of the windows in the Desktop 
area.  When more than one 
window is open (such as a data 
importer, and various analysis 
windows), these menu items 
will help the user organize the 
windows, or quickly navigate 
to a specific window.   The Tile 
option can be used to organize 

all of the currently opened windows in either a vertical or horizontal 
tile.  The Cascade option puts one window on top of the next in a 
cascading fashion.  The Next Window option brings the next window in 
the list of currently opened windows to the top.  The Previous Window 
brings the last window that was on top back to the top.  The Window 
Selector option brings up a pick list of the currently opened windows 
and allows you to select the one you want.  The Window option has a 
sub menu list of all the opened windows and allows you to select one.  

Help:  This menu allows the user to open the HEC-SSP User’s Manual, 
install example data sets, read the terms and conditions of use 
statement, and display the current version information about HEC-
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SSP.                                                    

 

Also on the HEC-SSP main window is a Tool Bar.  The buttons on the 
tool bar provide quick access to the most frequently used options 
under the HEC-SSP File and Edit menus. 

Steps in Performing a Bulletin 17B Frequency Analysis 

There are five main steps in performing a Bulletin 17B flow frequency 
analysis using HEC-SSP.  Similar steps are required when performing 
other statistical analyses.  

• Starting a new study 

• Adding a Background Map (Optional) 

• Importing, Entering, and Editing Data 

• Performing the Bulletin 17B Frequency Analysis 

• Viewing and Printing Results 

Starting a New Study 

The first step in performing a Flow Frequency analysis with HEC-SSP is 
to establish which directory you wish to work in and to enter a title for 
the new study.  To start a new study, go to the File menu and select 
New Study.  This will open the Create New Study window as shown 
in Figure 3-9.  The user is required to enter a name for the study, 
select a directory to work in (a default location is provided), and select 
the desired units system.  Adding a description of the study is optional.  
Once you have entered all the information, press the OK button to 
have the information accepted.  After the OK button is pressed, a 
subdirectory will be created under the user chosen directory.  The 
subdirectory will be labeled with the same name as the user-entered 
study name.  This study directory is where the HEC-SSP project file, as 
well as other study files and directories will be located.  Additionally, a 
default map window will appear in the Main View Pane.  However, the 
map window will be blank when it first opens. 
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Figure 3-9.  New Study Window. 

Adding a Background Map  

By default, when you start a new project in HEC-SSP a default map 
window (called Base Map) will open in the Desktop window.  Having a 
background map is optional in HEC-SSP.  Not having a map does not 
prevent the user from importing and entering data, or performing an 
analysis and viewing results.  The map is mostly a visual aid of the 
study area.  Additionally, when you bring in gage data you can enter 
the map coordinates of the gage and it will show up on the map.  Once 
a gage is located on the map you can right click on it to open a 
shortcut menu for viewing the data, or graphing and tabulating the 
results. 

To add a map layer to the default map, go to the Maps menu and 
select Add Map Layers.  When this option is selected a file chooser 
window will appear, as shown in Figure 3-10, allowing the user to 
select map layers to bring into the map.  The Create Copy option on 
the window will make a copy of the selected map and place it in the 
Maps subdirectory within the study folder. 

Currently, the HEC-SSP software can load the following types of map 
layers: USGS DLG, AutoCAD DXF, shapefile, Raster Image, USGS DEM, 
Arc Info DEM, ASCII NetTIN, and Mr Sid.   

An example map is shown in Figure 3-11.  This map contains a 
shapefile of state boundaries and data locations. 



Chapter 3 - Working with HEC-SSP – An Overview HEC-SSP User's Manual 

3-12 

 
Figure 3-10.  Select a Map Layer to add to the Base Map. 

 

 
Figure 3-11.  Example Background Map. 
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If more than one map layer is going to be added to a map, then it is 
up to the user to ensure that all map layers are in the same coordinate 
system.  HEC-SSP does not perform coordinate system projections.  
Also, HEC-SSP cannot always determine the coordinate system for all 
map layers entered.  However, under the Maps menu is an option 
called Default Map Properties.  This menu option can be used to set 
the default coordinate system for the map layers displayed in HEC-
SSP.  The user should set the default coordinate system first and then 
bring in map layers to the study. 

Importing, Entering, and Editing Data  

Before any analyses can be performed, the user must bring data into 
the HEC-SSP study.  For a peak flow frequency analysis following 
guidelines in Bulletin 17B, the data must consist of peak annual flow 
values.  To bring data into HEC-SSP go to the Data menu and select 
New.  This will bring up the Data Importer as shown in Figure 3-12. 

 
Figure 3-12.  HEC-SSP Data Importer. 

 

As shown in Figure 3-12, the Data Importer has fields for the Name, 
Short Identifier, and the Description of the data at the top of the 
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window.  Additionally, it lists the study DSS file name that the data will 
be stored in once it is brought into the study.  The study DSS file is 
always labeled the same name as your study with the .DSS file 
extension. 

The Data Importer contains two tabs, Data Source and Details.  The 
Data Source tab is shown first.  This tab is used for selecting and 
defining a source for bringing data into the HEC-SSP study.  Currently, 
there are five ways to bring data into an HEC-SSP study: import from 
another HEC-DSS file, import data from the USGS web site, import 
from a Microsoft Excel spreadsheet, manually entering the data into a 
table, and import the data from a text file.  All of these methods will 
import data into the study DSS file. 

For this example, importing data from the USGS website will be 
shown.  For a complete description of the data importer see Chapter 4.  
To import data from the USGS website, first select the USGS Website 
option from the list of five options available in the Location panel.  
Next, select Annual Peak Data as the data type and make sure the 
Flow option is selected.  The next step is to press the button labeled 
Get USGS Station ID’s by State.  When this button is pressed a 
window will appear (Figure 3-13) allowing the user to select a state 
from which to get data. 

 
Figure 3-13.  Window to Select a State for Downloading Data. 

 

Once a state is selected, press the OK button and a list of the available 
gages from that state will appear in a pick list as shown in Figure 3-14.  
Check the boxes for all of the gages you would like to import and then 
press the Import to Study DSS File button.  Once the import button 
is pressed, a process will begin during which the data will be 
downloaded from the USGS website and saved to the study DSS file.  
HEC-SSP will automatically name the data when importing multiple 
gages at one time.  The USGS import process will download annual 
peak flow data, and the USGS data quality codes.  The quality codes 
will be added as an addition object to the Data folder.   

In addition to the data itself, any metadata that is available will be 
downloaded and stored with the data.  The metadata can be viewed 
from the Details Tab on the Data Importer.  Metadata can also be 
viewed or edited by opening the Metadata Editor.  To open this 
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editor, place the mouse on top of a data object in the Data folder and 
click the right mouse button.  The shortcut menu contains an Edit 
Metadata option, as shown in Figure 3-15.  The metadata editor is 
shown in Figure 3-16. 

 
Figure 3-14.  Example of Choosing Gages from a USGS State List to Import. 

 

 
Figure 3-15.  Open the Metadata Editor Using the Right Mouse Click Menu. 
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Figure 3-16.  Metadata can be Viewed or Edited by Opening the Metadata 
Editor. 

 

As shown in Figure 3-16, the metadata consists of the State, County, 
Stream, Location, Drainage Area, DA Units, Gage Operator, USGS 
Gage No., Gage Datum, HUC (Hydrologic Unit Code), Vertical Datum, 
and a description field.  Additionally, the coordinate location of the 
data is shown.  The coordinate location consists of Coordinate System, 
Coordinate ID, Horizontal Datum, Datum Units, Coordinate X Value, 
and Coordinate Y Value.  Most of the USGS data is retrieved with the 
Latitude/Longitude coordinate system as shown in the example.  In 
addition to editing the metadata, the Metadata Editor allows the user 
to change the name of the data, enter a short identifier, and enter a 
longer description. 

If the metadata does not download automatically, the user has the 
option to enter any of the information by hand.  Metadata is not 
generated automatically for any of the other four data sources.  
Therefore, entering the metadata is required if the user wants it to be 
carried along with the study. 

After the data is imported into the study, the user can select any one 
of the gages in the Data folder and Plot or Tabulate the data.  The 
plot and tabulate options are available from the Data menu and from a 
shortcut menu that opens by clicking the right mouse button when the 
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pointer is located on top of the gage object in the Data folder.  If you 
select the Plot option, you will get a plot of the peak flow data for that 
gage.  If you select the Tabulate option, you will get a table 
containing the data.  Data values can be edited within the table; 
however, the editing mode must be turned on.  To turn on editing, 
select the EditAllow Editing menu option.  Use the FileSave or 
FileSave As menu option to save the data when you are satisfied 
with edits.  

If the data has coordinate location information, it will then be plotted 
on top of the background maps.  The software 
will convert the coordinates of the point data to 
the default coordinate system of the base map. 
The user can interact with the plotted points by 
right clicking on the gage icon in the map and a 
shortcut menu will appear as shown.  The user 
has the option to edit the metadata, plot, 
tabulate, rename, or delete the data. 

 

Performing the Bulletin 17B Flow Frequency Analysis 

To perform a Bulletin 17B flow frequency analysis, go to the Analysis 
menu and select New  Bulletin 17B Flow Frequency.  This will 
bring up an empty Bulletin 17B editor.  As shown in Figure 3-17, the 
user must enter a name for the analysis, a description (optional), and 
select a flow data set (gage data stored in study DSS file).  The DSS 
File Name and Report File are automatically filled in by the program.  
For now, the DSS File Name will be the study DSS file and the report 
file will have the same name as the analysis.  

The editor window contains three tabs: General, Options, and Tabular 
Results. The General tab contains settings for Generalized Skew, 
Expected Probability Curve, Plotting Positions, Confidence limits, and a 
Time Window Modification.  Default settings are already established for 
each of the options on the General tab; however, the user can change 
the default settings.   

The Options tab contains information on Low Outlier Threshold, 
Historic Period Data, and User-Specified Frequency Ordinates.  These 
options are not required for most analyses but may be necessary 
depending upon the data. 

A detailed description of each of the Bulletin 17B settings and options 
can be found in Chapter 5, Performing a Bulletin 17B Flow Frequency 
Analysis.  Once all of the settings and options have been selected, the 
user presses the Compute button to have the computations 
performed.  When the computations have finished a message window 
will open stating Compute Complete.  Press the OK button on the 
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message window to close the window.  Once the computations have 
finished the user can begin to look at output. 

 
Figure 3-17.  Bulletin 17B Flow Frequency Analysis Editor. 

  

Viewing and Printing Results 

Tabular output can be viewed by selecting the Tabular Results tab.  
When this tab is pressed, a set of tables will appear as shown in Figure 
3-18.  The primary table on the Tabular Results tab consists of 
percent chance exceedance, computed flow frequency curve, the 
expected probability adjusted curve, and the 5 and 95 percent 
confidence limits.  The second table (bottom left) contains general 
statistics about the data, such as the mean, standard deviation, 
station skew, regional skew, weighted skew, and the adopted skew of 
the analysis.  The third table (bottom right) contains the number of 
historic events, high outliers, low outliers, zero or missing values, 
systematic events in the data set, and the number of years in the 
historic period.   The table can be sent to the printer by pressing the 
Print button at the bottom of the analysis window.  The user can 
control the number of decimal digits shown in the result tables and in 
reports.  Select Options from the Tools menu and then open the 
Results tab, as shown in Figure 3-8. 
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Figure 3-18.  Tabular Results of Bulletin 17B Editor. 

 

Graphical output can be obtained by pressing the Plot Curve button at 
the bottom of the analysis editor.  When this button is pressed, a plot 
will appear like the one in Figure 3-19.  This plot contains the 
computed frequency curve, the expected probability adjusted curve, 
the confidence limits, and the data points plotted by the user-selected 
plotting position method.   Additionally, a plot title is listed at the top.  
The plot title is by default the user-defined name of the analysis.  The 
user can modify the plot properties by selecting the EditPlot 
Properties menu option.  A plot properties window will open that lets 
the user change the line style for each data type, change the axis 
labels, modify the plot title, and edit other plot properties.  The user 
can also edit line styles by placing the mouse on top of the line or data 
point in the plot or legend and clicking the right mouse button.  Then 
select the Edit Properties menu option in the shortcut menu.  The 
plot can be printed or sent to the windows clipboard by using the Print 
and Copy to Clipboard options found under the File menu. 

Additional points and lines can be added to a plot by placing the 
mouse anywhere in the plot area and clicking the right mouse button.  
Then select the Add Marker option to add a line or Add Marker 
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Point to add a point.  Draw properties can be edited for these user-
defined lines and points by placing the mouse on top of the point or 
line and clicking the right mouse button.  Then select the Edit 
Properties option in the shortcut menu. 

 
Figure 3-19.  Flow Frequency Curve Plot. 

 

The final piece of output available from a flow frequency analysis is a 
text report file.  The report file lists all of the input data and user 
settings, plotting positions of the data points, intermediate results, 
each of the various statistical tests performed (i.e. high and low 
outliers, historical data, etc.), and the final results.  This file is often 
useful for understanding how the software arrived at the final 
frequency curve.  Press the View Report button at the bottom of the 
analysis editor to view the report file.  When this button is pressed, a 
window will appear containing the report as shown in Figure 3-20. 
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Figure 3-20.  Report File from Bulletin 17B Frequency Analysis. 
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C H A P T E R   4   

Using the HEC-SSP Data Importer 

The HEC-SSP Data Importer is used to import, enter, and view data 
and the corresponding metadata used in an HEC-SSP study.  The 
current version of HEC-SSP can be used to import annual peak data 
(flow and stage) and data stored at regular intervals, like hourly flow 
data.   

Contents 
• Developing a New Data Set 

• Importing Data from an HEC-DSS File 

• Importing Data from the USGS Website 

• Importing Data from an Excel Spreadsheet 

• Entering Data Manually 

• Entering Data from a Text File 

• Metadata 

• Plotting and Tabulating Data 
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Developing a New Data Set 

Before any analyses can be performed in HEC-SSP, the user must 
import or enter data into the study.  Importing, entering, and viewing 
data is accomplished in the Data Importer.  To open the data 
importer, go to the Data menu and select New from the list of 
options.  This will bring up a data importer as shown in Figure 4-1. 

 
Figure 4-1.  HEC-SSP Data Importer. 

 

At the top of the Data Importer, the user can enter a Name for the 
new data set.  Optionally, the user can enter a short identifier (limited 
to 16 characters) and a Description of the data set.  The study DSS 
file name is provided.  The DSS file is used for storing the data for the 
study.  The user does not have to enter a name when importing or 
manually entering data.  The program will automatically name the data 
using USGS names or HEC-DSS pathname parts.  If a Name is 
entered then it will be combined with the USGS gage name or HEC-
DSS pathname parts to create a unique name.  The user can rename a 
data set by selecting the data set in the study explorer and clicking the 
right mouse button.  A shortcut menu should open with a Rename 
menu option.  The Data menu also contains a Rename menu option; 
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however, the data set must be selected in the study explorer before 
this menu option is active. 

The Data Importer contains two main tabs, Data Source and Details.  
The Data Source tab is used for importing or entering data manually 
while the Details tab is used to describe the data (i.e. metadata).  The 
Data Source tab contains five options for getting data into the study 
DSS file: Importing from an existing HEC-DSS file, importing from the 
USGS Website, importing from an Excel spreadsheet, entering the data 
manually, and importing from a text file. 

Importing Data from an HEC-DSS File 

To import data from an HEC-DSS file into the HEC-SSP study DSS file, 
first select the HEC-DSS radio button on the data importer.  Selecting 
HEC-DSS will change the view of the Data Importer to look like Figure 
4-2. 

 
Figure 4-2.  Data Importer with HEC-DSS Import Option. 

 

As shown in Figure 4-2, the user first selects a DSS file to import from 
by typing the path and name or by choosing the file browser at the 
end of the input field.  Once a DSS file is selected, the table of 
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pathnames will be filled with the records that are contained in that 
DSS file.  The user can reduce the number of listed pathnames by 
selecting pathname parts to filter in the pathname part selection area 
just above the table.  Any pathname part can be used to filter the list 
down to a more manageable number of pathnames to select from.  
The user can then select pathnames to import by double clicking on 
one or more of the listed pathnames in the table.  Each selected 
pathname will show up in the list below the table.  Once the user has 
selected all of the pathnames that they want to import, pressing the 
Import to Study DSS File button enacts the import process.  An 
HEC-SSP data set will be developed for each pathname that was 
selected. 

Importing Data from the USGS Website 

The second way to import data into HEC-SSP is to use the USGS 
Website option.  When this option is selected, the data importer will 
look like Figure 4-3. 

 Figure 4-3.  HEC-SSP Data Importer with USGS Website Import Option. 

 



HEC-SSP User's Manual Chapter 4 - Using the HEC-SSP Data Importer 

 4-5 

The first step in using the USGS import option is to select a data type 
to import (e.g. Annual Peak Data).  Then choose to import Flow 
and/or Stage data.  Next the user should select the Get USGS 
Station ID’s by State button.  Selecting this button will bring up a 
small window that allows the user to select a state in which to acquire 
data, as shown in Figure 4-4. 

 
Figure 4-4.  Window to Select a State for Importing USGS Data. 

 

Once the user selects a state and presses the OK button, a process 
will begin in which all of the gage locations for that state will be 
downloaded from the USGS website.  A listing of all the gages for that 
state will then be displayed in the table at the bottom of the data 
importer.  An example of the data importer with a list of USGS gages 
is shown in Figure 4-5. 
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Figure 4-5.  Data Importer with USGS Gages Listed in Table. 

 

The next step is to select the desired gages for importing into the HEC-
SSP study.  The user can filter the list to a smaller number of gages by 
using the filter drop down boxes at the top of the table.  To select a 
gage for importing, simply check the box in the left hand column for 
each gage location that is to be imported.  After all of the desired 
locations are selected, press the Import to DSS File button to import 
the data into the study DSS file.  Pressing this button will start a 
process of downloading data from the USGS website.  For each 
selected location, the software will download the Data Quality Codes if 
they are available.  The program issues a message that data quality 
codes are available and adds the codes as an additional data set to the 
Data folder.  For an explanation of the codes, please visit the USGS 
website. 

Warning: all data downloaded from the USGS website should be 
reviewed to ensure it is appropriate before any analyses are performed 
on the data.  Some data stored on the USGS website are estimated, 
not measured.  The user should check the data on the USGS website 
and be aware of the quality of all the data before using it.  HEC-SSP 
will import the annual peak flow and stage quality codes (the program 
does not import quality codes for daily, instantaneous, and real time 
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data).  A description of the quality codes for annual peak flows is 
contained in Table 4-1 and a description of the quality codes for annual 
peak stages is contained in Table 4-2.  

 
Table 4-1.  Quality Codes for USGS Annual Peak Flow Data. 

Code Description 
1 Discharge is a Maximum Daily Average 
2 Discharge is an Estimate 
3 Discharge affected by Dam Failure 
4 Discharge less than indicated value which is Minimum 

Recordable Discharge at this site 
5 Discharge affected to unknown degree by Regulation or 

Diversion 
6 Discharge affected by Regulation or Diversion 
7 Discharge is an Historic Peak 
8 Discharge actually greater than indicated value 
9 Discharge due to Snowmelt, Hurricane, Ice-Jam or Debris 

Dam breakup 
A Year of occurrence is unknown or not exact 
B Month or Day of occurrence is unknown or not exact 
C All or part of the record affected by Urbanization, Mining, 

Agricultural changes, Channelization, or other 
D Base Discharge changed during this year 
E Only Annual Maximum Peak available for this year 

 
 
Table 4-2.  Quality Codes for USGS Annual Peak Stage Data. 

Code Description 
1 Gage height affected by backwater 
2 Gage height not the maximum for the year 
3 Gage height at different site and(or) datum 
4 Gage height below minimum recordable elevation 
5 Gage height is an estimate 
6 Gage datum changed during this year 

 

Importing Data from an Excel Spreadsheet 

The third option for importing data into HEC-SSP is MS Excel.  When 
this option is selected, the data importer will change as shown in 
Figure 4-6.  The first step in importing data from an Excel spreadsheet 
is to select browse button, , at the end of the Excel File field.  Once 
an Excel file is selected, a data view window will open showing the 
data contained in the selected spreadsheet.  An example Excel® Data 
Viewer is shown in Figure 4-7. 
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Figure 4-6.  Data Importer with MS Excel Import Option Selected. 
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Figure 4-7.  Example Excel Data Viewer. 

 

The next step is to highlight the date and data values to be imported 
into the study (only highlight the data, not the column headings).  The 
data must be in a format of Date in the first column and Data in the 
second column.  The date must be in the Day, Month, Year format 
(ddmmyyyy) as shown in Figure 4-7.  Next, press the OK button and 
the data will be placed in the table at the bottom of the editor.  The 
last step before importing the data is to specify the units of the data, 
and each of the pathname parts for storing the data in the study DSS 
file (make sure to edit the C-part pathname if data is not annual 
peaks).  Enter units of cfs for data in cubic feet per second or units of 
cms for data in cubic meters per second.  The final step is to press the 
Import to Study DSS File button, and the data will be imported. 
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Entering Data Manually 

Another option for getting data into the study is to enter the data 
manually.  When the Manual option is selected, the window will 
change to what is shown in Figure 4-8.   

 
Figure 4-8.  Data Importer with Manual Data Entry Option Selected. 

  

To enter data manually, the user enters a name for the data set at the 
top, along with a short identifier and a description (optional).  A 
starting date and time must be entered.  The units of the data must 
also be defined as well as the data type.  The last step before entering 
the data is to specify the pathname parts for how the data will be 
stored into the study DSS file.  This requires the user to enter a label 
for the A, B, C, E, and F part of the DSS pathname.  Once all of the 
data labeling is completed, the data can be entered into the table at 
the bottom of the editor.  The user must enter the Date, Time, and 
data Value for each peak flow value to be entered.  After a Date, 
Time, and Value are entered into a row, a new row will be generated in 
the table when the user leaves the Value field.  The date must be in 
the Day, Month, Year format (ddmmyyyy).  Another option for getting 
data into the table is to copy it to the clipboard and then paste it into 
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the table.  The table supports pasting data one column at a time or 
you can paste the date, time, and value information all at once.  When 
all of the data are entered into the table, the user presses the Import 
to Study DSS File button and the data will be stored in the study DSS 
file. 

Importing Data from a Text File 

The fifth option for importing data into HEC-SSP is a comma delimited 
Text File.  When this option is selected, the data importer will change 
as shown in Figure 4-9.   

 
Figure 4-9.  Data Importer with Text File Option Selected. 

 

The first step in importing data from a comma delimited Text File is to 
press the Select File, , button at the end of the File field.  Once a 
comma delimited text file is selected, a data view window will open 
showing the data contained in the selected file.  An example text file 
data viewer is shown in Figure 4-10. 
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Figure 4-10.  Example Text File Data Viewer. 

 

The next step is to highlight the date, time, and data columns.  Only 
highlight the data that will be imported, not the column headings.  If 
there are column headings then they need to be identified.  To do this, 
select the row or rows that do not contain data to be imported.  Then 
click the right mouse button and select the Skip Row(s) menu option, 
as shown in Figure 4-11. 
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Figure 4-11.  Identify Rows that do not Contain Data to be Imported. 

 
To identify the date and time columns, place the mouse pointer on the 
column number at the top of the table and click the right mouse 
button.  Then move the mouse pointer to the Date – Time Column 
option to see an additional menu of options, as shown in Figure 4-12.  
Figure 4-12 shows that column 2 will be defined as the date column.  
The date must be in the Day, Month, Year format (ddmmyyyy).  The 
data viewer will highlight the date and time columns once they have 
been defined.   
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Figure 4-12.  Identify Date and Time Columns. 

 

To define the data column, place the mouse pointer on the column 
number at the top of the table and click the right mouse button.  Then 
choose the Set Data Column menu option from the shortcut menu.  
Another editor will open, as shown in Figure 4-13, that allows the user 
to define the pathname parts, data units, and data type.  After 
defining these data properties, click the Import Now button to import 
the data and data properties into the Data Importer.  You can edit the 
data values or data properties in the data importer before importing 
the data to the study.  The final step is to press the Import to Study 
DSS File button, and the data will be imported. 
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Figure 4-13.  Editor for Defining the Data Properties. 

 

Metadata 

When downloading data from the USGS website, in addition to the raw 
data, the software will also attempt to download any metadata 
available for each gage location.  When using one of the other four 
methods for importing data, the user can manually enter metadata by 
selecting the Details tab, as shown in Figure 4-14.  The metadata 
consists of the State, County, Stream, Location, Drainage Area, DA 
Units, Gage Operator, USGS Gage No., Gage Datum, HUC (Hydrologic 
Unit Code), Vertical Datum, and a description field.  Additionally, the 
coordinate location of the data is shown.  The coordinate location 
consists of Coordinate System, Coordinate ID, Horizontal Datum, 
Datum Units, Coordinate X Value, and Coordinate Y Value.  If 
coordinate system data are entered, data icons and text labels will 
show up on the background map at the specified locations. 

Metadata can be viewed and edited any time after the data has been 
imported into the study by opening the Metadata Editor.  To open 
the Metadata Editor, place the mouse pointer on top of a data set in 
the Data folder and then click the right mouse button.  Choose the 
Edit Metadata option from the shortcut menu, as shown in Figure 4-
15.  The Metadata Editor will look exactly like the Details tab on the 
Data Importer.  The Metadata Editor can also be opened from the Data 
menu and from a shortcut menu that opens by right clicking on a data 
icon in a background map. 
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Figure 4-14.  Details Tab on the HEC-SSP Data Importer. 

 

 
Figure 4-15.  Menu Option for Opening the Metadata Editor. 
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Plotting and Tabulating the Data 

After the data is imported into the study, the user can select any one 
of the data sets in the study explorer.  A shortcut menu will open when 
clicking the right mouse button while a data set is selected.  The 
shortcut menu contains options to change the name, plot, and tabulate 
the data.  These options are also available from the Data menu; 
however, the data must be selected in the study explorer before these 
options are available.  If you select the Plot option, you will get a plot 
similar to the one shown in Figure 4-16. 

 
Figure 4-16.  Plot of Peak Annual Flow Data. 

 

If you select the Tabulate option, a table will open with the data listed 
as shown in Figure 4-17.  Data values in the table can be edited after 
selecting the EditAllow Editing menu option.  To save any edits, 
select the FileSave menu option. 
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Figure 4-17.  Table Containing Peak Annual Flow Data. 
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C H A P T E R   5   

Performing a Bulletin 17B Flow 
Frequency Analysis 

The current version of HEC-SSP allows the user to perform flow 
frequency analyses based on Bulletin 17B, "Guidelines for Determining 
Flood Flow Frequency" (March 1982).  This chapter discusses in detail 
how to perform a Bulletin 17B Flow Frequency Analysis in HEC-SSP. 

Contents 
• Starting a New Analysis 

• General Settings, Options, and Computations 

• Viewing and Printing Results 
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Starting a New Analysis 

A flow frequency analysis can be started in two ways within the 
software, either by right clicking on the Bulletin 17B folder in the study 
explorer and selecting New, or by going to the Analysis menu and 
selecting New and then Bulletin 17B Flow Frequency.  When a new 
flow frequency analysis is selected, the Bulletin 17B Editor will appear 
as shown in Figure 5-1. 

Figure 5-1.  Bulletin 17B Flow Frequency Analysis Editor. 

 

The user is required to enter a Name for the analysis, while a 
Description is optional.  An annual peak flow data set must be 
selected from the available data sets stored in the current study DSS 
file (see chapter 4 for importing data into the study).  The list of data 
that can be selected for a Bulletin 17B analysis will only include those 
data that have an irregular interval, like IR-CENTURY and IR-YEAR (E-
part pathname).  Once a Name is entered, and a flow data set is 
selected, the DSS File Name and Report File will automatically be 
populated.  The DSS filename is by default the study DSS file.  The 
report file is given the same name as the analysis with the extension 
".rpt".   
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General Settings, Options, and Computations 

Once the analysis name and flow data set are selected, the user can 
begin setting up the analysis.  Three tabs are contained on the Bulletin 
17B editor.  The tabs are labeled General, Options, and Tabular 
Results.   

General Settings 

The first tab contains general settings for performing the flow 
frequency analysis (Figure 5-1).  These settings include: 

• Generalized Skew 

• Expected Probability Curve 

• Plotting Positions 

• Confidence Limits 

• Time Window Modification 

Generalized Skew 

There are three options contained within the generalized skew setting: 
Use Station Skew, Use Weighted Skew, and Use Regional Skew.  The 

default skew setting is 
Use Station Skew.  
With this setting, the 
skew of the computed 
curve will be based 
solely on computing a 
skew from the data 
points contained in the 
data set.  No weighting 
will be performed to 
compute the final skew.   

 

The Use Weighted Skew option requires the user to enter a 
generalized regional skew and a Mean-Square Error (MSE) of the 
generalized regional skew.  This option weights the computed station 
skew with the generalized regional skew.  The equation for performing 
this weighting can be found in Bulletin 17B (equation 6).  If a regional 
skew is taken from Plate I of Bulletin 17B (the skew map of the United 
States), the value of MSE = 0.302.   

The last generalized skew option is Use Regional Skew.  When this 
option is selected, the user must enter a generalized regional skew 
and an MSE for that skew.  The program will ignore the computed 
station skew and use only the generalized regional skew. 
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Expected Probability Curve 

This setting has two options: compute the expected probability curve 
and do not compute the expected probability curve.  The default 

setting is to have the expected 
probability curve computed.  When 
computed, this curve will be shown 
in both the result tables and the 
plots as an additional curve to the 
computed curve.  The expected 
probability adjustment is an 

attempt to correct for a certain bias in the frequency curve 
computation due to the shortness of the record.  Please review the 
discussion in Bulletin 17B about the expected probability curve 
adjustment for an explanation of how and why it is computed.  The 
use of the expected probability curve is a policy decision.  It is most 
often used in establishing design flood criteria.  The basic flood 
frequency curve without the expected probability curve adjustment is 
the curve used in computation of confidence limits, risk, and in 
obtaining weighted averages of independent estimates of flood 
frequency discharge (WRC, 1982). 

Plotting Positions 

Plotting positions are used for plotting the 
raw data points on the graph.  There are 
four options for plotting position 
methodologies within HEC-SSP: Weibull, 
Median, Hazen, and user entered 
coefficients.  The default method is the 
Median plotting position formula.  The 
generalized plotting position equation is: 

)1(
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Where: m = rank of flood values with the largest equal to 1. 

  n = number of flood peaks in the data set. 

A & B = constants dependent on which equation is used 
(Weibull A and B=0; Median A and B = 0.3; and 
Hazen A and B=0.5). 

Plotting positions are estimates of the exceedance probability of each 
data point.  Different methods can give very different values for the 
probabilities of the highest and lowest points in the data set.  In the 
Bulletin 17B methodology, the plotting of data on the graph by a 
plotting position method is only done as a guide to assist in evaluating 
the computed curve.  The plotting position method selected does not 
have any impact on the computed curve. 
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Confidence Limits 

Confidence limits provide a measure of the uncertainty in the 
computed discharge for a given 
exceedance probability.  The 
computation of confidence limits is 
outlined in Bulletin 17B, Appendix 
9.  By default, HEC-SSP calculates 
the 90 percent confidence interval 
(i.e. the 5% and 95% confidence 
limits).  The confidence limits 
must be entered in decimal form 
(i.e. 95% = 0.95, and 5% = 
0.05).  The user has the option to 

override the default values and enter whatever values they would like 
for the confidence limits. 

Time Window Modification 

This option allows the user to narrow the time window used for the 
analysis.  The default is to use all of the annual peak flow data 

contained in the 
selected data set.   
The user can enter 
either a start date 
for the analysis, 
and end date, or 
both a start and 
end date.  If a start 
and/or end date 

are used, they must be dates that are encompassed within the data 
stored in the selected data set.  The date range for the selected data 
set is shown in the editor just above the Start Date field. 

Options 

In addition to the general settings, there are also several options 
available to the user for modifying the computations of the frequency 
curves.  These options include:  

• Low Outlier Threshold 

• Historic Period Data 

• User-Specified Frequency Ordinates 

 

When the Options tab is selected, the Bulletin 17B Editor will appear as 
shown in Figure 5-2. 
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Figure 5-2.  Bulletin 17B Editor with Options Tab Selected. 

 

Low Outlier Threshold 

High and low outlier tests are based on the procedures outlined in 
Bulletin 17B.  The calculated outlier magnitudes, by the Bulletin 17B 
procedures, are used as 
default values for the high 
and low outlier thresholds in 
HEC-SSP.  The user has the 
option to enter a different 
value for the low outlier 
threshold.  If a value is entered for the low outlier threshold, then this 
value will override the computed value from Bulletin 17B procedure.  
When applying the outlier tests, HEC-SSP will identify both high and 
low outliers.  However, only low outliers will be removed from the data 
set when performing the analysis.  If a high outlier is identified in the 
data set, the analyst should try to incorporate historical period 
information to extend the time period for which the high outlier(s) is 
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considered to be the maximum value(s).  Further discussion of outlier 
thresholds can be found in Bulletin 17B.  To use the low outlier 
threshold, simply check the box and enter the value. 

Historic Period Data 

All historic data that provides reliable estimates of flood peaks outside 
the systematic record should be used in order to improve the 

frequency 
computations.   
Flood 
information 
outside of the 
systematic 
record can often 
be used to 
extend the 
record of the 
largest events 
to a historic 
period much 
longer than that 
of the 
systematic 
record.  HEC-
SSP uses 

historic data as recommended in Bulletin 17B.  To use historic data in 
HEC-SSP, check the box labeled Use Historic Data.  The user can 
enter a starting year for the historic period, ending year for a historic 
period, and a high threshold value.  If the user enters a high threshold 
value, then any value in the systematic record greater than that value 
will also be treated as a historical flood peak.   The user can also enter 
historic flood peaks that are not contained in the systematic record.  
This is done in the table at the bottom labeled Historic Flood Peaks.  
All years must be entered as water year values (October 1 through 
September 30).  If a start year is not entered, then the assumed start 
year is the earliest year of the systematic record and any historical 
values that have been entered.  If an end year is not entered, then the 
assumed end year is the latest year in the systematic record and any 
entered historic values.  Further discussion of the use of historical data 
can be found in Bulletin 17B and the HEC-SSP Statistical Reference 
Guide. 

Note:  The program treats all data in the data set as systematic data.  
If historic events are included in the data set, then the user can define 
the analysis time window (General tab – Time Window Modification) so 
that it only bounds the systematic record.  Then define the historic 
events in the Historic Events table.  Instead of using the Time Window 
Modification option, another option is to enter a High Threshold value 
so that the historic data point(s) would be treated as historic data 
(rather than part of the systematic record).  Please see test example 6 
in Appendix B for an example of using the historic data adjustment.   
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User Specified Frequency Ordinates 

This option allows the user to change the frequency ordinates used in 
computing the resulting frequency curves and confidence limits.  The 
default values listed in 
percent chance 
exceedance are 0.2, 0.5, 
1, 2, 5, 10, 20, 50, 80, 
90, 95, and 99.  Check 
the box next to Use 
Values from Table 
below to change or add 
additional values.  Once 
this box is checked, the 
user can add/remove rows and edit the frequency values.  To add or 
remove a row from the table, select the row(s), place the mouse over 
the highlighted row(s) and click the right mouse button.  The shortcut 
menu contains options to Insert Row(s) and Delete Row(s).  The 
program will use the default values, even if they are not contained in 
the table, when the Use Values from Table below option is not 
checked.  Finally, all values in the table must be between 0 and 100. 

Compute 

Once the new analysis has been defined, and the user has all of the 
settings and options the way they want them, performing the 
computations is simply a matter of pressing the 
Compute button at the bottom of the Bulletin 17B 
Editor.  If the computations are successful, the 
user will receive a message that says Compute Complete.  At this 
point, the user can begin to review the results of the flow frequency 
analysis. 

Multiple Bulletin 17B analyses can be computed using the Compute 
Manager.  Select the AnalysisCompute Manager menu option to 
open the Compute Manager.  Select the analyses to be computed and 
then press the Compute button.  Close the compute dialogs and 
Compute Manager when the program finished computing the analyses.  

Viewing and Printing Results 

The user can view output from the flow frequency analysis directly 
from the Bulletin 17B Editor.  The output consists of tabular results, a 
frequency curve plot, and a report documenting the data and 
computations performed. 
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Tabular Output 

Once the computations for the flow frequency analysis are completed, 
the user can view tabular output by opening the Tabular Results tab.  
When this tab is pressed, the results will be displayed as shown in 
Figure 5-3. 

Figure 5-3.  Bulletin 17B Editor with Tabular Results Tab Active. 

 

Output on the results tab consists of three tables: Frequency Curves, 
System Statistics, and Number of Events.  The Frequency Curve 
output table contains the percent chance of exceedance ordinates, the 
computed Log Pearson III frequency curve, the expected probability 
adjusted frequency curve, the 5% chance of exceedance confidence 
limit, and the 95% chance of exceedance confidence limit.  Data in the 
frequency curve table can be re-sorted.  Click the Percent Chance 
Exceedance column header (two mouse clicks are required the first 
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time).  The percent chance exceedance ordinates, along with 
frequency curve and confidence limits values, will sort so that the 
lowest values are on top or the highest values are on top.  The 
System Statistics table contains the mean of the data in log space, 
standard deviation in log space, station skew, user entered regional 
skew, weighted skew (weighted between station skew and regional 
skew), and the adopted skew for the analysis.  The Number of 
Events table tabulates the number of historic events, high outliers, 
low outliers, zero or missing values, systematic events, and the 
number of years in the historic period (this value only comes into play 
if the user entered historic data). 

The tabular results can be printed by using the Print button at the 
bottom of the Bulletin 17B Editor.  When the print button is pressed, a 
window will appear giving the user options for how they would like the 
table to be printed. 

Graphical Output 

Graphical output of the frequency curves can be obtained by pressing 
the Plot Curve button.  When the Plot Curve button is pressed, a 
frequency curve plot will appear in a separate window as shown in 
Figure 5-4.  The user can modify the plot properties by selecting the 
EditPlot Properties menu option.  A plot properties window will 
open that lets the user change the line style for each data type, 
change the axis labels, modify the plot title, and edit other plot 
properties.  The user can also edit line styles by placing the mouse on 
top of the line or data point in the plot or legend and clicking the right 
mouse button.  Then select the Edit Properties menu option in the 
shortcut menu.  Both the Y and X-axis properties can be edited by 
placing the mouse on top of axis and clicking the right mouse button.  
Then select the Edit Properties menu option in the shortcut menu.  
For example, the user can turn on minor tic marks for the y-axis and 
modify the minimum and maximum scale for the x-axis. 
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Figure 5-4.  Example Frequency Curve Plot. 

 

The frequency curve plot can be sent to the printer by selecting the 
Print option from the File menu at the top of the window.  Additional 
printing options available from the File menu are Page Setup, Print 
Preview, and Print Multiple (used for printing multiple graphs on the 
same page).  The graphic can also be sent to the Windows Clipboard 
by selecting Copy to Clipboard from the File menu.  Additionally, the 
plot can be saved to a file by selecting the Save As option from the 
File menu.   When the Save As option is selected, a window will appear 
allowing the user to select a directory, enter a filename, and select the 
format for saving the file.  Currently, four file formats are available for 
saving the graphic to disk, windows metafile, postscript, JPEG, and 
portable network graphic. 

The data contained within the plot can also be tabulated by selecting 
Tabulate from the File menu.  When this option is selected, a 
separate window will appear with the data tabulated.  Additional 
options are available from the File menu for saving the graphics 
options as a template (Save Template) and applying previously 
saved templates to the current graphic (Apply Template).   

The Edit menu on the graphic window contains several options for 
customizing the graphic.  These options include Plot Properties, 
Configure Plot Layout, Default Line Styles, and Default Plot Properties.   
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Also, a shortcut menu will appear with further customizing options 
when the user right-clicks on a line on the graph or the legend. 

The graphic customizing capabilities within HEC-SSP are very powerful, 
but are also somewhat complex to use.  The code used in developing 
the plots in HEC-SSP is the same code that is used for developing 
graphics in HEC-DSSVue and several other HEC software programs.  
Please refer to the HEC-DSSVue User’s Manual for details on 
customizing plots. 

Viewing the Report File 

When the Bulletin 17B computations are performed, a report file of the 
statistical computations is created.  The report file lists all of the input 
data and user settings, plotting positions of the data points, 
intermediate results, each of the various statistical tests performed 
(i.e. high and low outliers, historical data, etc…), and the final results.  
This file is often useful for understanding how the software arrived at 
the final frequency curve.   

Press the View Report button at the bottom of the Bulletin 17B 
Analysis editor to view the report file.  When this button is pressed a 
window will appear containing the report as shown in Figure 5-5. 



HEC-SSP User's Manual Chapter 5 - Performing a Bulletin 17B Flow Frequency Analysis 

 5-13 

Figure 5-5.  Example of the Bulletin 17B Report File. 

 

Plots, tables and reports can also be created by selecting menu options 
from the Results menu.  At least one Bulletin 17B analysis must be 
selected in the study explorer before selecting one of the menu options 
on the Results menu.  Results from multiple analyses are combined in 
one graph if they are selected in the study explorer when the Graph 
menu option is selected.  The ResultsSummary Report menu 
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option will create a summary table of statistics and frequency curve 
ordinates for the selected analyses as shown in Figure 5-6.  

 
Figure 5-6.  Summary Table for Selected Bulletin 17B Analyses. 

  



HEC-SSP User's Manual Chapter 6 - Performing a General Frequency Analysis 

 6-1 

C H A P T E R   6   

Performing a General Frequency 
Analysis 

The current version of HEC-SSP allows the user to perform generalized 
frequency analyses of flow and stage data, as well as other data types.   
The user can choose between different analytical distributions or 
perform a graphical fit to the data.  This chapter discusses in detail 
how to use the General Frequency Analysis editor in HEC-SSP. 

Contents 
• Starting a New Analysis 

• General Settings and Options 

• Analytical Frequency Analysis 

• Graphical Frequency Analysis 

• Viewing and Printing Results 
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Starting a New Analysis 

A general frequency analysis can be started in two ways, either by 
right clicking on the General Frequency Analysis folder in the study 
explorer and selecting New, or by going to the Analysis menu and 
selecting New and then General Frequency Analysis.  When a new 
general frequency analysis is selected, the General Frequency Analysis 
editor will appear as shown in Figure 6-1. 

 
Figure 6-1.  General Frequency Analysis Editor. 

 

The user is required to enter a Name for the analysis, while a 
Description is optional.  A data set (flow, stage, or other) must be 
selected from the available data sets stored in the current study DSS 
file (see Chapter 4 for importing data into the study).  The list of data 
that can be selected for a general frequency analysis will only include 
those data that have an irregular interval, like IR-CENTURY and IR-
YEAR (E-part pathname).  Once a Name is entered and a data set is 
selected, the DSS File Name and Report File will automatically be 
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filled out.  The DSS filename is by default the study DSS file.  The 
report file is given the same name as the analysis with the extension 
".rpt".   

General Settings and Options 

Once the analysis name and data set are selected, the user can begin 
to perform the computations.  Contained on the General Frequency 
Analysis editor are four tabs.  The tabs are labeled General, Options, 
Analytical, and Graphical.  This section of the manual explains the 
use of the General and Options tabs.  

General Settings 

The first tab contains general settings for performing the frequency 
analysis (Figure 6-1).  These settings include: 

• Log Transforms 

• Plotting Positions 

• Confidence Limits 

• Time Window Modification 

Log Transform 

There are two options contained within the Log Transform setting: Use 
Log Transform and Do not use Log Transform.  If the user selects Use 
Log Transform then the logs of the 
data will be taken first.  The frequency 
analysis will be performed on the logs 
of the data.  If the user selects Do not 
use Log Transform, then the 
frequency analysis will be performed on 
the raw data values without taking the 
logs of the data.   The default setting is Use Log Transform.    
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Plotting Positions 

Plotting positions are used for plotting the raw data points on the 
graph.  There are four options for plotting position methodologies 

within HEC-SSP: Weibull, Median, Hazen, 
and user entered coefficients.  The default 
method is the Weibull plotting position 
formula.  The generalized plotting position 
equation is: 

)1(
)(

BAn
AmP
−−+

−
=  

 

Where: m = rank of flood values with the largest equal to 1. 

 n = number of flood peaks in the data set. 

A & B = constants dependent on which equation is used 
(Weibull A and B=0; Median A and B = 0.3; and 
Hazen A and B=0.5). 

Plotting positions are estimates of the exceedance probability of each 
data point.  Different methods can give very different values for the 
probabilities of the highest and lowest points in the data set.  In the 
General Frequency methodology, the plotting of data on the graph by 
a plotting position method is only done as a guide to assist in 
evaluating the computed curve.  The plotting position method selected 
does not have any impact on the computed curve. 

Confidence Limits 

Confidence limits provide a measure of the uncertainty in the 
computed value for a given exceedance probability.  The computation 
of confidence limits is outlined in 
Bulletin 17B, Appendix 9, and is 
applied in the same manner here 
in the general frequency analysis.  
By default, HEC-SSP calculates the 
90 percent confidence interval 
(i.e. the 5% and 95% confidence 
limits).  The confidence limits 
must be entered in decimal form 
(i.e. 95% = 0.95, and 5% = 
0.05).  The user has the option to 
override the default values. 
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Time Window Modification 

This option allows the user to narrow the time window used for the 
analysis.  The default is to use all of the data contained in the selected 
data set.   The 
user can enter 
either a start date 
and end date or 
both a start and 
end date.  If a 
start and/or end 
date are used, 
they must be dates 
that are encompassed within the data stored in the selected data set.  
The date range for the selected data set is shown in the editor just 
above the Start Date field. 

Options 

In addition to the general settings, there are also several options 
available to the user for modifying the computations of the frequency 
curves.  These options include:  

• Low Outlier Threshold 

• Historic Period Data 

• User-Specified Frequency Ordinates 

• Output Labeling 

When the Options tab is selected, the General Frequency Analysis 
editor will appear as shown in Figure 6-2. 
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Figure 6-2.  General Frequency Editor with Options Tab Selected. 

 

Low Outlier Threshold 

High and low outlier tests are based on the procedures outlined in 
Bulletin 17B, and are applied in 
the same manner in the 
General Frequency Analysis.  
The calculated outlier 
magnitudes, by the Bulletin 
17B procedure, are used as 
default values for the high and low outlier thresholds in HEC-SSP.  The 
user has the option to enter a different value for the low outlier 
threshold.  If a value is entered for the low outlier threshold, then this 
value will override the computed value from the Bulletin 17B 
methodology.  When applying the outlier tests, HEC-SSP will identify 
both high and low outliers.  However, only low outliers will be removed 
from the data set when performing the analysis.  If a high outlier is 
identified in the data set, the analyst should try to incorporate 
historical period information to extend the time period for which the 
high outlier(s) is considered to be the maximum value(s).  Further 
discussion of outlier thresholds can be found in Bulletin 17B.  To use 
the low outlier threshold, simply check the box and enter the value. 
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Historic Period Data 

All historic data that provides reliable estimates outside the systematic 
record should be used in order to improve the frequency 
computations.  Information outside of the systematic record can often 
be used to extend the record of the largest events to a historic period 
much longer than that of the systematic record.  HEC-SSP uses 

historic data as 
recommended in 
Bulletin 17B. 
This calculation 
is applied in the 
same manner in 
the General 
Frequency 
Analysis.    To 
use historic 
data, check the 
box labeled Use 
Historic Data.  
The user can 
enter a starting 
year for the 
historic period, 
ending year for 

a historic period, and a High Threshold value.  If the user enters a high 
threshold value, then any data in the systematic record greater than 
that value will also be treated as a historical annual maximum.   The 
user can also enter historic data that are not contained in the 
systematic record.  This is done in the table at the bottom labeled 
Historic Events.  All years must be entered as water year values 
(October 1 through September 30).  If a start year is not entered, then 
the assumed start year is the earliest year of the systematic record 
and any historical values that have been entered.  If an end year is not 
entered, then the assumed end year is the latest year in the 
systematic record and any entered historic values.  Further discussion 
of the use of historical data can be found in Bulletin 17B. 

Note:  The program treats all data in the data set as systematic data.  
If historic events are included in the data set, then the user can define 
the analysis time window (General tab – Time Window Modification) so 
that it only bounds the systematic record.  Then define the historic 
events in the Historic Events table.  Instead of using the Time Window 
Modification option, another option is to enter a High Threshold value 
so that the historic data point(s) would be treated as historic data 
(rather than part of the systematic record).  Please see test example 6 
in Appendix B for an example of using the historic data adjustment. 
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User Specified Frequency Ordinates 

This option allows the user to change the frequency ordinates used in 
computing 
the resulting 
frequency 
curves and 
confidence 
limits.  The 
default values 
listed in 
percent 
chance 
exceedance 
are 0.2, 0.5, 1, 2, 5, 10, 20, 50, 80, 90, 95, and 99.  Check the box 
next to Use Values from Table below to change or add additional 
values.  Once this box is checked, the user can add/remove rows and 
edit the frequency values.  To add or remove a row from the table, 
select the row(s), place the mouse over the highlighted row(s) and 
click the right mouse button.  The shortcut menu contains options to 
Insert Row(s) and Delete Row(s).  The program will use the 
default values, even if they are not contained in the table, when the 
Use Values from Table below option are not checked.  Finally, all 
values in the table must be between 0 and 100. 

Output Labeling 

This option allows the user to change the default labels for data 
contained in the output tables and plots.  The user can change both 

the name of 
the data as 
well as how 
the units of 
the data are 
labeled. 

 

 

Analytical Frequency Analysis 

Once the new analysis has been defined and the user has all of the 
general settings and options the way they want them, the user can 
choose between performing an Analytical Frequency analysis or a 
Graphical Frequency analysis.  This section of the manual describes 
how to use the Analytical Frequency analysis option. 

When the user selects the Analytical tab on the General Frequency 
Analysis editor, the window will appear as shown in Figure 6-3.  As 
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shown, three additional tabs will appear on the screen: Settings, 
Tabular Results, and Plot. 

 
Figure 6-3.  Analytical Analysis Tab of the General Frequency Analysis Editor. 

 

Settings 

The Settings tab contains additional settings for the analytical 
frequency analysis.  These settings include: 

• Distribution 

• Generalized Skew 

• Expected Probability Curve 
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Distribution 

This option allows the user to select from available analytical 
distributions to perform the frequency analysis.  The current version of 
HEC-SSP contains five distribution choices: None, Normal, LogNormal, 

Pearson III, and LogPearson 
III.   If the user has selected 
to transform the data to log 
space (General tab), then the 
only available choices for 
distribution will be None, 
LogNormal, and LogPearson 
III.  If the user did not select 

the option to transform the data to log space (General tab), then the 
only available choices for distribution will be None, Normal and 
Pearson III. 

Generalized Skew 

There are three options contained within the generalized skew setting: 
Use Station Skew, Use Weighted Skew, and Use Regional Skew.  The 
default skew setting is Use Station Skew.  With this setting, the skew 
of the computed curve 
will be based solely on 
computing a skew from 
the data points.   

The Use Weighted 
Skew option requires 
the user to enter a 
generalized regional 
skew and a Mean-
Square Error (MSE) of 
the generalized regional 
skew.  This option weights the computed station skew with the 
generalized regional skew.  The equation for performing this weighting 
can be found in Bulletin 17B (Equation 6).  If a regional skew is taken 
from Plate I of Bulletin 17B (the skew map of the United States), the 
value of MSE = 0.302.   

The last generalized skew option is Use Regional Skew.  When this 
option is selected, the user must enter a generalized regional skew 
and an MSE for that skew.  The program will ignore the computed 
station skew and use only the generalized regional skew. 
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Expected Probability Curve   

This setting has two options: Compute the expected probability curve 
and do not compute the expected probability curve.  The default 
setting is to have the expected probability curve computed.  When 
computed, this curve will be shown in both the tables and the plots as 

an additional curve to the 
computed curve.  The 
expected probability 
adjustment is an attempt to 
correct for a certain bias in the 
frequency curve computation 
due to the shortness of the 

record.  Please review the discussion in Bulletin 17B about the 
expected probability curve adjustment for an explanation of how and 
why it is computed.  The use of the expected probability curve is a 
policy decision.  It is most often used in establishing design flood 
criteria.  The basic flood frequency curve without the expected 
probability curve adjustment is the curve used in computation of 
confidence limits, risk, and in obtaining weighted averages of 
independent estimates of flood frequency discharge (WRC, 1982). 

Compute 

Once the new analysis has been defined, and the user has all of the 
General, Options, and Settings information selected the way they 

want, performing the computations is simply a matter 
of pressing the Compute button at the bottom of the 

General Frequency Analysis editor.  If the computations are successful, 
the user will receive a message that says “Compute Complete”.  At 
this point, the user can begin to review the results of the Analytical 
Frequency computations. 

Multiple General Frequency analyses can be computed using the 
Compute Manager.  Select the AnalysisCompute Manager menu 
option to open the Compute Manager.  Select the analyses to be 
computed and then press the Compute button.  Close the compute 
dialogs and Compute Manager when the program finished computing 
the analyses.  

Tabular Results 

The Tabular Results tab will bring up a table of results for the 
Analytical Frequency analysis.  An example of the results tab is shown 
in Figure 6-4. 

As shown in Figure 6-4, the window contains three tables.  The top 
table contains results of the computed frequency curve.  The very left 
column of the top table is the Percent Chance Exceedance for all the 
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computed values.  The next three columns in the top table contain the 
computed frequency curve and the 95% and 5% confidence limits that 
correspond to that computed curve.  The last three columns of the top 
table contain a computed frequency curve and confidence limits for an 
analysis based on user-adjusted statistics for the mean, standard 
deviation, adopted skew, and equivalent years of record.  User entered 
adjusted statistics are an option that the user can set on the Plot tab, 
which is discussed in detail in the next section of this manual.  If the 
user has not entered adjusted statistics, then these columns will be 
empty.  Data in the frequency curve table can be re-sorted.  Click the 
Percent Chance Exceedance column header (two mouse clicks are 
required the first time).  The percent chance exceedance ordinates, 
along with frequency curve and confidence limits values, will sort so 
that the lowest values are on top or the highest values are on top.   

Two additional tables are shown at the bottom of the window: System 
Statistics and Number of Events.  The System Statistics table 
consists of the mean, standard deviation, station skew, user entered 
regional skew, weighted skew (weighted between station skew and 
regional skew), and the adopted skew for the analysis.  The Number 
of Events table contains the number of historic events, high outliers, 
low outliers, zero or missing values, systematic events, and the 
number of years in the historic period (this value only comes into play 
if the user entered historic data). 

Additionally, the lower right portion of the table will show if Log 
Transform is On or Off, and which analytical distribution was selected 
for the analysis. 
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Figure 6-4.  Tabular Results Tab for Analytical Analysis. 

 

Plot 

In addition to tabular results, a Plot tab is available for viewing a 
graphical plot of both the computed frequency curve, as well as a 
computed curve based on any user-adjusted statistics.  When the Plot 
tab is selected the window will change to what is shown in Figure 6-5. 
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Figure 6-5.  Plot Tab of the General Frequency Analytical Analysis. 
 
 

As shown in Figure 6-5, the plot contains the computed frequency 
curve, 95% and 5% confidence limits, and raw data points plotted by 
the user selected plotting position method.  The computed statistics for 
the frequency curve are shown in a table on the right side of the 
window.  Below the computed statistics is a table labeled "User 
Statistics".  There is a check box and a data entry field for the Mean, 
Standard Deviation, Adopted Skew, and Equivalent Years of Record.  
The user can enter values into any or all of these fields.  Turning on 
the check box then enables that field to be used in computing a curve 
with the user entered statistic overriding the computed value from the 
raw data.  The user statistics option allows the user to see how the 
curve would change if any or all of the statistics were different.  When 
data is entered into the user statistics fields, and the check boxes are 
turned on, the user must press the compute button again in order for 
the computations to be performed with the user entered statistics.  
After the compute button is pressed, both the plot and the table on the 
Tabular Results tab will be updated to reflect any user entered 
statistics. 
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Graphical Frequency Analysis 

In addition to an analytical frequency analysis which uses a statistical 
distribution fit to the data, the user has the option to graphically fit a 
curve to the data.  A graphical fit can be very useful when the 
available analytical distributions do not provide a good fit to the data.  
One example of when a graphical frequency analysis is most 
appropriate is when plotting a frequency curve for flow data that is 
downstream of a flood control reservoir.  Analytical frequency 
distributions are often not appropriate for describing flow data that is 
significantly regulated by upstream reservoirs.  In general, a portion of 
the flow frequency data for a highly regulated stream will be very flat 
in the zone in which upstream regulation can control the flows for a 
range of frequencies.  This type of data lends itself to a graphical fit 
analysis rather than the use of an analytical equation.  Another 
example of using a graphical fitting technique over an analytical curve 
is when trying to compute a frequency curve for annual peak stage 
data at a point on a river.  Often the stages will flatten out with 
decreased frequencies when flows go out into the overbank and 
floodplain area.  Again, this type of data is fitted much better using a 
graphical fit curve instead of an analytical distribution. 

When the Graphical tab is selected, the editor will display a plot and 
table as shown in Figure 6-6.  In the plot, the data will be plotted 
using the user selected plotting position method.  The table to the 
right of the plot allows the user to enter data values for the frequency 
ordinates defined on the Options tab.  The Data Type and Equivalent 
Years of Record options are required to compute the confidence 
limits using the order statistics method that is discussed in ETL 1110-
2-537.  If the data is not flow or stage, select the Flow data type 
when the graphical frequency curve is approximately analytic for 
extreme probabilities (frequency curve is not relatively flat for extreme 
probabilities).  Select the Stage data type when the graphical 
frequency curve is relatively flat for extreme probabilities (ETL 1110-2-
537). When the user enters values into the frequency curve table, 
those values will be plotted as a line on the plot after the Compute 
button is pressed.  The idea is to enter values in the table that will 
create a best fit line of the data, based on the user’s judgment. 
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Figure 6-6.  Graphical Tab of the General Frequency Analysis Editor. 

 

Viewing and Printing Results 

The user can view output for the frequency analysis directly from the 
General Frequency Analysis editor (Tabular and Graphical output) or 
by using the plot and view buttons at the bottom of the editor.  The 
output consists of tabular results, an analytical frequency curve plot, a 
graphical frequency curve plot, and a report documenting the data and 
computations performed. 

Tabular Output 

Once the computations for the analytical frequency analysis are 
completed, the user can view tabular output by selecting the Tabular 
Results tab under the Analytical analysis tab.  The details of this 
table were discussed under the analytical analysis option above. 
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The tabular results can be printed by using the Print button at the 
bottom of the General Frequency Analysis editor.  When the print 
button is pressed, a window will appear giving the user options for how 
they would like the table to be printed. 

Graphical Output 

Graphical output of the analytical frequency curve can be obtained by 
selecting either the Plot tab under the analytical analysis tab, or by 
pressing the button labeled Plot Analytical Curve at the bottom of 
the general frequency editor.  When the Plot Analytical Curve button is 
pressed, a frequency curve plot will appear in a separate window as 
shown in Figure 6-7. 

 
Figure 6-7.  Analytical Analysis Frequency Curve Plot. 

 

The analytical frequency curve plot can be sent to the printer by 
selecting the Print option from the File menu at the top of the 
window.  Additional printing options available from the File menu are 
Page Setup, Print Preview, and Print Multiple (used for printing 
multiple graphs on the same page).  The graphic can also be sent to 
the Windows Clipboard by selecting Copy to Clipboard from the File 
menu.  Additionally, the plot can be saved to a file by selecting the 
Save As option from the File menu.   When the Save As option is 
selected, a window will appear allowing the user to select a directory, 
enter a filename, and select the format for saving the file.  Currently 
four file formats are available for saving the graphic to disk: windows 
metafile, postscript, JPEG, and portable network graphic.   
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The data contained within the plot can also be tabulated by selecting 
Tabulate from the File menu.  When this option is selected, a 
separate window will appear with the data tabulated.  Additional 
options are available from the File menu for saving the plot options as 
a template (Save Template) and applying previously saved templates 
to the current plot (Apply Template).   

The Edit menu contains several options for customizing the graphic.  
These options include Plot Properties, Configure Plot Layout, Default 
Line Styles, and Default Plot Properties.  Also, a shortcut menu will 
appear with further customizing options when the user right-clicks on 
a line on the graph or the legend.  Both the Y and X-axis properties 
can be edited by placing the mouse on top of axis and clicking the 
right mouse button.  Then select the Edit Properties menu option in 
the shortcut menu.  For example, the user can turn on minor tic marks 
for the y-axis and modify the minimum and maximum scale for the x-
axis.  The graphic customizing capabilities within HEC-SSP are very 
powerful, but are also somewhat complex to use.  The code used in 
developing the plots in HEC-SSP is the same code that is used for 
developing plots in HEC-DSSVue and several other HEC software 
programs.  Please refer to the HEC-DSSVue User’s Manual for details 
on customizing plots. 

A plot of the graphical frequency curve can be obtained by pressing 
either the Graphical tab, or by pressing the button labeled Plot 
Graphical Curve at the bottom of the general frequency editor.  
When the Plot Graphical Curve button is pressed, a frequency curve 
plot will appear in a separate window as shown in Figure 6-8.  All of 
the same options for tabulating, printing, and sending results to the 
windows clipboard are available for this plot as they are for the 
analytical frequency curve plot. 
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Figure 6-8.  Graphical Analysis Frequency Curve Plot. 

 

Viewing the Report File 

When the General Frequency analysis computations are performed, a 
report file of the statistical computations is created.  The report file 
lists all of the input data and user settings, plotting positions of the 
data points, intermediate results, each of the various statistical tests 
performed (i.e. high and low outliers, historical data, etc…), and the 
final results.  This file is often useful for understanding and describing 
how the software arrived at the final frequency curve.   

To view the report file press the View Report button at the bottom of 
the General Frequency analysis editor.  When this button is pressed, a 
window will appear containing the report as shown in Figure 6-9. 
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Figure 6-9.  General Frequency Analysis Report File. 

 



HEC-SSP User's Manual Chapter 6 - Performing a General Frequency Analysis 

 6-21 

Plots, tables and reports can also be created by selecting menu options 
from the Results menu.  At least one General Frequency analysis 
must be selected in the study explorer before selecting one of the 
menu options on the Results menu.  Results from multiple analyses 
are combined in one graph if they are selected in the study explorer 
when the Graph menu option is selected.  The ResultsSummary 
Report menu option will create a summary table of statistics and 
frequency curve ordinates for the selected analyses as shown in Figure 
6-10.  

 
Figure 6-10.  Summary Table for Selected General Frequency Analyses. 
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C H A P T E R   7   

Performing a Volume Frequency 
Analysis 

The current version of HEC-SSP allows the user to perform a volume 
frequency analysis of flow data.  In this type of analysis, frequency 
curves are developed using daily average flows.  Runoff volumes are 
expressed as average flows over a time duration.  For example, the 3-
day flow is the average flow over a three day period.  The volume from 
the 3-day flow would be computed by multiplying the 3-day flow (in 
cfs) by 259200 seconds (3-days).  Typical volume frequency analyses 
would develop frequency curves for a number of volumes (flow-
duration), like the 1, 3, 7, 15, 30, 60, 90, 120, and 180 day volumes.  
The user can choose between different analytical distributions as well 
as perform a graphical fit to the data.  This chapter discusses in detail 
how to use the Volume Frequency Analysis editor in HEC-SSP. 

Contents 
• Starting a New Volume Frequency Analysis 

• General Settings and Options 

• Extracting the Volume-Duration Data 

• Analytical Frequency Analysis 

• Graphical Frequency Analysis 

• Viewing and Printing Results 
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Starting a New Volume Frequency Analysis 

A volume frequency analysis can be started in two ways within the 
software, either by right clicking on the Volume Frequency Analysis 
folder in the study explorer and selecting New, or by going to the 
Analysis menu and selecting New and then Volume-Frequency 
Analysis.  When a new volume frequency analysis is selected, the 
Volume Frequency Analysis editor will appear as shown in Figure 7-1. 

  Figure 7-1.  Volume Frequency Analysis Editor. 

 

The user is required to enter a Name for the analysis; while a 
Description is optional.  A data set must be selected from the 
available data sets stored in the current study DSS file (see Chapter 4 
for importing daily flow data into the study).  The list of data that can 
be selected for a volume frequency analysis will only include those 
data that have a regular interval, like 1HOUR and 1DAY (E-part 
pathname).  Once a Name is entered and a data set is selected, the 
DSS File Name and Report File will automatically be filled out.  The 
DSS filename is by default the same name as the study DSS file.  The 
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report file is given the same name as the analysis with the extension 
".rpt".  

General Settings and Options 

Once the analysis name and data set are selected, the user can begin 
defining the analysis.  Five tabs are contained on the Volume 
Frequency Analysis editor.  The tabs are labeled General, Options, 
Duration Table, Analytical, and Graphical.  This section of the 
manual explains the use of the General and Options tabs.  

General Settings 

The first tab contains general settings for performing the frequency 
analysis (Figure 7-1).  These settings include: 

• Log Transforms 

• Plotting Positions 

• Maximum or Minimum Analysis 

• Year Specification 

• Time Window Modification 

Log Transform 

There are two options contained within the Log Transform setting: Use 
Log Transform and Do not use Log 
Transform.  If the user selects Use 
Log Transform, then the logs of the 
data will be computed first, and the 
frequency analysis will be performed 
on the logs of the data.  If the user 

selects Do not use Log Transform, then the frequency analysis will 
be performed on the raw data values without taking the logs of the 
data.  The default setting is Use Log Transform. 
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Plotting Positions 

Plotting positions are used for plotting the raw data points on the 
graph.  There are four options for plotting position within HEC-SSP: 

Weibull, Median, Hazen, 
and user entered 
coefficients.  The default 
method is the Weibull 
plotting position method.   

 

 

 

 

 

 

 

 

The generalized plotting position equation is: 
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Where: m = rank of flood values with the largest equal to 1. 

  n = number of flood peaks in the data set. 

A & B = constants dependent on which equation is used 
(Weibull A and B=0; Median A and B = 0.3; and 
Hazen A and B=0.5). 

Plotting positions are estimates of the exceedance probability for each 
data point.  Different methods can give different values for the 
probabilities of the highest and lowest points in the data set.  The 
plotting of data on the graph by a plotting position method is only 
done as a guide to assist in evaluating the computed curve.  The 
plotting position method selected does not have any impact on the 
computed curve. 
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Maximum or Minimum Analysis 

A volume frequency analysis can be performed using annual maximum 
or minimum flows.  A maximum flow analysis could be used for 
determining the amount of reservoir storage required for a flood of 
specific frequency.  A minimum flow, or low flow analysis, could be 
used determine if a river could 
supply a given demand.  A low 
flow analysis could also be 
beneficial for water quality and 
reservoir storage projects. There 
are two options contained in the 
Maximum or Minimum Analysis 
section.   If Analyze Maximums is selected, then the program will 
extract annual maximum volumes for all durations.  The program will 
extract annual minimum volumes for all durations if Analyze 
Minimums is selected.  

Year Specification 

This option allows the user to define the beginning and ending date for 
what will be considered as the analysis year for extracting the data.  
These dates are used for extracting the annual maximum or minimum 
flows, in order to get one value for each analysis year.  It is important 
to choose a start date that captures all flood events from a certain 
hydrologic regime.  If high flows generally occur between November 

and May, then the year 
should not start 
between these months.   
This will minimize the 
possibility that the same 
flood event is used for 
consecutive years.  
There are three options 
contained in the Year 
Specification section.   If 
Water Year is selected, 
the program uses a 
starting date of October 
1 and an ending date of 
September 30.  If 

Calendar Year is selected, the program uses a starting date of 
January 1 and an ending date of December 31.  The Other option lets 
the user define the starting date.  One way to determine when the 
year should begin is to plot each year of record on top of one another, 
as shown in Figure 7-2.  The program will create a graph like the one 
shown in Figure 7-2 when the Plot Yearly Data button is pressed.  
This data set is from an area that experiences both snowmelt floods 
and summer/fall rain floods.  Starting the year on January 1 would be 
more appropriate for this data set because a few large flood events 
occurred around October 1.                
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Figure 7-2.  Plot Showing when Flood Events Typically Occur. 

 

Time Window Modification 

This option allows the user to narrow the time window used for the 
analysis.  When left unchecked, the program will use all of the data 
contained in the selected data set.  The user can enter either a start or 
end date or both a start and end date.  If a start and/or end date are 
used, they must be dates that are included within the selected data 
set.  The date range for the selected data set is shown in the editor 
just above the Start Date field.    

An additional option at the bottom of the time window modification 
section allows the user to define a shorter duration, a Season, within 
the year in which the program extracts maximum or minimum flows.  
This option allows the user to analyze floods that typically occur during 
a specific season, like snowmelt floods.  When left unchecked, the 
program will examine all flow records during the year.  The season 
start and end dates must be entered using a two digit day followed by 
the month, example 15May.  The season start and end dates must fall 
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within a year as defined in the Year Specification.  The user must enter 
both start and end dates to define the season subset. 

 

Options 

In addition to the general settings, there are also several options 
available to the user for modifying the computation of the volume-
frequency curves.  These options include:  

• Flow-durations 

• User-Specified Frequency Ordinates 

• Output Labeling 

• Low Outlier Threshold 

• Historic Period Data 

When the Options tab is selected, the Volume Frequency Analysis 
editor will appear as shown in Figure 7-3. 
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Figure 7-3.  Volume Frequency Analysis Editor with Options Tab Selected. 

                                         

Flow-Durations 

This option lets the user define which durations are used in the volume 
frequency analysis.  The program will extract annual maximum or 

minimum volumes based on the 
durations defined in this table.  
The default durations are 1, 3, 
7, 15, 30, 60, 120, and 183 
days.  Check the box next to 
Change or add to default 
values to change or add 
additional durations to the 
analysis.  Once this box is 
checked, the user can 
add/remove rows and edit the 
duration values.  To add or 
remove a row from the table, 
select the row(s), place the 
mouse over the highlighted 
row(s) and click the right 

mouse button.  The shortcut menu contains options to Insert Row(s) 
and Delete Row(s).  The program will use the default durations, even 
if they are not contained in the table, when the Change or add to 
default values option is not checked.   
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User Specified Frequency Ordinates 

 This option allows the user to 
change the frequency ordinates 
used for creating result tables and 
graphs.  The default values listed 
in percent chance exceedance are 
0.2, 0.5, 1, 2, 5, 10, 20, 50, 80, 
90, 95, and 99.  Check the box 
next to Use Values from Table 
below to change or add 
additional values.  Once this box 
is checked, the user can 
add/remove rows and edit the 
frequency values.  To add or 
remove a row from the table, 
select the row(s), place the 
mouse over the highlighted 
row(s) and click the right mouse 
button.  The shortcut menu 

contains options to Insert Row(s) and Delete Row(s).  The 
program will use the default values, even if they are not contained in 
the table, when the Use Values from Table below option is not 
checked.  Finally, all values in the table must be between 0 and 100. 

Output Labeling 

This option allows the user to change the default labels for data 
contained in the output tables and plots.  The user can change both 
the name of the data and how the units of the data are labeled.   
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Low Outlier Threshold 

High and low outlier tests are based on the procedures outlined in 
Bulletin 17B, and are applied in the same manner in the Volume 
Frequency 
Analysis.  The 
outlier 
magnitudes 
calculated by 
the Bulletin 
17B 
procedure are 
used as 
default values 
for the high and low outlier thresholds in HEC-SSP.  The user has the 
option to enter a different low outlier threshold for each duration.  If a 
value is entered for the low outlier threshold, then this value will 
override the computed value from the Bulletin 17B methodology.  
When analyzing maximum flows, HEC-SSP will identify both high and 
low outliers.  However, only low outliers will be removed from the data 
set when performing the analysis.  If a high outlier is identified in the 
data set, the analyst should try to incorporate historical period 
information to extend the time period for which the high outlier(s) is 
considered to be the maximum value(s).  Further discussion of outlier 
thresholds can be found in Bulletin 17B and the HEC-SSP Statistical 
Reference Guide.  To use the low outlier threshold, simply check the 
box and enter a value for one duration or all durations.   

When Analyzing Minimums is selected on the General tab, then the 
Low Outlier Threshold criteria becomes the High Outlier Threshold.  
When applying the outlier tests, HEC-SSP will identify both high and 
low outliers.  However, only high outliers will be removed from the 
data set when performing the analysis.  If a low outlier is identified in 
the data set, the analyst should try to incorporate historical period 
information to extend the time period for which the low outlier(s) is 
considered to be the minimum value(s).   

Historic Period Data 

All historic data that provides reliable estimates outside the systematic 
record should be used in order to improve the frequency 
computations.  Information outside of the systematic record can often 
be used to extend the record of the largest events to a historic period 
much longer than that of the systematic record.  HEC-SSP uses 
historic data as recommended in Bulletin 17B. This calculation is 
applied in the same manner in the Volume Frequency Analysis.  To use 
historic data, check the box labeled Use Historic Data.  The user can 
enter a starting year for the historic period, ending year for a historic 
period and a High Threshold value for each duration as shown in 
Figure 7-4.  If the user enters a high threshold value, then any data in 
the systematic record greater than that value will also be treated as a 
historical annual maximum.  The user can also enter historic data that 
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are not contained in the systematic record.  This is done in the table at 
the bottom labeled Historic Events.  If a start year is not entered, 
then the assumed start year is the earliest year of the systematic 
record and any historical values that have been entered.  If an end 
year is not entered, then the assumed end year is the latest year in 
the systematic record and any entered historic values.  Further 
discussion of the use of historical data can be found in Bulletin 17B.  If 
Analyze Minimums is selected on the General tab then the High 
Threshold becomes the Low Threshold.  The program will treat 
systematic values that are lower than the low threshold as historic 
annual minimums.  

Note:  The program treats all data in the data set as systematic data.  
If historic events are included in the data set, then the user can define 
the analysis time window (General tab – Time Window Modification) so 
that it only bounds the systematic record.  Then define the historic 
events in the Historic Events table.  Instead of using the Time Window 
Modification option, another option is to enter a High Threshold value 
so that the historic data point(s) would be treated as historic data 
(rather than part of the systematic record).   

 
Figure 7-4.  Historic Period Data on the Options Tab. 
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Extracting The Volume-Duration Data 

The user can extract the volume-duration data once settings have 
been defined on the General and Options tabs.  When the Duration 
Table tab is selected, the Volume Frequency Analysis editor will appear 
as shown in Figure 7-5.  The program will compute the annual 
maximum or minimum average flows for the durations specified on the 
Options tab when the user presses the Extract Volume-Duration 
Data button at the bottom of the Duration Table.   

The program computes the maximum/minimum flows by evaluating 
the flow record as one continuous record.  For each duration, the 
program computes a time-series of average flow.  These time-series 
are written to the study DSS file and can be viewed using HEC-
DSSVue.  Then the program extracts the annual maximum/minimum 
flows and populates the duration table.   

The Allow Editing checkbox in the upper left portion of the Duration 
Table tab allows the user to manually edit values in the volume-
duration table.  The table becomes editable when the Allow Editing 
box is checked.  Then the user can overwrite the extracted volume-
duration data.  In addition, the program will no longer extract volume-
duration data during a compute and the Extract Volume-Duration 
Data button becomes inactive.    

When computing the analysis, the program will issue a warning 
message if any of the maximum/minimum flows occur a specific 
number of days after the beginning of the year.  The number of days is 
determined by the duration plus five days.  For example, for a fifteen-
day duration, the program issues a warning if the maximum/minimum 
is within twenty days after the beginning of the year.  If water year is 
chosen, then the program issues a warning if the maximum/minimum 
occurs between October 1 – October 20.  This warning is an attempt to 
let the user know if a maximum or minimum flow is generated by an 
event that began in the previous year.  The goal is to prevent a 
scenario in which the same flow event causes maximum/minimum 
flows in consecutive years; this is why it is important to choose an 
appropriate annual starting date.  
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Figure 7-5.  Volume-Duration Table. 

 

The user must Compute the analysis before viewing a frequency plot 
of the volume-duration data.  The plot created by pressing the Plot 
Duration Data button, located at the bottom of a Volume Frequency 
Analysis editor, shows the annual maximum/minimum volumes plotted 
using the user specified plotting position method, as shown in Figure 
7-6.   
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Figure 7-6.  Plot of Volume-Duration Data.   

 

Analytical Frequency Analysis 

The user can choose between performing an Analytical Frequency 
Analysis or a Graphical Frequency Analysis once settings have been 
defined on the General and Options tabs.  The Duration Data does not 
have to be extracted before computing an analysis.  The program will 
automatically extract the duration data when the Compute button is 
pressed.  This section of the manual describes how to compute and 
view results for an Analytical Frequency Analysis. 

When the user selects the Analytical tab on the Volume Frequency 
Analysis editor, the window will appear as shown in Figure 7-7.  As 
shown, four additional tabs will appear on the screen: Settings, 
Tabular Results, Plot, and Statistics. 
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Figure 7-7.  Analytical Tab of the Volume Frequency Analysis Editor. 

 

Settings 

In addition to settings on the General and Options tabs, there are 
more options on the Settings tab the user must define in order to 
perform an Analytical Frequency analysis on the volume-duration data.  
These settings include: 

• Distribution 

• Expected Probability Curve 

• Skew 

Distribution 

This option allows the user to select a distribution to perform the 
frequency analysis.  The current version of HEC-SSP contains five 
distribution choices: None, Normal, LogNormal, 
Pearson III, and LogPearson III.  If the user has 
selected the Use Log Transform option, 
located on the General tab, then the available 
choices for distribution are None, LogNormal, 
and LogPearson III.  If the user has selected 
the Do not use Log Transform option, located 
on the General tab, then the distribution choices 
are None, Normal, and Pearson III. 
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Expected Probability Curve 

This setting has two options, Compute Expected Prob. Curve and 
Do Not Compute Expected Prob. Curve.  The default setting is to 
have the expected probability curve computed.   When computed, this 
curve will be shown in both 
the result table and the plot 
as an additional curve to the 
computed curve.  The 
expected probability 
adjustment is an attempt to 
correct for a certain bias in 
the frequency curve computation due to the shortness of the record.  
Please review the discussion in Bulletin 17B about the expected 
probability curve adjustment for an explanation of how and why it is 
computed.  The use of the expected probability curve is a policy 
decision.  It is most often used in establishing design flood criteria.  
The basic flood frequency curve without the expected probability curve 
adjustment is the curve used in computation of confidence limits, risk, 
and in obtaining weighted averages of independent estimates of flood 
frequency discharge (WRC, 1982). 

Skew   

The skew option is only available whenever the analytical distribution 
is set to PearsonIII or LogPearsonIII.  There are three options 
contained within the skew setting, Use Station Skew, Use Weighted 
Skew, and Use 
Regional Skew.  
The default skew 
setting is Use 
Station Skew.   
With this setting, 
the skew of the 
computed curve will 
be based solely on 
computing a skew 
from the data 
points.   

The Use Weighted 
Skew option 
requires the user to 
enter a generalized 
regional skew and a 
mean-square error 
(MSE) of the 
generalized regional skew.  This option weights the computed station 
skew with the generalized regional skew.  The equation for performing 
this weighting can be found in Bulletin 17B (Equation 6).  If a regional 
skew is taken from Plate I of Bulletin 17B (the skew map of the United 
States), the value of MSE = 0.302.   
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The Use Regional Skew option requires the user to enter a 
generalized regional skew and a mean-square error (MSE) of the 
generalized regional skew.  The program will ignore the computed 
station skew and use only the generalized regional skew. 

Compute  

Press the Compute button, located at the bottom of the Volume 
Frequency Analysis editor, once options have been set 
on the General, Options, and Settings tabs.  If the 
compute is successful, the user will receive a message 
that says Compute Complete.  At this point, the user 

can review results from the analytical analysis by selecting the Tabular 
Results and Plot tabs. 

Multiple Volume Frequency analyses can be computed using the 
Compute Manager.  Select the AnalysisCompute Manager menu 
option to open the Compute Manager.  Select the analyses to be 
computed and then press the Compute button.  Close the compute 
dialogs and Compute Manager when the program finishes computing 
the analyses.  

Tabular Results 

The Tabular Results tab contains a table of results for the analytical 
frequency analysis.  An example of the results table is shown in Figure 
7-8.  The top portion of this table contains the analytical frequency 
curves for each duration.  Data in the frequency curves can be re-
sorted.  Click the Percent Chance Exceedance column header (two 
mouse clicks are required the first time).  The percent chance 
exceedance ordinates, along with the frequency curves, will sort so 
that the lowest values are on top or the highest values are on top.  
The statistics of the analytical frequency curves are contained below 
the frequency curve ordinates.  The statistics include the mean, 
standard deviation, station skew, regional skew, weighted skew, 
adopted skew, number of years of record, and number of years with 
zero or missing flow.   

User-adjusted statistics can be defined by the user on the Statistics 
tab.  If the user has not entered statistics on the Statistics tab, then 
the results table will look similar to Figure 7-8.  If the user does enter 
statistics on the Statistics tab, then the results table will include the 
adjusted mean, adjusted standard deviation, and adjusted skew.  If 
specified by the user, the program will use the user-adjusted statistics 
when computing the analytical curves.  
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Figure 7-8.  Tabular Results for a Volume Frequency Analysis. 

 

Plot 

In addition to tabular results, a Plot tab is available for viewing 
results, as shown in Figure 7-9.  The results graph includes the 
systematic annual maximum/minimum volumes, plotted using the 
specified plotting position method, and the analytical frequency 
curves.  The analytical frequency curves are based on the computed 
statistics or user-adjusted statistics if they are defined on the Statistics 
tab.  
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Figure 7-9.  Plot of Analytical Results for a Volume Frequency Analysis. 

 

Statistics 

As discussed in EM 1110-2-1415, a necessary step in a volume-
frequency analysis is to make sure the analytical frequency curves are 
consistent across all durations (USACE, 1993).   In some situations, 
frequency curves from different durations might cross one another.  
The Statistics tab contains tools allowing the user to modify the 
mean, standard deviation, and skew to make sure frequency curves do 
not cross one another.   

When the user selects the Statistics tab, the window will appear as 
shown in Figure 7-10.  The upper portion of the Statistics tab contains 
a plot of the computed and user-adjusted statistics.  The user has the 
option of choosing the parameter to be plotted in the comparison 
graph.  Computed statistics are plotted as black data points and user-
adjusted statistics are plotted as blue data points.  The first table, 
Sample Statistics, contains the statistics computed from the 
systematic data.  In addition, the adopted skew value in this table can 
be the station skew, weighted skew, or regional skew.  The adopted 
skew is set by the user on the Settings tab.  The lower table is where 
the user enters the adjusted statistics.  Before entering adjusted 
statistics, the user must check the box in Column 1.  User-adjusted 
statistics entered in this table are used when the program computes 
the analytical frequency curve. 
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Figure 7-10.  Statistics Tab in the Volume Frequency Analysis Editor. 

 

Graphical Frequency Analysis 

In addition to an analytical frequency analysis, which uses a statistical 
distribution to fit the data, the user has the option to graphically fit a 
frequency curve to the data.  A graphical curve can be very useful 
when the available analytical distributions do not provide a good fit.  
One example of when a graphical frequency analysis is more 
appropriate is when plotting a frequency curve for flow data that is 
downstream of a flood control reservoir.  Analytical frequency 
distributions are often not appropriate for fitting flow data that is 
significantly regulated by upstream reservoirs.  In general, a portion of 
the flow frequency data for a highly regulated stream will be very flat 
in the zone in which upstream regulation can control the flow.  This 
type of data lends itself to a graphical fit.   

When the Graphical tab is selected on the Volume Frequency analysis 
editor, the window will appear as shown in Figure 7-11.  As indicated, 
two additional tabs will appear on the screen, Curve Input and Plot.   
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Figure 7-11.  Graphical Curve Table for a Volume Frequency Analysis. 

 

Curve Input 

The user manually enters the frequency ordinates for all durations in 
the table on the Curve Input tab.  As previously mentioned, the 
number of frequency ordinates and durations are set on the Options 
tab.  The idea is to enter values in the table that will create a best fit 
line of the data, based on the user’s judgment.  Data entered in the 
graphical curve table will be plotted as a line in the graph on the Plot 
tab after the Compute button is pressed.  

Plot 

The graphical analysis Plot tab is available for viewing results, as 
shown in Figure 7-12.  The results graph includes the historic annual 
maximum/minimum flows, plotted using the specified plotting position 
method, and the user-defined graphical curve, which was entered in 
the table on the Curve Input tab. 
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Figure 7-12.  Plot Tab for a Graphical Analysis. 

 

Viewing and Printing Results – Volume Frequency 
Analysis 

The user can view output for the frequency analysis directly from the 
Volume Frequency Analysis editor (Tabular and Graphical output) or by 
using the plot and view report buttons at the bottom of the editor.  
The output consists of tabular results, an analytical frequency curve 
plot, a graphical frequency curve plot, and a report documenting the 
data and computations performed. 

Tabular Output 

Once the computations for the analytical frequency analysis are 
completed, the user can view tabular output by opening the Tabular 
Results tab under the Analytical analysis tab.  The details of this 
table were discussed above.  The tabular results can be printed by 
using the Print button at the bottom of the Volume Frequency 
Analysis editor.  When the print button is pressed, a window will 
appear, giving the user options for how the table is to be printed. 
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Graphical Output 

Graphical output can be opened by selecting one of the plot buttons at 
the bottom of the Volume Frequency Analysis editor or by selecting the 
Plot tab under the Analytical or Graphical tabs.  There are three plot 
buttons at the bottom of the Volume Frequency Analysis editor, Plot 
Duration Data, Plot Analytical Curve, and Plot Graphical Curve.  
Pressing the Plot Duration Data button will open a new window 
containing a graph showing the systematic data plotted using the user-
defined plotting position method.  Pressing the Plot Analytical Curve 
button will open a new window containing a graph with both the 
systematic data and the computed analytical frequency curves, as 
shown in Figure 7-13.  Pressing the Plot Graphical Curve button will 
open a new window containing a graph with both the systematic data 
and the user-defined frequency curves.  

Figure 7-13.  Plot of Systematic Data and Analytical Frequency Curves.  

 

All plots opened by selecting one of the plot buttons at the bottom of 
the Volume Frequency Analysis editor contain menu options for 
printing, editing, and saving the plots.   

Plots can be sent to the printer by selecting the Print option located 
on the File menu.  Additional printing options available from the File 
menu are Page Setup, Print Preview, and Print Multiple (used for 
printing multiple graphs on the same page).  The plot can also be sent 
to the Windows Clipboard by selecting Copy to Clipboard from the 
File menu.  Additionally, the plot can be saved to a file by selecting the 
Save As option from the File menu.  When the Save As option is 
selected, a window will appear allowing the user to select a directory, 
enter a filename, and select the format for saving the file.  Currently 
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four file formats are available for saving the plot to disk: windows 
metafile, postscript, JPEG, and portable network graphic.  The data 
contained within the plot can also be tabulated by selecting Tabulate 
from the File menu.  When this option is selected, a separate window 
will appear with the data tabulated.  Additional options are available 
from the File menu for saving the plot properties as a template (Save 
Template) and applying previously saved templates to the current 
plot (Apply Template).   

The Edit menu contains several options for customizing the plot 
properties.  These options include Plot Properties, Configure Plot 
Layout, Default Line Styles, and Default Plot Properties.  Also, the user 
can right-click on a line or data point in the plot area or in the legend 
and a shortcut menu will open with customization options.  Both the Y 
and X-axis properties can be edited by placing the mouse on top of 
axis and clicking the right mouse button.  Then select the Edit 
Properties menu option in the shortcut menu.  For example, the user 
can turn on minor tic marks for the y-axis and modify the minimum 
and maximum scale for the x-axis.  The graphic customizing 
capabilities within HEC-SSP are very powerful, but are also somewhat 
complex to use.  The code used in developing the plots in HEC-SSP is 
the same code that is used for developing plots in HEC-DSSVue and 
several other HEC software programs.  Please refer to the HEC-
DSSVue User’s Manual for details on customizing plots. 

Viewing the Report File 

Computational results for a volume frequency analysis are written to a 
report file.  The report file lists all of the input data and user settings, 
plotting positions of the data points, intermediate results, each of the 
various statistical tests performed (i.e. high and low outliers, historical 
data, etc…), and the final results.  This file is often useful for 
understanding how the software arrived at the final frequency curves.  
Press the View Report button at the bottom of the Volume Frequency 
Analysis editor to open the report, as shown in Figure 7-14. 
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Figure 7-14.  Volume Frequency Analysis Report. 
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Plots, tables and reports can also be created by selecting menu options 
from the Results menu.  At least one volume frequency analysis must 
be selected in the study explorer before selecting one of the menu 
options on the Results menu.  Results from multiple analyses are 
combined in one graph if they are selected in the study explorer when 
the Graph menu option is selected.  The ResultsSummary Report 
menu option will create a summary table of statistics and frequency 
curve ordinates for the selected analyses as shown in Figure 7-15.  

 
Figure 7-15.  Summary Table for a Volume Frequency Analysis. 
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Performing a Duration Analysis 

This chapter discusses in detail how to use the Duration Analysis editor 
in HEC-SSP.  A duration analysis can be performed on flow and stage 
data as well as other data types.  All regular interval data can be used 
in a duration analysis and an option is included to manually define a 
duration curve.   

Contents 
• Starting a New Analysis 

• General Settings and Options 

• Analytical Duration Analysis 

• Manual Analysis 

• Viewing and Printing Results 
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Starting a New Analysis 

A duration analysis can be started in two ways, either by right clicking 
on the Duration Analysis folder in the study explorer and selecting 
New, or by going to the Analysis menu and selecting New and then 
Duration Analysis.  When a new duration analysis is selected, the 
Duration Analysis editor will appear as shown in Figure 8-1. 

 Figure 8-1.  Duration Analysis Editor. 

 

The user is required to enter a Name for the analysis, while a 
Description is optional.  A data set (flow, stage, or other) can be 
selected from the available data sets stored in the current study DSS 
file (see Chapter 4 for importing data into the study).  The list of data 
that can be selected for a duration analysis will only include those data 
that have a regular interval, like 1HOUR and 1DAY (E-part pathname).  
Choose “None” for the Data Set when defining the duration curve 
manually on the Manual Entry tab.  Once a Name is entered and a 
data set is selected, the DSS File Name and Report File will 
automatically be filled out.  The DSS filename is by default the study 
DSS file.  The report file is given the same name as the analysis with 
the extension ".rpt".   
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General Settings and Options 

Once the analysis name and data set are selected, the user can begin 
to perform the analysis.  Contained on the Duration Analysis editor are 
four tabs.  The tabs are labeled General, Options, Results, and 
Manual Entry.  This section of the manual explains the use of the 
General and Options tabs.  

General 

The first tab contains general settings for performing the duration 
analysis (Figure 8-1).  These settings include: 

• Method 

• X-Axis Scale 

• Y-Axis Scale 

• Time Window Modification 

• Duration Period 

Method 

This option allows the user to choose the Rank All Data Values or 
Bin (STATS) method for computing the duration analysis; the rank all 

data values method is the preferred choice.  
This method computes the duration curve by 
sorting the data from largest to smallest, 
ranking the values from 1 to n, and using: 

)]1/([*100 += nMP  where M is the ranked 
position and n is the number of events.  The Bin method uses a similar 
procedure as in the STATS program for computing the duration curve 
(HEC, 1996).  The data is grouped into bins (classes) and the duration 
curve is computed using the number of data in each bin.         

X-Axis Scale 

This option allows the user to choose the scale of the x-axis.  The 
options are Linear and Probability.  This 
option will affect the x-axis scale in the 
duration curve plot and how the 
“interpolated” frequency curve is computed.   
The program will use a probability scale 
when interpolating the final duration curve 

to the user specified exceedance ordinates.                                                          
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Y-Axis Scale 

This option allows the user to choose the scale of the y-axis.  The 
options are Linear and Log.  This option will affect the y-axis scale in 

the duration curve plot, how the program 
computes evenly spaced bins when the Bin 
(Stats) method is selected, and how the 
“interpolated” frequency curve is computed.   
One option for computing bins is to let the 
program define the bins at evenly spaced 

intervals between the minimum and maximum values from the 
selected data set.  When Log is set as the y-axis scale, the program 
will convert the minimum and maximum values to log space before 
computing the evenly spaced bin limits.  Also, the program will use log 
scale when interpolating the final duration curve to the user specified 
exceedance ordinates.                                         

Time Window Modification 

This option allows the user to narrow the time window used for the 
analysis.  The default is to use all of the data contained in the selected 
data set.   The 
user can enter 
either a start date 
and end date or 
both a start and 
end date.  If a 
start and/or end 
date are used, 
they must be dates 
that are contained within the data stored in the selected data set.  The 
date range for the selected data set is shown in the editor just above 
the Start Date field. 

Duration Period 

This option allows the user to compute multiple duration curves for 
different time windows within the year.  If Annual is selected, then 
the program uses all the data when computing the duration curve.  If 
Quarterly is selected, then the program separates the data into 
quarters and computes a separate duration curve for each quarter.  
For example, a duration curve for the 1st quarter includes all data 
measured from Jan 1 – March 31.  The program will compute a 
separate duration curve for each month of the year when the Monthly 
option is selected.  The User-Defined option lets the user define one 
or multiple periods within the year.   Then the program will perform 
the duration analysis using data only measured during the user-
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defined period(s).  

      

Options 

In addition to the general settings, there are also several options 
available to the user for modifying the computations of the duration 
curve.  These options include:  

• Output Labeling 

• Plotting Position Formula 

• User-Specified Exceedance Ordinates 

• Bin Limits 

When the Options tab is selected, the Duration Analysis editor will 
appear as shown in Figure 8-2. 
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Figure 8-2.  Duration Analysis Editor with Options Tab Selected. 

 

Output Labeling 

This option allows the user to change the default labels for data 
contained in the output 
tables and plots.   The 
user can change both the 
name of the data as well 
as the units of the data.  
The output labeling does 
not result in the 
conversion of data from 
one unit system to 
another; it only affects 

what is displayed on table headings and the y-axis of the results plot.  

Plotting Position Formula 

This option allows the user to choose how the duration curve is 
computed (this option is not available when the Bin method is 
selected).  When Rank/(N+1) is selected the program will compute 
the duration curve using: )]1/([*100 += nMP  where M is the ranked 
position and n is the number of events.  When Rank/N is selected the 
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program will compute the duration curve using: ]/[*100 nMP =  
where M is the ranked position and n is the 
number of events. 

 

 

User-Specified Exceedance Ordinates 

This option allows the user to change the ordinates used in computing 
the resulting duration curves.  The default values listed in percent of 

time exceedance are 
99, 95, 90, 80, 50, 
25, 15, 10, 5, 2, 1, 
and 0.1.  Check the 
box next to Change 
or add to default 
values to change or 
add additional 
values.  Once this 
box is checked, the 
user can 
add/remove rows 
and edit the 
ordinates.  To add 
or remove a row 
from the table, 
select the row(s), 
place the mouse 
over the highlighted 
row(s) and click the 

right mouse button.  The shortcut menu contains options to Insert 
Row(s) and Delete Row(s).  The program will use the default 
values, even if they are not contained in the table, when the Change 
or add to default values option is not checked.  Finally, all values in 
the table must be between 0 and 100. 

Bin Limits 

The Bin Limits panel is only active when the Bin (STATS) method is 
selected on the General tab.  This option helps the user to define the 
limits, the minimum and maximum values, for each bin.  There are 
two options; Evenly Spaced and User-Defined.  When Evenly 
Spaced is selected the user must also enter the number of bins.  The 
Extract Bin Limits button will automatically populate the bin limits 
table by first extracting the minimum and maximum values from the 
data set and then linearly interpolating evenly spaced bin limits.  If 
Log is selected as the Y-axis scale on the General tab, then the 
program converts the minimum and maximum values to log space 
before computing the evenly spaced bin limits.  The User-Defined 
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option lets the user manually enter the bin limits.  The user must 
ensure the minimum and maximum values from the data set are 
contained in the bin limits table.  For example, if the minimum flow 
from the data set is 100.0 then the first row in the table must be less 
than or equal to 100.0.  Additional rows can be added to the table.  
Place the mouse pointer on top of the table and click the right mouse 
button.  Then select the Insert Row(s)… menu option to open an 
editor for specifying the number of rows to insert into the table.       

 

Compute 

Once the new analysis has been defined, and the user has all of the 
General and Options information selected the way they want, 

performing the computations is simply a matter of 
pressing the Compute button at the bottom of the 

Duration Analysis editor.  If the computations are successful, the user 
will receive a message that says “Compute Complete”.  At this point, 
the user can begin to review the results. 

Multiple Duration analyses can be computed using the Compute 
Manager.  Select the AnalysisCompute Manager menu option to 
open the Compute Manager.  Select the analyses to be computed and 
then press the Compute button.  Close the compute dialogs and 
Compute Manager when the program finished computing the analyses.  
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Results 

This section of the manual describes results that are available for the 
Duration analysis.  When the user selects the Results tab on the 
Duration Analysis editor, the window will appear as shown in Figure 8-
3.  As shown, two additional tabs will appear on the screen: Tabular 
Results and Plot. 

 
Figure 8-3.  Results Tab of the Duration Analysis Editor. 

 

Tabular Results 

The Tabular Results tab will bring up a table of results for the 
duration analysis.  The tabular results are different for the Rank All 
Data Values and Bin (STATS) methods.  An example of tabular 
results for a Rank All Data Values analysis is shown in Figure 8-3.  
The results table will contain multiple duration curves if the Quarterly, 
Monthly, or the User Defined options are selected as the Duration 
Period.  Data in the duration curve table can be re-sorted.  Click the 
Percent of Time Exceeded column header (two mouse clicks are 
required the first time).  The percent of time exceeded ordinates, 
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along with the duration curve values, will sort so that the lowest 
values are on top or the highest values are on top.    

The tabular results tab will look different when the Bin (STATS) 
method is used to compute the duration analysis.  As shown in Figure 
8-4, there are two tables.  The first table contains summary 
information about the bins and the second table contains the 
interpolated duration curve.  

 
Figure 8-4.  Results Tab for a Bin (STATS) analysis. 

 

Plot 

In addition to tabular results, a Plot tab is available for viewing a 
graphical plot of the duration curves.  When the Plot tab is selected the 
window will change to what is shown in Figure 8-5.  The plot contains 
the computed duration curve and the duration curve interpolated to 
the user-defined ordinates (defined on the Options tab).  Multiple 
duration curves will be graphed if the Quarterly, Monthly, or User 
Defined options are selected as the duration period. 
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Figure 8-5.  Plot Tab of the Duration Analysis. 
 
 

Manual Duration Analysis 

The user has the option to manually define a duration curve.  This 
option would be used when a duration curve has been computed 
outside of HEC-SSP.  The “None” data set must be selected in order to 
define a duration curve manually.  When the Manual Entry tab is 
selected, the editor will display a plot and table as shown in Figure 8-
6.  The table allows the user to enter data values for the percent of 
time exceedance ordinates defined on the Options tab.  When the user 
enters values in this table, those values will be plotted as a line on the 
plot after the Compute button is pressed.   
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Figure 8-6.  Manual Entry Tab of the Duration Analysis Editor. 

 

Viewing and Printing Results 

The user can view output for the duration analysis directly from the 
Duration Analysis editor (Tabular and Graphical output) or by using the 
buttons at the bottom of the editor.  Results can also be opened by 
selecting the duration analysis in the study explorer and then choosing 
the Graph, Table, or Report option available from the Results 
menu.  

Tabular Output 

Once the computations for the duration analysis are completed, the 
user can view tabular output by selecting the Tabular Results tab 
under the Results tab.  The details of this table were discussed above. 

The tabular results can be printed by using the Print button at the 
bottom of the Duration Analysis editor.  When the print button is 
pressed, a window will appear giving the user options for how they 
would like the table to be printed. 
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Graphical Output 

Graphical output of the duration curve can be obtained by selecting 
either the Plot tab under the results tab, or by pressing the button 
labeled Plot Duration Curve at the bottom of the Duration Analysis 
editor.  When the Plot Duration Curve button is pressed, a duration 
curve plot will appear in a separate window as shown in Figure 8-7. 

 
Figure 8-7.  Duration Curve Plot. 

 

The duration curve plot can be sent to the printer by selecting the 
Print option from the File menu at the top of the window.  Additional 
printing options available from the File menu are Page Setup, Print 
Preview, and Print Multiple (used for printing multiple graphs on the 
same page).  The graphic can also be sent to the Windows Clipboard 
by selecting Copy to Clipboard from the File menu.  Additionally, the 
plot can be saved to a file by selecting the Save As option from the 
File menu.   When the Save As option is selected, a window will appear 
allowing the user to select a directory, enter a filename, and select the 
format for saving the file.  Currently four file formats are available for 
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saving the graphic to disk: windows metafile, postscript, JPEG, and 
portable network graphic. 

The data contained within the plot can also be tabulated by selecting 
Tabulate from the File menu.  When this option is selected, a 
separate window will appear with the data tabulated.  Additional 
options are available from the File menu for saving the plot options as 
a template (Save Template) and applying previously saved templates 
to the current plot (Apply Template).   

The Edit menu contains several options for customizing the graphic.  
These options include Plot Properties, Configure Plot Layout, Default 
Line Styles, and Default Plot Properties.  Also, a shortcut menu will 
appear with further customizing options when the user right-clicks on 
a line on the graph or the legend.  Both the Y and X-axis properties 
can be edited by placing the mouse on top of axis and clicking the 
right mouse button.  Then select the Edit Properties menu option in 
the shortcut menu.  For example, the user can turn on minor tic marks 
for the y-axis and modify the minimum and maximum scale for the x-
axis.  The graphic customizing capabilities within HEC-SSP are very 
powerful, but are also somewhat complex to use.  The code used in 
developing the plots in HEC-SSP is the same code that is used for 
developing plots in HEC-DSSVue and several other HEC software 
programs.  Please refer to the HEC-DSSVue User’s Manual for details 
on customizing plots. 

Viewing the Report File 

A report file is created when the duration analysis computations are 
performed.  The report file contains information about the duration 
analysis and the final results.  To view the report file press the View 
Report button at the bottom of the Duration Analysis editor.  When 
this button is pressed, a window will appear containing the report as 
shown in Figure 8-8. 
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Figure 8-8.  Duration Analysis Report File. 
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Performing a Coincident Frequency 
Analysis 

This chapter discusses in detail how to use the Coincident Frequency 
Analysis editor in HEC-SSP.  A coincident frequency analysis can be 
performed on any data type; flow, stage, precipitation, wind, etc.  The 
coincident frequency analysis requires both duration and frequency 
curves.  These can be computed by existing analyses in the HEC-SSP 
study or they can be entered manually in the coincident frequency 
analysis editor.   

The Coincident Frequency Analysis is designed following guidelines in 
EM 1110-2-1415.  This analysis tool can be used to compute the 
exceedance frequency relationship for a variable that is a function of 
two other variables.  An example is illustrated in Figure 9-1.  In this 
example, the stage at the damage site on the tributary, variable C, is a 
function of stream flow from the tributary, variable A, and the stage in 
the mainstem river, variable B.      

 

 
Figure 9-1.  Example Application of the Coincident Frequency Analysis. 

The general procedure for performing a coincident frequency analysis, 
using HEC-SSP is described below.   

1) Develop a duration curve for variable B.  This can be done using 
the Duration Analysis editor or it can be defined manually in the 
Coincident Frequency Analysis editor.  Then discretize the duration 
curve to determine index values for variable B.  The index values 
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should be defined so that the area under the discretized duration 
curve approximates the original duration curve.  Figure 9-2 shows 
a flow duration curve that has been discretized using 9 index 
points.  The index points are taken at the midpoint of each discrete 
segment and there are more index points along the steeper portion 
of the duration curve.  The Coincident Frequency Analysis editor 
can be used to define the index points and to estimate the 
proportion of time for each index point.  For example, the 9th index 
point in Figure 9-2 is taken at the midpoint for the discrete 
segment from 100 to 60 percent of time exceeded.  The flow value 
at this point represents the variable B index occurring 40 percent 
of the time.  The 8th index point is taken at the midpoint for the 
discrete segment from 60 to 40 percent of time exceeded.  The 
flow value at this point represents the variable B index occurring 
20 percent of the time.  The proportion of time  assigned to each 
index point will be used to compute the variable C frequency curve. 

 
Figure 9-2.  Variable B Duration Curve Divided into Discrete Segments. 

 
   

2) Different procedures are required depending on whether variables 
A and B are independent or not independent of one another.  When 
variables A and B are assumed independent of one another, 
develop a frequency curve of variable A.  The frequency curve can 
come from an existing Bulletin 17B or General Frequency analysis 
or it can be defined manually in the Coincident Frequency Analysis 
editor.  If variables A and B are not independent of one another, 
then develop a frequency curve of variable A for each variable B 
index value.  In this case, the variable A frequency curves must be 
defined manually in the Coincident Frequency Analysis editor.  This 
involves extracting annual peak values for variable A that occur for 
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each discrete range identified on the variable B duration curve and 
performing a separate frequency analysis on each set of variable A 
data.  

3) Develop the response of variable C for combinations of variable A 
and variable B.  This could be done using a hydrology or hydraulics 
model.  For the example shown in Figure 9-1, a flow value from the 
variable A frequency curve would be applied to the tributary and 
the index flow (or stage) from the variable B duration curve would 
be applied to the mainstem.  The hydraulics model would be used 
to compute the variable C stage at some reference point on the 
tributary.  This model simulation would be computed for many 
combinations of variable A and variable B.  Figure 9-3 shows 
example output from a hydraulics model.  The model was used to 
generate output from multiple combinations of variable A and B 
values.  In this example, there were 12 variable A values and 9 
index values from variable B.  This resulted in 108 simulation 
results.  The table shown in Figure 9-3 is referred to as the 
Response Curves table in HEC-SSP and these values must be 
entered by the user.     

 

 
Figure 9-3.  Response of Variable C for Combinations of Variable A and 
Variable B. 

     

4) The program computes the variable C frequency curve by first 
using the response curves to compute conditional frequency curves 
of variable C.  This is done by assigning the same frequency from 
the variable A value to the corresponding variable C value.  Then 
for a selected value of variable C, the frequency value from each 
condition frequency curve is multiplied by the corresponding 
proportion of time (probability) from the variable B index value.  
The values are summed to obtain the frequency of the selected 
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value of variable C.  This is done for a number of values of variable 
C until a complete frequency curve is created.  

Contents 
• Starting a New Analysis 

• General Settings  

• Variable A 

• Variable B 

• Response Curves 

• Viewing and Printing Results 

Starting a New Analysis 

A coincident frequency analysis can be started in two ways, either by 
right clicking on the Coincident Frequency Analysis folder in the study 
explorer and selecting New, or by going to the Analysis menu and 
selecting New and then Coincident Frequency Analysis.  When a 
new coincident frequency analysis is selected, the Coincident 
Frequency Analysis editor will appear as shown in Figure 9-4. 

 
Figure 9-4.  Coincident Frequency Analysis Editor. 
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The user is required to enter a Name for the analysis, while a 
Description is optional.  Once a Name is entered, the DSS File Name 
and Report File will automatically be filled out.  The DSS filename is 
by default the study DSS file.  The report file is given the same name 
as the analysis with the extension ".rpt".   

General Settings 

Once the analysis name has been entered, the user can begin to 
perform the computations.  Contained on the Coincident Frequency 
Analysis editor are five tabs.  The tabs are labeled General, Variable 
A, Variable B, Response Curves, and Results.  The first tab 
contains general settings for performing the coincident frequency 
analysis (Figure 9-4).  These settings include: 

• Variable A 

• Variable B 

• Output Labeling 

• Y-Axis Scale 

• User Specified Frequency Ordinates 

Variable A 

This option allows the user to choose whether the coincident frequency 
analysis assumes variables A and B are independent or dependent.  
When variables A and B can be assumed independent, there will be 
only one frequency curve for variable A.  A conditional variable A 
frequency curve assumes variables A and B are not independent, so 
there will be a separate variable A frequency curve for each variable B 
index value.  

 

Variable B 

This option allows the user to define the number of index values for 
variable B.  The index points are used to discretize the duration curve.  
A probability, or a proportion of time, will be assigned to each index 
point.     
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Output Labeling 

This option allows the user to enter labels for data contained in the 
output tables and 
plots.   The user must 
enter the name of the 
data as well as the 
data units.  The 
output labeling does 
not result in the 
conversion of data 

from one unit system to another; it only affects what is displayed on 
table headings and the y-axis of the results plot.  

Y-Axis Scale 

This option allows the user to choose the scale of the y-axis.  The 
options are Linear and Log.  This option will affect the y-axis scale in 

the coincident frequency curve plot. 

 

  

User Specified Frequency Ordinates 

 This option allows the user to 
change the frequency ordinates 
used for creating result tables and 
graphs.  The default values listed 
in percent chance exceedance are 
0.2, 0.5, 1, 2, 5, 10, 20, 50, 80, 
90, 95, and 99.  Check the box 
next to Use Values from Table 
below to change or add 
additional values.  Once this box 
is checked, the user can 
add/remove rows and edit the 
frequency values.  To add or 
remove a row from the table, 
select the row(s), place the 
mouse over the highlighted 
row(s) and click the right mouse 
button.  The shortcut menu 
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contains options to Insert Row(s) and Delete Row(s).  The 
program will use the default values, even if they are not contained in 
the table, when the Use Values from Table below option is not 
checked.  Finally, all values in the table must be between 0 and 100. 

Variable A 

The Variable A tab is used to define the frequency curve for variable 
A.  This tab will look different based on the user’s selection on the 
General Tab.  The Variable A tab will look like Figure 9-5 when “A and 
B can be Assumed Independent” is selected on the General tab.  Since 
variables A and B are independent, there will only be one frequency 
curve for variable A.    

As shown in Figure 9-5, the user can choose to define the curve 
manually or select an existing study analysis.  When the Manual 
Entry option is selected, the user must define the Data Name and 
Data Units.  Then the user must enter the frequency curve for 
variable A.  A frequency curve value must be defined for each percent 
chance exceedance ordinate in the table.  When the Existing Study 
Analysis option is selected, the dropdown list will be active and the 
user can choose any Bulletin 17B or General Frequency analysis in the 
HEC-SSP study.  The variable A frequency curve table will be 
populated with the frequency curve when an analysis is selected.  The 
program uses the statistics from the selected analysis and computes 
the frequency curve that populates the table.   

 
Figure 9-5.  Variable A Tab when Variable A and B are Independent. 
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The Variable A tab will look like Figure 9-6 when “A and B can not be 
Assumed Independent” is selected on the General tab.  A conditional 
variable A frequency curve assumes variables A and B are not 
independent, so there will be a separate variable A frequency curve for 
each variable B index value.  

As shown in Figure 9-6, the user must define the Data Name and 
Data Units.  Then the user must manually enter the variable A 
frequency curve for each index value of variable B.  This involves 
extracting the annual peak values for variable A that occur for each 
discrete range identified on the variable B duration curve and 
performing a separate frequency analysis on each set of variable A 
data.  Also, a frequency curve value must be defined for each Percent 
Chance Exceedance ordinate in the table.   

  

 
Figure 9-6.  Variable A Tab when Variable A and B are not Independent. 

 

Press the Plot button located at the lower left corner of the Variable A 
tab to open a plot of the variable A frequency curve(s).  

Variable B 

The Variable B tab is used to define the duration curve for variable B 
and the index points with an associated probability.  The index points 
will be used by the user when developing the response curves 
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(response of variable C to each combination of variables A and B).  
The associated probability represents the proportion of time that each 
index point can be expected to occur.    

As shown in Figure 9-7, the left side of the variable B tab is used to 
select the duration curve from an existing Duration Curve analysis.  
Once selected, the program populates the duration curve table. Press 
the Plot button located at the lower left corner of the Variable B tab to 
open a plot of the variable B duration curve.   

 
Figure 9-7.  Variable B Tab. 

 

After the duration curve has been selected, the right side of the 
variable B tab is used to define the index points and associated 
probabilities used to discretize the duration curve.  The number of 
index points is defined on the General tab and is included on the 
Variable B tab to let the user know how many index points must be 
defined in the table.  There are 4 methods for defining the index 
values and the associated probabilities.  The user selects one of the 
methods, edits the table, and then clicks the Generate Table button 
in order for the program to finish populating the table.  The following 
text describes each method.       

Define Automatically.  The program will use a predefined pattern of 
probability ranges when this option is selected, as contained in Table 
9-1, to populate the Probability column.  The pattern is dependent on 
the number of index points and the default probability patterns do not 
extend beyond nine index points.  If more than nine index points have 
been selected for the analysis, then use one of the other methods for 
defining the index points and associated probabilities.  The program 
will compute the Index and Break Point columns when the 
Generate Table button is pressed.  The Break Point column is 
computed using the probability pattern.  The first row in this column is 
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always 100.  The second break point is computed by subtracting the 
first probability value from the first break point value.  The third break 
point is computed by subtracting the second probability value from the 
second break point value.  This procedure is followed until the last 
break point is computed; it should always have a value of 0.  The 
Index values are taken from the duration curve at the midpoint 
between each break point range.  For example, if the first break point 
was 100 and the second was 60 then the first Index value would be 
the value from the duration curve at 80 percent time exceeded.  

 
Table 9-1.  Default Probability Patterns.  

 Number of Index Points 

Index 3 4 5 6 7 8 9 

1 20 15 45 35 35 35 40 
2 60 35 40 30 25 20 20 
3 10 35 10 20 20 15 15 
4  15 4 10 10 10 10 
5   1 4 6 10 5 
6    1 3 6 4 
7     1 3 3 
8      1 3 
9       1 

    

Define from Index Points.  The number of rows is set by the 
number of index points.  In this case, the Index column is edited by 
the user; the user must enter an index value in each row.  When the 
Generate Table button is pressed, the program will compute the 
Break Point and the Probability values.  First, the program will use 
the selected duration curve and interpolate a percent of time exceeded 
for each user-defined index value.  Then break points are computed so 
that they are half way between the percent of time exceeded values 
(the first and last break points will be 100 and 0).  The probability 
values are computed based on the break points.  For example, the first 
probability value is computed by subtracting the second break point 
value from the first.  The second probability value is computed by 
subtracting the third break point value from the second.  This 
procedure is followed until the last probability value is computed.    

Define from Probabilities.  The number of rows is set by the number 
of index points.  In this case, the Probability column is edited by the 
user; the user must enter a probability value in each row (the 
probability values should add up to 100).  When the Generate Table 
button is pressed, the Break Point column is computed using the 
user-entered probability pattern.  For example, the first row in the 
break point column is 100; therefore, the second break point is 
computed by subtracting the first probability value from the first break 
point value.  The third break point is computed by subtracting the 
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second probability value from the second break point value.  This 
procedure is followed until the last break point is computed; it should 
always have a value of 0.  The Index values are taken from the 
duration curve at the midpoint between each break point range.  For 
example, if the first break point was 100 and the second was 60 then 
the first Index value would be the value from the duration curve at 80 
percent time exceeded.  

User-Specified Index Points and Probability Ranges.  This option 
can only be selected when the user does not select an existing 
Duration Curve to import.  This would be applicable for the case where 
the user developed the duration curve outside of HEC-SSP and 
developed the index points and associated probabilities.  As shown in 
Figure 9-8, the user must specify both the Probability and Index 
values; the user must enter values in each row.  When the Generate 
Table button is pressed, the Break Point column is computed using 
the user-entered probability pattern.  For example, the first row in the 
break point column is 100; therefore, the second break point is 
computed by subtracting the first probability value from the first break 
point value.  The third break point is computed by subtracting the 
second probability value from the second break point value.  This 
procedure is followed until the last break point is computed; it should 
always have a value of 0.      

 
Figure 9-8.  User-Specified Option to Define Index Points and Probability 
Ranges. 

 

Response Curves 

The Response Curves tab is used to define the response of variable C 
to each combination of variable A and variable B.  This analysis is 
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performed outside of HEC-SSP.  For example, a hydraulics model could 
be used to apply flow values from the variable A frequency curve to 
the tributary and the index flow (or stage) from the variable B duration 
curve would be applied to the mainstem.  The hydraulics model would 
be used to compute the variable C stage at some reference point on 
the tributary for multiple combinations of variable A and variable B.  
The peak variable C stage is the value to input into the Response 
Curves table.    

As shown in Figure 9-9, there are two options for the Response Curves 
table; Same Variable A for each index or Different Variable A for 
each index.  When the Same Variable A for each index option is 
selected, there is only one Variable A column in the response curves 
table.  The user can manually fill in the values for Variable A or press 
the Import Variable A button.  When the button is pressed, the 
program will import the values on the Variable A tab.  The user can 
edit the Variable A values after they are imported.  When the 
Different Variable A for each index option is selected, there is a 
separate Variable A column for each variable B index value, as shown 
in Figure 9-10.  The user can manually fill in the values for Variable A 
or press the Import Variable A button.  When the button is pressed, 
the program will import the values from the Variable A tab.  The user 
can edit the Variable A values after they are imported.  In most cases, 
the Different Variable A for each index options will be used when 
performing a conditional analysis (variables A and B can not be 
assumed independent).  In this case, a separated variable A frequency 
curve was defined for each variable B index value; therefore, when the 
Import Variable A button is pressed the program will import the 
corresponding frequency curve into the response curves table.        

The user must compute the variable C value given the combinations of 
variables A and B.  Figure 9-9 contains 12 values of variable A and 9 
index values for variable B.  Therefore, the user would have 108 
combinations of variables A and B to compute values of variable C.  
Once computed, the user would manually enter the variable C values 
into the response curves table.  For example, the first value in the first 
variable C column in Figure 9-9 is 481.38.  This was computed using a 
variable A value of 66039 and a variable B value of 3005.92.   

The Plot Response Surface button will open a plot similar to the one 
shown in Figure 9-11.  Each line in the response surface plot shows 
the variable C versus variable A relationship for a given variable B 
index value.  
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Figure 9-9.  Response Curves Tab for Same Variable A for Each Variable B 
Index. 

 

 
Figure 9-10.  Response Curves Tab for Different Variable A for Each Variable B 
Index. 
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Figure 9-11.  Plot of Response Curves. 

 

Compute 

Once the new analysis has been defined, and the user has all of the 
information defined on the General, Variable A, Variable B, Response 

Curves tabs, performing the computations is simply a 
matter of pressing the Compute button at the bottom 

of the Coincident Frequency Analysis editor.  If the computations are 
successful, the user will receive a message that says “Compute 
Complete”.  At this point, the user can begin to review the results. 

The following describes how the variable C coincident frequency curve 
is computed.  

1) The program uses the variable A frequency curve(s) and the 
variable A values in the response curves table to assign a 
frequency of exceedance to each variable C value in the response 
curves table.   

2) The program finds the minimum and maximum values of variable C 
in the response curves table. 

3) The program defines 20 evenly spaced values of variable C in-
between the minimum and maximum values (20 values include the 
minimum and maximum values).  
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4) For each variable C from step 3, the program will look-up the 
exceedance frequency value from each response curve in step 1 
and multiply by the corresponding proportion of time (using the 
probability defined on the Variable B tab) obtained from the 
variable B index value.  These “weighted” values from each 
response curve are summed to compute the variable C frequency 
curve.  

5) The curve is interpolated to the selected exceedance ordinates 
defined on the General tab.  

Multiple coincident frequency analyses can be computed using the 
Compute Manager.  Select the AnalysisCompute Manager menu 
option to open the Compute Manager.  Select the analyses to be 
computed and then press the Compute button.  Close the compute 
dialogs and Compute Manager when the program finishes computing 
the analyses.  

Results 

This section of the manual describes results that are available for the 
Coincident Frequency analysis.  When the user selects the Results tab 
on the Coincident Frequency Analysis editor, the window will appear as 
shown in Figure 9-12.  Both tabular and graphical results are included.  
The percent chance exceedance ordinates are the same as those 
defined on the General tab.  In addition, the Data Name and Data 
Units defined on the General tab are used in the column header in the 
results table and the y-axis label in the plot.  Data in the frequency 
curve table can be re-sorted.  Click the Percent Chance Exceedance 
column header (two mouse clicks are required the first time).  The 
percent chance exceedance ordinates, along with frequency values, 
will sort so that the lowest values are on top or the highest values are 
on top.      
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Figure 9-12.  Results Tab of the Coincident Frequency Analysis Editor. 

 

Viewing and Printing Results 

The user can view output for the coincident frequency analysis directly 
from the Coincident Frequency Analysis editor (tabular and graphical 
output) or by using the buttons at the bottom of the editor.   

Tabular Output 

Once the computations for the coincident frequency analysis are 
completed, the user can view tabular output by selecting the Results 
tab.  The tabular results can be printed by using the Print button at 
the bottom of the coincident frequency analysis editor.  When the print 
button is pressed, a window will appear giving the user options for how 
they would like the table to be printed.  Result tables can also be 
created from the Results menu.  At least one coincident frequency 
analysis must be selected in the study explorer before selecting the 
ResultsTable option.   

Graphical Output 

Graphical output of the coincident frequency analysis can be obtained 
by selecting either the Results tab, or by pressing the Plot button at 
the bottom of the coincident frequency analysis editor.  When the Plot 
button is pressed, a frequency curve plot will appear in a separate 
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window as shown in Figure 9-13.  Result graphs can also be created 
from the Results menu.  At least one coincident frequency analysis 
must be selected in the study explorer before selecting the 
ResultsGraph option.  Results will be graphed in the same plot if 
multiple coincident frequency analyses are selected in the study 
explorer when opening a graph from the Results menu. 

The coincident frequency curve plot can be sent to the printer by 
selecting the Print option from the File menu at the top of the 
window.  Additional printing options available from the File menu are 
Page Setup, Print Preview, and Print Multiple (used for printing 
multiple graphs on the same page).  The graphic can also be sent to 
the Windows Clipboard by selecting Copy to Clipboard from the File 
menu.  Additionally, the plot can be saved to a file by selecting the 
Save As option from the File menu.   When the Save As option is 
selected, a window will appear allowing the user to select a directory, 
enter a filename, and select the format for saving the file.  Currently 
four file formats are available for saving the graphic to disk: windows 
metafile, postscript, JPEG, and portable network graphic. 

 
Figure 9-13.  Coincident Frequency Analysis Plot. 

 

The data contained within the plot can also be tabulated by selecting 
Tabulate from the File menu.  When this option is selected, a 
separate window will appear with the data tabulated.  Additional 
options are available from the File menu for saving the plot options as 
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a template (Save Template) and applying previously saved templates 
to the current plot (Apply Template).   

The Edit menu contains several options for customizing the graphic.  
These options include Plot Properties, Configure Plot Layout, Default 
Line Styles, and Default Plot Properties.  Also, a shortcut menu will 
appear with further customizing options when the user right-clicks on 
a line on the graph or the legend.  Both the Y and X-axis properties 
can be edited by placing the mouse on top of axis and clicking the 
right mouse button.  Then select the Edit Properties menu option in 
the shortcut menu.  For example, the user can turn on minor tic marks 
for the y-axis and modify the minimum and maximum scale for the x-
axis.  The graphic customizing capabilities within HEC-SSP are very 
powerful, but are also somewhat complex to use.  The code used in 
developing the plots in HEC-SSP is the same code that is used for 
developing plots in HEC-DSSVue and several other HEC software 
programs.  Please refer to the HEC-DSSVue User’s Manual for details 
on customizing plots. 

Viewing the Report File 

A report file is created when the coincident frequency analysis 
computations are performed.  The report file lists the input data, user 
settings, and the final results.  This file is often useful for 
understanding how the software arrived at the final frequency curve.   

To view the report file press the View Report button at the bottom of 
the Coincident Frequency Analysis editor.  When this button is pressed, 
a window will appear containing the report as shown in Figure 9-14. 
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Figure 9-14.  Coincident Frequency Analysis Report File. 
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C H A P T E R   1 0   

Performing a Curve Combination 
Analysis 

The Curve Combination analysis provides a tool for combining 
frequency curves (and confidence limits) from multiple sources.  One 
example is shown in Figure 10-1.  This example includes observed 
historic measurements of annual maximum stage, results from a 
hydrology model, and an estimate of the maximum stage from the 
probable maximum flood.  The curve combination tool can be used to 
develop one frequency curve that combines all these sources of 
information.   

 
Figure 10-1.  Example of Data used in a Curve Combination Analysis. 
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Contents 
• Starting a New Analysis 

• General Settings  

• Frequency Curves 

• Confidence Limits 

• Viewing and Printing Results 

Starting a New Analysis 

A curve combination analysis can be started in two ways, either by 
right clicking on the Curve Combination Analysis folder in the study 
explorer and selecting New, or by going to the Analysis menu and 
selecting New and then Curve Combination Analysis.  When a new 
curve combination analysis is selected, the Curve Combination 
Analysis editor will appear as shown in 10-2. 

 
Figure 10-2.  Curve Combination Analysis Editor. 

 

The user is required to enter a Name for the analysis, while a 
Description is optional.  Once a Name is entered, the DSS File Name 
and Report File will automatically be filled out.  The DSS filename is 
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by default the study DSS file.  The report file is given the same name 
as the analysis with the extension ".rpt".   

General Settings 

Once the analysis name has been entered, the user can begin to 
perform the analysis.  Contained on the Curve Combination Analysis 
editor are four tabs.  The tabs are labeled General, Frequency 
Curves, Confidence Limits, and Results.  The first tab contains 
general settings for performing the curve combination analysis (Figure 
10-2).  These settings include: 

• Number of Curves 

• Output Labeling 

• Data Type 

• Y-Axis Scale 

• Confidence Limits Method 

• Frequency of PMF 

• Confidence Limits 

• User Specified Frequency Ordinates 

Number of Curves 

This option lets the user choose the number of frequency curves to 
combine.  Both the Frequency Curves and Confidence Limits tabs will 
update based on the number of curves.   

 

Output Labeling 

This option allows the user to enter labels for data contained in the 
output tables and 
plots.   The user must 
enter the name of the 
data as well as the 
data units.  The 
output labeling does 
not result in the 
conversion of data 

from one unit system to another; it only affects what is displayed on 
table headings and the y-axis of the results plot.  
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Data Type 

The user is required to select the data type for the combined 
frequency curve; the options are Flow and Stage.  This is required for 

the Order Statistics method to compute the 
confidence limits, different equations are used 
depending on the data type.  Developing 
confidence limits for graphical frequency curves 
and the order statistics method is discussed in ETL 
1110-2-537.  If the data is not flow or stage, 

select the Flow data type when the graphical frequency curve is 
approximately analytic for extreme probabilities (frequency curve is 
not relatively flat for extreme probabilities).  Select the Stage data 
type when the graphical frequency curve is relatively flat for extreme 
probabilities (ETL 1110-2-537).       

Y-Axis Scale 

This option allows the user to choose the scale of the Y-axis in the 
curve combination plot.  The options are Linear 
and Log.                                                                                                     

  

Confidence Limits Method 

This option lets the user choose the method for computing the 
confidence limits around the combined frequency curve.  The options 
include None, User Defined Confidence Limits, User Defined 
Weights, and Order Statistics.   

 

None.  When the None option is selected, the Confidence Limits tab 
will become disabled and the program will only compute the combined 
frequency curve.   

User Defined Confidence Limits.  When the User Defined 
Confidence Limits option is select, the Confidence Limits tab will 
become disabled and the Upper and Lower Confidence Limits columns 
in the table on the Results tab will become enabled.  The user can 
manually enter the confidence limits into this table and the program 
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will plot the curves along with the combined frequency curve when the 
compute button is pressed.  The user must specify an upper and lower 
confidence limit value for each ordinate in the table on the Results tab 
before pressing the compute button.  

User Defined Weights.  When the User Defined Weights option is 
selected, the Confidents Limits panel on the General tab becomes 
active as well as the Confidence Limits tab.  The Confidence Limits tab 
provides tables for defining the upper and lower confidence limits for 
each frequency curve in the analysis.  The user can select the 
confidence limits from an existing analysis, define the limits manually, 
or have HEC-SSP compute them using the order statistics method. 
After the confidence limits have been defined, the user must provide a 
weight for each pair of confidence limits.  The program uses the weight 
for computing the combined confidence limits.  

Order Statistics.  When the Order Statistics option is selected, the 
Confidents Limits panel on the General tab becomes active as well as 
the Confidence Limits tab.  The Confidence Limits tab is used to 
compute the confidence limits using the order statistics method.  The 
order statistics method is described in ETL 1110-2-537. 

Frequency of PMF 

This option provides a tool for estimating the frequency of the Probable 
Maximum Flood (PMF) using regional precipitation.  The method scales 
the probability of the PMF by comparing the Probable Maximum 
Precipitation (PMP) to the largest observed regional historical 
precipitation and using an established institutional range of 
probabilities for the PMF.  By utilizing regional precipitation data, this 
procedure inherently includes the effects of regional weather patterns, 
distance from moisture sources, orographic effects, etc.  In areas 
where the largest observed regional historical precipitation has 
approached the PMP, the method would yield a probability towards the 
more frequent end of the established institutional range.  Likewise, in 
areas where the largest observed regional historical precipitation is 
much lower than the PMP, the probability of the PMF would tend 
towards the less frequent end of the established institutional range. 

This option is not necessary in order to use the Curve Combination 
analysis to combine frequency curves.  It was added to assist users 
when developing frequency curves that included estimates of the PMF.  
The user must check the box, Estimate Frequency of PMF using 
Regional Precipitation, to use this tool to estimate the probability of 
the PMF.  Before the Compute Frequency of PMF button can be 
pressed, the user must enter the PMP depth, the maximum regional 
historic precipitation, and probabilities for the low and high ends of the 
established range of the PMF.  The frequency of the PMF, estimated 
with this tool, should be multiplied by 100 before entering it into the 
User Specified Frequency Ordinates table.   
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The following equation is used to calculate the probability of the PMF: 

].)1[(10 ValueMinRangeRatioAEP +×−−=  

where Ratio is the largest observed regional historical precipitation 
divided by the PMP, Range is the established institutional range for the 
probability of the PMF (for the US Army Corps of Engineers this is 10-3 
to 10-7), and MinValue is the minimum value of the established 
institutional range.  When solving the equation, Range and MinValue 
are the exponents from the established institutional range.  If the 
institutional range was   10-3 to 10-7, then Range would be 4 and the 
MinValue would be 3.  

Confidence Limits 

Confidence limits provide a measure of the uncertainty in the 
computed value for a given exceedance probability.  The computation 
of confidence limits is an option 
defined in the Confidence Limits 
Method panel.  The Confidence 
Limits panel is only active when 
the User Defined Weights or the 
Order Statistics method is 
selected.  By default, HEC-SSP 
calculates the 90 percent 
confidence interval (i.e. the 5% 
and 95% confidence limits).  The 
confidence limits must be entered 
in decimal form (i.e. 95% = 0.95, and 5% = 0.05).  The user has the 
option to override the default values. 
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User Specified Frequency Ordinates 

 This option allows the user to 
change the frequency ordinates 
used for creating result tables and 
graphs.  The default values listed 
in percent chance exceedance are 
0.00001, 0.2, 0.5, 1, 2, 5, 10, 20, 
50, 80, 90, 95, and 99.  Check 
the box next to Use Values from 
Table below to change or add 
additional values.  Once this box 
is checked, the user can 
add/remove rows and edit the 
frequency values.  To add or 
remove a row from the table, 
select the row(s), place the 
mouse over the highlighted 
row(s) and click the right mouse 
button.  The shortcut menu 

contains options to Insert Row(s) and Delete Row(s).  The 
program will use the default values, even if they are not contained in 
the table, when the Use Values from Table below option is not 
checked.  Finally, all values in the table must be between 0 and 100. 

Frequency Curves 

The Frequency Curves tab is used to define the frequency curves and 
the user-defined weights used by the program to combine the curves 
into one frequency curve.  As shown in Figure 10-3, the Frequency 
Curves tab contains a panel for each frequency curve; the number of 
frequency curves is defined on the General tab.  The frequency curve 
ordinates in the Frequency in Percent column are defined on the 
General tab.  The user has the option to enter the frequency curve 
manually or to pick an existing Bulletin 17B or General Frequency 
analysis.  If an Existing Study Analysis is selected, the program 
uses the statistics from the selected analysis and computes the 
frequency curve that populates the table.  The frequency curve will 
only be computed for those frequency ordinates included within the 
selected analysis.  The program will not extrapolate frequency curve 
values.  For example, if the selected Bulletin 17B analysis computed a 
frequency curve from 99 to 0.2 percent chance exceedance then 
values less than 0.2 percent chance exceedance will not be populated 
in the curve combination analysis.  The user can always add additional 
frequency ordinates to a Bulletin 17B or General Frequency analysis if 
needed.  If Manual Entry is selected, then the user can enter 
frequency curve values for a few or all the frequency curve ordinates.  
The user must also enter the weights used to combine the frequency 
curves.  Finally, the equivalent years of record must be defined when 
using the order statistics method to compute the confidence limits.  
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The program will import the years of record from the selected analysis 
when the Existing Study Analysis option is selected.  The user must 
manually enter the equivalent years of record when the Manual Entry 
option is selected.   

As shown in Figure 10-3, the frequency curves do not have to have a 
value for each ordinate; however, each frequency curve ordinate must 
have at least one frequency curve value.  In addition, a user-defined 
weight does not have to be entered for each frequency curve value; 
however, the weights for a frequency curve ordinate must sum to 1.     

The Plot Curves button will open a graph showing all frequency curves 
defined on the frequency curves tab, as show in Figure 10-4.   

 
Figure 10-3.  Curve Combination Analysis Frequency Curves Tab. 
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Figure 10-4.  Plot of Frequency Curves Defined on the Frequency Curves Tab. 

 

Confidence Limits 

The Confidence Limits tab is used to define the confidence limits and 
the user-defined weights used by the program to combine the 
confidence limits into one pair of upper and lower confidence limits.  
The confidence limits tab will change based on the Confidence Limits 
Method selected on the General Tab.   

The Confidence Limits tab will look similar to Figure 10-5 when the 
User Defined Weights option is selected on the General tab.  The 
Confidence Limits tab contains a panel for each frequency curve; the 
number of frequency curves is defined on the General tab.  The 
frequency curve ordinates in the Frequency in Percent column are 
defined on the General tab.  The user has the option to enter the 
confidence limits manually, compute the confidence limits using the 
order statistics method, or pick an existing Bulletin 17B or General 
Frequency analysis.  If Manual Entry is selected, then the user can 
enter confidence limits values for a few or all the frequency curve 
ordinates.  If Compute using Order Statistics Method is selected, 
then the Compute Confidence Limits button will become active.  When 
this button is pressed, the program will compute the upper and lower 
confidence limits using the order statistics method (and the equivalent 
years of record defined on the Frequency Curves tab) and 
automatically populate the table.  If Existing Study Analysis is 
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selected, the program uses the statistics from the selected analysis 
and computes the confidence limits that populate the table.  The 
confidence limits will only be computed for those frequency ordinates 
included within the selected analysis.  The program will not extrapolate 
confidence limits values.  For example, if the selected Bulletin 17B 
analysis computed a frequency curve from 99 to 0.2 percent chance 
exceedance then values less than 0.2 percent chance exceedance will 
not be populated in the curve combination analysis.  The user can 
always add additional frequency ordinates to a Bulletin 17B or General 
Frequency analysis if needed.  The user must enter the weights used 
to combine the confidence limits.  The Import Weights from 
Frequency Curves Tab button will import the same weights as 
defined on the Frequency Curves tab.    

As shown in Figure 10-5, the confidence limits do not have to have a 
value for each ordinate; however, each frequency curve ordinate must 
have at least one upper and lower confidence limits value.  In addition, 
a user-defined weight does not have to be entered for each upper and 
lower confidence limits pair; however, the weights for a frequency 
curve ordinate must sum to 1.     

The Confidence Limits tab will look similar to Figure 10-6 when the 
Order Statistics option is selected on the General tab.  The user must 
enter an equivalent years of record for each frequency ordinate.  The 
program will compute the combined frequency curve and then the 
confidence limits using the order statistics method when the Compute 
Confidence Limits button is pressed.  As shown in Figure 10-6, the 
upper and lower confidence limits will be populated in the table and a 
plot is created showing the combined frequency curve along with the 
computed confidence limits.     
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Figure 10-5.  Curve Combination Analysis Confidence Limits Tab – User 
Defined Weights Method. 

 

 
Figure 10-6.  Curve Combination Analysis Confidence Limits Tab - Order 
Statistics Method. 
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Compute 

Once the new analysis has been defined, and the user has all of the 
information defined on the General, Frequency Curves, and Confidence 

Limits tabs, performing the computation is simply a 
matter of pressing the Compute button at the bottom 

of the Curve Combination Analysis editor.  If the computations are 
successful, the user will receive a message that says “Compute 
Complete”.  At this point, the user can begin to review the results. 

Multiple curve combination analyses can be computed using the 
Compute Manager.  Select the AnalysisCompute Manager menu 
option to open the Compute Manager.  Select the analyses to be 
computed and then press the Compute button.  Close the compute 
dialogs and Compute Manager when the program finished computing 
the analyses.  

Results 

This section describes results that are available for the Curve 
Combination analysis.  When the user selects the Results tab on the 
Curve Combination Analysis editor, the window will appear as shown in 
Figure 10-7.  Both tabular and graphical results are included.  The 
percent chance exceedance ordinates are the same as those defined 
on the General tab.  In addition, the Data Name and Data Units 
defined on the General tab are used in the y-axis label in the plot.  The 
user must enter the upper and lower confidence limits when the User 
Defined Confidence Limits option is selected on the General tab; 
otherwise, the program computes the confidence limits when the 
compute button is pressed.  Data in the frequency curve table can be 
re-sorted.  Click the Percent Chance Exceedance column header 
(two mouse clicks are required the first time).  The percent chance 
exceedance ordinates, along with frequency curve and confidence 
limits values, will sort so that the lowest values are on top or the 
highest values are on top.   
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Figure 10-7.  Results Tab of the Curve Combination Analysis Editor. 

Viewing and Printing Results 

The user can view output for the curve combination analysis directly 
from the Curve Combination Analysis editor (tabular and graphical 
output) or by using the buttons at the bottom of the editor.   

Tabular Output 

Once the computations for the curve combination analysis are 
completed, the user can view tabular output by selecting the Results 
tab.  The tabular results can be printed by using the Print button at 
the bottom of the curve combination analysis editor.  When the print 
button is pressed, a window will appear giving the user options for how 
they would like the table to be printed.  Result tables can also be 
opened from the Results menu.  At least one curve combination 
analysis must be selected in the study explorer before selecting the 
ResultsTable option.   

Graphical Output 

Graphical output of the curve combination analysis can be obtained by 
selecting either the Results tab, or by pressing the Plot button at the 
bottom of the curve combination analysis editor.  When the Plot button 
is pressed, a frequency curve plot will appear in a separate window as 
shown in Figure 10-8.  Result graphs can also be created from the 
Results menu.  At least one curve combination analysis must be 
selected in the study explorer before selecting the ResultsGraph 
option.  Results will be graphed in the same plot if multiple curve 
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combination analyses are selected in the study explorer when opening 
a graph from the Results menu. 

The curve combination frequency curve plot can be sent to the printer 
by selecting the Print option from the File menu at the top of the 
window.  Additional printing options available from the File menu are 
Page Setup, Print Preview, and Print Multiple (used for printing 
multiple graphs on the same page).  The graphic can also be sent to 
the Windows Clipboard by selecting Copy to Clipboard from the File 
menu.  Additionally, the plot can be saved to a file by selecting the 
Save As option from the File menu.   When the Save As option is 
selected, a window will appear allowing the user to select a directory, 
enter a filename, and select the format for saving the file.  Currently 
four file formats are available for saving the graphic to disk: windows 
metafile, postscript, JPEG, and portable network graphic. 

 

 
Figure 10-8.  Curve Combination Analysis Plot. 

 

The data contained within the plot can also be tabulated by selecting 
Tabulate from the File menu.  When this option is selected, a 
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separate window will appear with the data tabulated.  Additional 
options are available from the File menu for saving the plot options as 
a template (Save Template) and applying previously saved templates 
to the current plot (Apply Template).   

The Edit menu contains several options for customizing the graphic.  
These options include Plot Properties, Configure Plot Layout, Default 
Line Styles, and Default Plot Properties.  Also, a shortcut menu will 
appear with further customizing options when the user right-clicks on 
a line on the graph or the legend.  Both the Y and X-axis properties 
can be edited by placing the mouse on top of axis and clicking the 
right mouse button.  Then select the Edit Properties menu option in 
the shortcut menu.  For example, the user can turn on minor tic marks 
for the y-axis and modify the minimum and maximum scale for the x-
axis.  The graphic customizing capabilities within HEC-SSP are very 
powerful, but are also somewhat complex to use.  The code used in 
developing the plots in HEC-SSP is the same code that is used for 
developing plots in HEC-DSSVue and several other HEC software 
programs.  Please refer to the HEC-DSSVue User’s Manual for details 
on customizing plots. 

Viewing the Report File 

A report file is created when the curve combination analysis 
computations are performed.  The report file lists the input data, user 
settings, and the final results.  This file is often useful for 
understanding how the software arrived at the final frequency curve.   

To view the report file press the View Report button at the bottom of 
the Curve Combination Analysis editor.  When this button is pressed, a 
window will appear containing the report as shown in Figure 10-9. 
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Figure 10-9.  Curve Combination Analysis Report File. 
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A P P E N D I X  B   

Example Data Sets 

The input and output for eleven example data sets are provided to 
illustrate the use of selected options and to assist in verifying the 
correct execution of the program.     

The first six example data sets are the same examples that were found 
in the HEC-FFA program documentation.  The first six examples were 
duplicated with a Bulletin 17B and General Frequency analysis.  This 
manual only shows these examples using the Bulletin 17B analysis; 
however, the example data sets show that results are the same 
whether a Bulletin 17B or General Frequency analysis was performed. 
As shown in the example data sets, the HEC-SSP software produces 
the same results as HEC-FFA for these six data sets.  All of these test 
examples are provided with the software as a single HEC-SSP study 
labeled "SSP Examples".  You can install this study on your computer 
by selecting the HelpInstall Example Data menu option.  After 
opening this study for the first time on your computer, you must 
compute each example before viewing tabular and graphical results.     

A brief description of each test example is provided.  In most cases the 
weighted skew option was selected, and a regional skew value was 
entered from the generalized skew map of the United States provided 
within Bulletin 17B (Plate 1).   

The example problems shown in this section are entitled: 

1. Fitting the Log-Pearson Type III Distribution. 

2. Analysis with High Outliers. 

3. Testing and Adjusting for a Low Outlier. 

4. Zero Flood Years. 

5. Confidence Limits and Low Threshold Discharge. 

6. Use of Historic Data and Median Plotting Positions. 

7. Analyzing Stage Data. 

8. Using User-Adjusted Statistics. 

9. General Frequency - Graphical Analysis. 
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10. Volume Frequency Analysis, Maximum Flows.  

11. Volume Frequency Analysis, Minimum Flows.  

12. Duration Analysis, Bin (STATS) Method.  

13. Duration Analysis, Rank All Data Method. 

14. Duration Analysis, Manual Entry.  

15. Coincident Frequency Analysis, A and B can be Assumed 
Independent.  

16. Coincident Frequency Analysis, A and B can not be Assumed 
Independent.  

17. Curve Combination Analysis, Combine Flow Frequency Curves.  

18. Curve Combination Analysis, Combine Stage Frequency 
Curves.  

When the "SSP Examples" study file is open, the screen will appear as 
shown in Figure B-1.  There are six Bulletin 17B analyses, nine General 
Frequency analyses, two Volume Frequency analyses, three Duration 
analyses, two Coincidence Frequency analyses, and two Curve 
Combination analyses in this study.  The following sections document 
each of the example data sets. 
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Figure B-1.  SSP Examples Study. 
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Example 1: Fitting the Log-Pearson Type III 
Distribution 

The input data for the HEC-SSP Example 1 is the same as that for 
Example 1 in Appendix 12, Guidelines for Determining Flood Flow 
Frequency, Water Resources Council Bulletin 17B.  Example 1 
illustrates the routine computation of a frequency curve by the Bulletin 
17B methodology.   

The data for this example is from Fishkill Creek in Beacon, New York.  
The period of record used for this example is from 1945 to 1968.  To 
view the data from HEC-SSP, right-click on the data record labeled 
“Fishkill Creek-Beacon, NY” in the study explorer and then select 
Tabulate.  The data will appear as shown in Figure B-2. 

 
Figure B-2.  Tabulation of the Peak Flow Data for Fishkill Creek. 
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To plot the data for this example, right-click on the data record again 
and then select Plot.  A plot of the data will appear as shown in Figure 
B-3. 

Figure B-3.  Plot of the Fishkill Creek Data. 

 

A Bulletin 17B and a General Frequency analysis have been developed 
for this example.  To open the Bulletin 17B analysis editor for test 
example 1, either double-click on the analysis labeled FFA Test 1 
from the Study Explorer, or from the Analysis menu select open, then 
select FFA Test 1 from the list of available analyses.  When FFA Test 1 
is selected, the Bulletin 17B analysis editor will appear as shown in 
Figure B-4. 
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Figure B-4.  Bulletin 17B Analysis Editor with Test Example 1 Data Set. 

 

Shown in Figure B-4 are the general settings that were used to 
perform this frequency analysis.  As shown, the Skew option was set 
to use the Weighted Skew.  To use the weighted skew option, the 
user must enter a value for the Regional Skew and the Regional Skew 
Mean Square Error (MSE).  This selection requires the user to either 
look up a value from the generalized skew map of the United States, 
which is provided with Bulletin 17B, or develop a value from a regional 
analysis of nearby gages.  In this example a value of 0.6 was taken 
from the generalized skew map of the U.S. from Bulletin 17B.  Bulletin 
17B suggests using a Regional Skew MSE of 0.302 whenever regional 
skew values are taken from the map. 

Also for this example, the Expected Probability Curve option was 
selected to be computed in addition to the Log Pearson III computed 
curve.  The Weibull plotting position method was selected, as well as 
the default Confidence Limits of 0.05 (5 percent chance exceedance) 
and 0.95 (95% chance exceedance).  Shown in Figure B-5 is the 
Bulletin 17B editor with the Options Tab selected. 
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Figure B-5.  Bulletin 17B Editor with Options Tab Selected for Test Example 1. 

 

As shown in Figure B-5, none of the available options for modifying the 
frequency analysis were selected for this example.  These options 
include changing the Low Outlier Threshold and using Historic 
Data.  Additionally, the option to override the default Frequency 
Ordinates was not selected. 

Once all of the General and Optional settings are set or selected, the 
user can press the Compute button to perform the analysis.  Once the 
computations have been completed, a message window will open 
stating Compute Complete.  Close this window and then select the 
Tabular Results tab.  The analysis window should look like Figure B-
6. 
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Figure B-6.  Bulletin 17B Analysis Window with Results Tab Shown for Test 
Example 1. 

 

As shown in Figure B-6, the Frequency Curve table contains the 
following results: 

 Percent Chance Exceedance 

 Computed Curve (Log-Pearson III results) 

 Expected Probability Curve 

 Confidence Limits (5% and 95% chance exceedance curves) 

On the bottom, left side of the results tab is a table of System 
Statistics for the observed station data (mean, standard deviation, 
station skew) and regional adjustment (regional skew, weighted skew, 
and adopted skew).  Also on the bottom, right side of the results tab is 
a Number of Events table showing the number of historic events used 
in the analysis, number of high outliers found, number of low outliers, 
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number of zero or missing data years, number of systematic events in 
the gage record, and the historic record length (if historic data was 
entered). 

In addition to the tabular results, a graphical plot of the computed 
frequency curves can be obtained by pressing the Plot Curve button 
at the bottom of the analysis window.  A plot of the results for this test 
example is shown in Figure B-7. 

Figure B-7.  Plotted Frequency Curves for Test Example 1. 

 

The tabular and graphical results can be sent to the printer or the 
Windows clipboard for transfer into another piece of software.  To print 
the tabular results, select Print from the bottom of the analysis 
window.  To send the tabular results to the Windows clipboard, 
highlight the data you want to send to the clipboard and then press 
the Control-C key sequence.  To print the graphical results, first bring 
up the graphical plot and then select Print from the File menu.  To 
send the graphic to the windows clipboard, select Copy to Clipboard 
from the File menu. 
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In addition to the tabular and graphical results, there is a report file 
that shows the order in which the calculations were performed.  To 
review the report file, press the View Report button at the bottom of 
the analysis window.  When this button is selected a text viewer will 
open the report file and display it on the screen.  Shown in Figure B-8 
is the report file for test example 1. 

The report file contains a listing of the input data, preliminary results, 
outlier and historical data tests, additional calculations needed, and 
the final frequency curve results.  Different types and amounts of 
information will show up in the report file depending on the data and 
the options that have been selected for the analysis.  The user should 
review the report file to understand how HEC-SSP performed the 
Bulletin 17B frequency curve calculations. 
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Figure B-8.  Test Example 1 Report File. 
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Example 2: Analysis with High Outliers 
The input data for the Example 2 is the same as that for Example 2 in 
Appendix 12, Guidelines for Determining Flood Flow Frequency, Water 
Resources Council Bulletin 17B.  Example 2 illustrates the application 
to data with a high outlier.  

The data for this example is from Floyd River in James, Iowa.  The 
period of record used is from 1935 to 1973.  To view the data from 
HEC-SSP, right-click on the data record labeled "Floyd River-James 
IA" in the study explorer and then select Tabulate.  The data will 
appear as shown in Figure B-9. 

 
Figure B-9.  Tabulation of the Peak Flow Data for the Floyd River. 
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To plot the data for this example, right-click on the data record and 
then select Plot.  A plot of the data will appear as shown in Figure B-
10. 

Figure B-10.  Plot of Floyd River Data 

 

A Bulletin 17B and General Frequency analysis have been developed 
for this example.  To open the Bulletin 17B analysis editor for test 
example 2, either double-click on the analysis labeled FFA Test 2 
from the study pane, or from the Analysis menu select open and then 
select FFA Test 2 from the list of available analyses.  When FFA Test 2 
is selected, the Bulletin 17B analysis editor will appear as shown in 
Figure B-11. 
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Figure B-11.  Bulletin 17B Analysis Editor with Test Example 2 Data Set. 

 

Shown in Figure B-11 are the general settings that were used to 
perform this frequency analysis.  As shown, the Skew option was set 
to use the Weighted Skew.  To use the weighted skew option, the 
user must enter a value for the Regional Skew and the Regional Skew 
Mean Square Error (MSE).  This selection requires the user to either 
look up a value from the generalized skew map of the United States, 
which is provided with Bulletin 17B, or develop a value from a regional 
analysis of nearby gages.  In this example a value of -0.3 was taken 
from the generalized skew map of the U.S. from Bulletin 17B.  Bulletin 
17B suggests using a Regional Skew MSE of 0.302 whenever regional 
skew values are taken from the map. 

Also for this example, the Expected Probability Curve option was 
selected to be computed in addition to the Log Pearson III computed 
curve.  The Weibull plotting position method was selected, as well as 
the default Confidence Limits of 0.05 (5 percent chance exceedance) 
and 0.95 (95% chance exceedance).  Shown in Figure B-12 is the 
Bulletin 17B editor with the Options Tab selected. 
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Figure B-12.  Bulletin 17B Editor with Options Tab Selected for Test Example 
2. 

 

As shown in Figure B-12, the Historic Period Data option has been 
selected to reflect the fact that the 1953 flood peak of 71,500 cfs is 
known to be the largest flood since 1892. When the analysis was 
originally performed on this data set, the 1953 event was found to be 
a high outlier.  (The reader may replicate this result by un-checking 
the "Use Historic Data" box, hitting the Compute button, and reviewing 
the Tabular Results tab.)  High outliers should not be eliminated from 
an analysis, as they are valuable pieces of the flow record.  However, 
when a high outlier is found in a data set, it suggests that the event 
might actually be the largest in a much longer period of record.  The 
analyst should always try to locate and incorporate historic information 
to define a longer record and improve the quality of the frequency 
analysis.  Since it was known that the 1953 event was the largest 
value since 1892, the year 1892 is entered as the Start Year for the 
historic period.  Additionally, a High Threshold Value of 70,000 cfs 
was entered.  By entering the High Threshold Value of 70,000 cfs, the 
1953 flood of 71,500 cfs was removed from the systematic record and 
treated as a historic data value during the historic data adjustment 
calculations performed by HEC-SSP and outlined in Bulletin 17B, 
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Appendix 6.  Since no End Year was entered for the historic period, the 
last year of the systematic data set will be used as the End Year. 

Other features on this tab include the Low Outlier Threshold and the 
option to override the default Frequency Ordinates, neither of which 
are selected in this example. 

Once all of the General and Optional settings are set or selected, the 
user can press the Compute button to perform the analysis.  Once the 
computations have been completed, a message window will open 
stating Compute Complete.  Close this window and then select the 
Tabular Results tab.  The analysis window should look like Figure B-
13. 

Figure B-13.  Bulletin 17B Editor with Results Tab Selected for Test Example 2. 

 

As shown in Figure B-13, the Frequency Curve table contains the 
following results: 

 Percent Chance Exceedance 
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 Computed Curve (Log-Pearson III results) 

 Expected Probability Curve 

 Confidence Limits (5% and 95% chance exceedance curves) 

On the bottom left-hand side of the results tab is the System Statistics 
table for the observed station data (mean, standard deviation, station 
skew) and regional adjustment (regional skew, weighted skew, and 
adopted skew).  Also on the bottom right-hand side of the results tab 
is the Number of Events table showing the number of historic events 
used in the analysis, number of high outliers found, number of low 
outliers, number of zero or missing data years, number of systematic 
events in the gage record, and the historic record length (if historic 
data was entered). 

In addition to the tabular results, a graphical plot of the computed 
frequency curves can be obtained by pressing the Plot Curve button 
at the bottom of the analysis window.  A plot of the results for this test 
example is shown in Figure B-14. 
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Figure B-14.  Plotted Frequency Curves for Test Example 2. 

 

The tabular and graphical results can be sent to the printer or the 
windows clipboard for transfer into another piece of software.  To print 
the tabular results, select Print from the bottom of the analysis 
window.  To send the tabular results to the windows clipboard, 
highlight the data you want to send to the clipboard and then press 
the Control-C key sequence.  To print the graphical results, first bring 
up the graphical plot and then select Print from the File menu.  To 
send the graphic to the windows clipboard, select Copy to Clipboard 
from the File menu. 

In addition to the tabular and graphical results, there is a report file 
that shows the order in which the calculations were performed.  To 
review the report file, press the View Report button at the bottom of 
the analysis window.  When this button is selected a text viewer will 
open the report file and display it on the screen.  Shown in Figure B-15 
is the report file for Test Example 2. 

The report file contains a listing of the input data, preliminary results, 
outlier and historical data tests, additional calculations needed, and 
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the final frequency curve results.  Different types and amounts of 
information will show up in the report file depending on the data and 
the options that have been selected for the analysis.  The user should 
review the report file to understand how HEC-SSP performed the 
frequency curve calculations. 

         
Figure B-15.  Test Example 2 Report File. 
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Example 3: Testing and Adjusting for a Low Outlier 
The input data for Test 3 are the same as that for Example 3 in 
Appendix 12 of the WRC Guidelines.  Test 3 illustrates the application 
to data with a low outlier.  Note that the program automatically 
screens for low outliers and, if low outliers are found, outputs the 
preliminary results in the report file in order to allow for comparison 
with the final results. 

The data for this example is from Back Creek in Jones Springs, West 
Virginia.  The period of record used for this example is from 1929 to 
1973.  To view the data, right-click on the data record labeled "Back 
Creek-Jones Springs" in the study pane and then select Tabulate.  
The data will appear as shown in Figure B-16. 

 
Figure B-16.  Tabulation of the Peak Flow Data for Back Creek. 
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To plot the data for this example, right-click on the data record and 
select Plot.  A plot of the data will appear as shown in Figure B-17. 

Figure B-17.  Plot of Back Creek Data. 

 

A Bulletin 17B and General Frequency analysis have been developed 
for this example.  To open the Bulletin 17B analysis editor for test 
example 3, either double-click on the analysis labeled FFA Test 3 
from the study explorer, or from the Analysis menu select open and 
then select FFA Test 3 from the list of available analyses.  When FFA 
Test 3 is selected, the Bulletin 17B analysis editor will appear as shown 
in Figure B-18. 
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Figure B-18.  Bulletin 17B Analysis Editor with Test Example 3 Data Set. 

 

Shown in Figure B-18 are the general settings that were used to 
perform this frequency analysis.  As shown, the Skew option was set 
to use the Weighted Skew.  To use the weighted skew option, the 
user must enter a value for the Regional Skew and the Regional Skew 
Mean Square Error (MSE).  This selection requires the user to either 
look up a value from the generalized skew map of the United States, 
which is provided with Bulletin 17B, or develop a value from a regional 
analysis of nearby gages.  In this example, a value of 0.5 was taken 
from the generalized skew map of the U.S. from Bulletin 17B.  Bulletin 
17B suggests using a Regional Skew MSE of 0.302 whenever regional 
skew values are taken from the map. 

Also for this example, the Expected Probability Curve option was 
selected to be computed in addition to the Log Pearson III computed 
curve.  The Weibull plotting position method was selected, as well as 
the default Confidence Limits of 0.05 (5 percent chance exceedance) 
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and 0.95 (95% chance exceedance).  Shown in Figure B-19 is the 
Bulletin 17B editor with the Options Tab selected. 

Figure B-19.  Bulletin 17B Editor with the Options Tab Selected for Test 
Example 3. 

 

As shown in Figure B-19, none of the available options for modifying 
the frequency curve were selected for this test example.  These 
options include the Low Outlier Threshold and Historic Period 
Data.  Additionally, the option to override the default Frequency 
Ordinates was not selected. 

Once all of the General and Optional settings are set or selected, the 
user can press the Compute button to perform the analysis.  Once the 
computations have been completed a message window will open 
stating Compute Complete.  Close this window and select the 
Tabular Results tab.  The analysis window should look like Figure B-
20. 
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Figure B-20.  Bulletin 17B Editor with the Results Tab Selected for Test 
Example 3. 

 
As shown in Figure B-20, the Frequency Curve table contains the 
following results: 

 Percent Chance Exceedance 

 Computed Curve (Log-Pearson III results) 

 Expected Probability Curve 

 Confidence Limits (5% and 95% chance exceedance curves) 

On the bottom left-hand side of the results tab is a table of System 
Statistics for the observed station data (mean, standard deviation, 
station skew) and regional adjustment (regional skew, weighted skew, 
and adopted skew).  Also on the bottom right-hand side of the results 
tab is a table of Number of Events showing the number of historic 
events used in the analysis, number of high outliers found, number of 
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low outliers, number of zero or missing data years, number of 
systematic events in the gage record, and the historic record length (if 
historic data was entered).   

In this analysis, the software detected one low outlier in the 
systematic record.  As recommended in Bulletin 17B, if a low outlier is 
detected, then that data point will be removed and the Conditional 
Probability Adjustment will be used to recalculate the frequency curve 
and then the statistics without that point.  Review the report file to see 
the original statistics, computed curves, the low outlier test, and 
recomputed curves. 

In addition to the tabular results, a graphical plot of the computed 
frequency curves can be obtained by pressing the Plot Curve button 
at the bottom of the analysis window.  A plot of the results for this test 
example is shown in Figure B-21. 

Figure B-21.  Pot for Test Example 3. 

 

In addition to the tabular and graphical results, there is a report file 
that shows the order in which the calculations were performed.  To 
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review the report file, press the View Report button at the bottom of 
the analysis window.  When this button is selected a text viewer will 
open the report file and display it on the screen.  Shown in Figure B-22 
is the report file for test example 3. 

The report file contains a listing of the input data, preliminary results, 
outlier and historical data tests, additional calculations needed, and 
the final frequency curve results.  Different types and amounts of 
information will show up in the report file depending on the data and 
the options that have been selected for the analysis. 
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Figure B-22.  Report File for Test Example 3.  
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Example 4: Zero-Flood Years 

The input data for Test 4 are the same as that for Example 4 in 
Appendix 12 of the WRC Guidelines.  Test 4 illustrates the application 
to data that includes several zero flow years. 

The data for this example is from Orestimba Creek in Newman, 
California.  The period of record used for this example is from 1932 to 
1973.  To view the data from HEC-SSP, right-click on the data record 
labeled "Orestimba Creek-Newman, CA” in the study explorer and 
then select Tabulate.  The data will appear as shown in Figure B-23. 

 
Figure B-23.  Tabulation of the Peak Flow Data for Orestimba Creek. 
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To plot the data for this example, right-click on the data record and 
then select Plot.  A plot of the data will appear as shown in Figure B-
24.  The years with peak flows measuring zero are visible. 

Figure B-24.  Plot of Orestimba Creek Data. 

 

A Bulletin 17B and General Frequency analysis have been developed 
for this example.  To open the Bulletin 17B analysis editor for test 
example 4, either double-click on the analysis labeled FFA Test 4 
from the study explorer, or from the Analysis menu select open, then 
select FFA Test 4 from the list of available analyses.  When FFA Test 4 
is selected, the Bulletin 17B analysis editor will appear as shown in 
Figure B-25. 
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Figure B-25.  Bulletin 17B Analysis Editor with Test Example 4 Data Set. 

 

Shown in Figure B-25 are the general settings that were used to 
perform this frequency analysis.  As shown, the Skew option was set 
to use the Weighted Skew.  To use the weighted skew option, the 
user must enter a value for the Regional Skew and the Regional Skew 
Mean Square Error (MSE).  This selection requires the user to either 
look up a value from the generalized skew map of the United States, 
which is provided with Bulletin 17B, or develop a value from a regional 
analysis of nearby gages.  In this example a value of -0.3 was taken 
from the generalized skew map of the U.S. from Bulletin 17B.  Bulletin 
17B suggests using a Regional Skew MSE of 0.302 whenever regional 
skew values are taken from the map. 

Also for this example, the Expected Probability Curve option was 
selected to be computed in addition to the Log Pearson III computed 
curve.  The Weibull plotting position method was selected, as well as 
the default Confidence Limits of 0.05 (5 percent chance exceedance) 
and 0.95 (95% chance exceedance).  Shown in Figure B-26 is the 
Bulletin 17B editor with the Options Tab selected. 
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Figure B-26.  Bulletin 17B Editor with the Options Tab Selected for Test 
Example 4. 

 

As shown in Figure B-26, none of the available options for modifying 
the frequency curve were selected for this test example.  These 
options include the Low Outlier Threshold and Historic Period 
Data.  Additionally, the option to override the default Frequency 
Ordinates was not selected. 

Once all of the General and Optional settings are set or selected, the 
user can press the Compute button to perform the analysis.  Once the 
computations have been completed a message window will open 
stating Compute Complete.  Close this window and then select the 
Tabular Results tab.  The analysis window should look Figure B-27. 
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Figure B-27.  Bulletin 17B Editor with the Results Tab Selected for Test 
Example 4. 

 
 
As shown in Figure B-27, the Frequency Curve table contains the 
following results: 

 Percent Chance Exceedance 

 Computed Curve (Log-Pearson III results) 

 Expected Probability Curve 

 Confidence Limits (5% and 95% chance exceedance curves) 

On the bottom left-hand side of the results tab is a table of System 
Statistics for the observed station data (mean, standard deviation, 
station skew) and regional adjustment (regional skew, weighted skew, 
and adopted skew).  Also on the bottom right-hand side of the results 
tab is a table of Number of Events showing the number of historic 
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events used in the analysis, number of high outliers found, number of 
low outliers, number of zero or missing data years, number of 
systematic events in the gage record, and the historic record length (if 
historic data was entered).    

As noted earlier, there were six zero values in this record, and also a 
low outlier.  A zero value causes difficulty because the first step in 
fitting a Log Pearson III distribution is computing the base-10 log of 
each flow value, which is undefined for zero.  Bulletin 17B 
recommends removing the zero values (and the low outlier) from the 
systematic record to compute a preliminary frequency curve, and then 
adjusting that curve with the Conditional Probability Adjustment.  The 
final frequency curve and statistics are shown in the table, and the 
preliminary calculations can be reviewed in the report file.  

In addition to the tabular results, a graphical plot of the computed 
frequency curves can be obtained by pressing the Plot Curve button 
at the bottom of the analysis window.  A plot of the results for this test 
example is shown in Figure B-28. 

Figure B-28.  Plot of Test Example 4 Results. 
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The tabular and graphical results can be sent to the printer or the 
windows clipboard for transfer into another piece of software.  To print 
the tabular results, select Print from the bottom of the analysis 
window.  To send the tabular results to the windows clipboard, 
highlight the data you want to send to the clipboard and then press 
the Control-C key sequence.  To print the graphical results, first bring 
up the graphical plot and then select Print from the File menu.  To 
send the graphic to the windows clipboard, select Copy to Clipboard 
from the File menu. 

In addition to the tabular and graphical results, there is a report file 
that shows the order in which the calculations were performed.  To 
review the report file, press the View Report button at the bottom of 
the analysis window.  When this button is selected a text viewer will 
open the report file and display it on the screen.  Shown in Figure B-29 
is the report file for Test Example 4. 

The report file contains a listing of the input data, preliminary results, 
outlier and historical data tests, additional calculations needed, and 
the final frequency curve results.  Different types and amounts of 
information will show up in the report file depending on the data and 
the options that have been selected for the analysis. 
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Figure B-29.  HEC-SSP Report File for Test Example 4. 
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Example 5: Confidence Limits and Low Threshold 
Discharge 

This test illustrates the use of user-entered confidence limits.  
Probabilities of .01 and .99 were entered for the computed confidence 
limit curves.  This data set also includes two very low values, the 
higher of which is just above the default low outlier threshold.  This 
example therefore also demonstrates the use of a user-entered low 
outlier threshold set to be higher than both values.   

The data for this example is from Kaskaskia River in Vandalia, Illinois.  
The period of record used for this example is from 1908 to 1970.  To 
view the data from HEC-SSP, right-click on the data record labeled 
"Kaskaskia River-Vandalia, IL" in the study explorer and then select 
Tabulate.  The data will appear as shown in Figure B-30. 

 
Figure B-30.  Tabulation of the Peak Flow Data for Kaskaskia River. 
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To plot the data for this example, right-click on the data record and 
then select Plot.  A plot of the data will appear as shown in Figure B-
31. 

Figure B-31.  HEC-SSP Plot of the Kaskaskia River Data. 

 

A Bulletin 17B and General Frequency analysis have been developed 
for this example.  To open the Bulletin 17B analysis editor for test 
example 5, either double-click on the analysis labeled FFA Test 5 
from the study explorer, or from the Analysis menu select Open and 
then select FFA Test 5 from the list of available analyses.  When FFA 
Test 5 is selected, the Bulletin 17B analysis editor will appear as shown 
in Figure B-32. 
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Figure B-32.  Bulletin 17B Analysis Editor for Test Example 5. 

 

Shown in Figure B-32 are the general settings that were used to 
perform this frequency analysis.  As shown, the Skew option was set 
to use the Weighted Skew.  To use the weighted skew option, the 
user must enter a value for the Regional Skew and the Regional Skew 
Mean Square Error (MSE).  This selection requires the user to either 
look up a value from the generalized skew map of the United States, 
which is provided with Bulletin 17B, or develop a value from a regional 
analysis of nearby gages.  In this example a value of -0.4 was taken 
from the generalized skew map of the U.S. from Bulletin 17B.  Bulletin 
17B suggests using a Regional Skew MSE of 0.302 whenever regional 
skew values are taken from the map. 

Also for this example, the Expected Probability Curve option was 
selected to be computed in addition to the Log Pearson III computed 
curve.  The default method of Weibull plotting positions was selected.  
The default values for confidence limits (.05 and .95) were changed to 
0.01 (1 percent chance exceedance) and 0.99 (99% chance 
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exceedance).  Shown in Figure B-33 is the Bulletin 17B editor with the 
Options Tab selected. 

Figure B-33.  Bulletin 17B Editor with the Options Tab Shown for Test Example 
5. 

 

As shown in Figure B-33, a Low Outlier Threshold of 2000 cfs was 
entered. In the initial computation with this data (which the reader can 
reproduce by Computing without the "Use Low Outlier Threshold" box 
checked), the default low outlier threshold was 1,253 cfs, just below 
the second lowest value of 1,270 cfs.  A look at the statistics and 
computed frequency curve from that run shows that the 1,270 cfs 
value is well below the computed curve and with a station skew of -
0.21 the frequency curve does not fit the upper data well.  By choosing 
to also censor the 1,270 cfs value with a threshold of 2000 cfs, the fit 
is improved.  None of the other available options, such as Historic 
Period Data and the option to override the default Frequency 
Ordinates were selected for this test example.  
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Once all of the General and Optional settings are set or selected, the 
user can press the Compute button to perform the analysis.  Once the 
computations have been completed a message window will open 
stating Compute Complete.  Close this window and then select the 
Tabular Results tab from the analysis window.  The analysis window 
should look Figure B-34. 

Figure B-34.  Bulletin 17B Editor with the Results Tab Selected for Test 
Example 5. 

 

As shown in Figure B-34, the Frequency Curve table contains the 
following results: 

 Percent Chance Exceedance 

 Computed Curve (Log-Pearson III results) 

 Expected Probability Curve 

 Confidence Limits (1% and 99% chance exceedance curves) 
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On the bottom left-hand side of the results tab is a table of System 
Statistics for the observed station data (mean, standard deviation, 
station skew) and regional adjustment (regional skew, weighted skew, 
and adopted skew).  Also on the bottom right-hand side of the results 
tab is a table of Number of Events showing the number of historic 
events used in the analysis, number of high outliers found, number of 
low outliers, number of zero or missing data years, number of 
systematic events in the gage record, and the historic record length 
(only if historic data was entered). 

With the user-defined low-outlier threshold of 2000 cfs, there are two 
low-outliers detected.  The analysis report shows the program omitted 
these values and used the Conditional Probability Adjustment to 
recompute the resulting frequency curve and statistics.  The report file 
(described below) includes the preliminary computation before 
removal of outliers and the default and user-defined outlier thresholds, 
as well as the final frequency curve and statistics. 

In addition to the tabular results, a graphical plot of the computed 
frequency curves can be obtained by pressing the Plot Curve button 
at the bottom of the analysis window.  A plot of the results for this test 
example is shown in Figure B-35. 
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Figure B-35.  Plot of the Frequency Curve Results for Test Example 5. 

 

The tabular and graphical results can be sent to the printer or the 
windows clipboard for transfer into another piece of software.  To print 
the tabular results, select Print from the bottom of the analysis 
window.  To send the tabular results to the windows clipboard, 
highlight the data you want to send to the clipboard and then press 
the Control-C key sequence.  To print the graphical results, first bring 
up the graphical plot and then select Print from the File menu.  To 
send the graphic to the windows clipboard, select Copy to Clipboard 
from the File menu. 

In addition to the tabular and graphical results, there is a report file 
that shows the order in which the calculations were performed.  To 
review the report file, press the View Report button at the bottom of 
the analysis window.  When this button is selected a text viewer will 
open the report file and display it on the screen.  Shown in Figure B-36 
is the report file for Test Example 5. 

The report file contains a listing of the input data, preliminary results, 
outlier and historical data tests, additional calculations needed, and 
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the final frequency curve results.  Different types and amounts of 
information will show up in the report file depending on the data and 
the options that have been selected for the analysis. 

  
Figure B-36.  Report File for Test Example 5. 
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Example 6: Use of Historic Data and Median Plotting 
Position 

This test demonstrates how to use historic information to improve a 
flow frequency analysis.  A historic flood peak of 15,000 cfs which 
occurred in 1843 is included in the analysis.  This value is the highest 
known value up to the present time (1974 for this example), even 
though the systematic record stopped in 1955.   

The data for this example is from Ridley Creek in Moylan, 
Pennsylvania.  The period of record used for this example is from 1932 
to 1955.  To view the data from HEC-SSP, right-click on the data 
record labeled "Ridley Creek-Moylan, PA" in the study explorer and 
then select Tabulate.  The data will appear as shown in Figure B-37. 

 
Figure B-37.  Tabulation of the Peak Flow Data for Ridley Creek. 
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To plot the data for this example, right-click on the data record and 
then select Plot.  A plot of the data will appear as shown in Figure B-
38. 

Figure B-38.  Plot of the Ridley Creek Data. 

 

A Bulletin 17B and General Frequency analysis have been developed 
for this example.  To open the Bulletin 17B analysis editor for test 
example 6, either double-click on the analysis labeled FFA Test 6 
from the study explorer, or from the Analysis menu select open, then 
select FFA Test 6 from the list of available analyses.  When FFA Test 6 
is selected, the Bulletin 17B analysis editor will appear as shown in 
Figure B-39. 



Appendix B – Example Data Sets HEC-SSP User's Manual 

B-46 

Figure B-39.  Bulletin 17B Analysis Editor for Test Example 6. 

 

Shown in Figure B-39 are the general settings that were used to 
perform this frequency analysis.  As shown, the Skew option was set 
to use the Weighted Skew.  To use the weighted skew option, the 
user must enter a value for the Regional Skew and the Regional Skew 
Mean Square Error (MSE).  This selection requires the user to either 
look up a value from the generalized skew map of the United States, 
which is provided with Bulletin 17B, or develop a value from a regional 
analysis of nearby gages.  In this example a value of 0.4 was taken 
from the generalized skew map of the U.S. from Bulletin 17B.  Bulletin 
17B suggests using a Regional Skew MSE of 0.302 whenever regional 
skew values are taken from the map. 

Also for this example, the Expected Probability Curve option was 
selected to be computed in addition to the Log Pearson III computed 
curve.  The Median plotting position method was selected, as well as 
the default Confidence Limits of 0.05 (5 percent chance exceedance) 
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and 0.95 (95% chance exceedance).  Shown in Figure B-40 is the 
Bulletin 17B editor with the Options Tab selected. 

Figure B-40.  Bulletin 17B Analysis Editor with Options Tab Shown for Test 
Example 6. 

 

As shown in Figure B-40, the Historic Period Data option has been 
selected to reflect a historical flood event of 15,000 cfs in 1843 and an 
analysis period from 1843 to 1974.  Historic data is used to account for 
historic flood events large enough to be relevant to the analysis and 
not contained in the systematic data record.  The additional 
information provided by historic data can improve the flood frequency 
analysis, especially when the data collection period for a given area is 
relatively short. Information for a Historic Flood Peak has been 
entered to account for a peak flow of 15,000 cfs in the 1843 water 
year.  The Historic Period Start Year has been left blank.  By default 
this value will be the earliest year found in the historic flood peak data 
or the systematic record.  Therefore for this example, 1843 will 
automatically be used for the Start Year of the Historic Period.  An End 
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Year of 1974 has been entered.  The systematic record for the gage 
ended in 1955, however when this analysis was performed in 1974, no 
other flood peaks of consequence had been observed between 1955 
and 1974.  Therefore, 1974 is set as the End Year for the historic 
period analysis. 

Other features on this tab include the Low Outlier Threshold and the 
option to override the default Frequency Ordinates.  Neither option 
is selected in this example. 

Once all of the General and Optional settings are set or selected, the 
user can press the Compute button to perform the analysis.  Once the 
computations have been completed a message window will open 
stating Compute Complete.  Close this window and then select the 
Tabular Results tab from the analysis window.  The analysis window 
should look Figure B-41. 

Figure B-41.  Bulletin 17B Editor with the Results Tab Selected for Test 
Example 6. 
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As shown in Figure B-41, the Frequency Curve table contains the 
following results: 

 Percent Chance Exceedance 

 Computed Curve (Log-Pearson III results) 

 Expected Probability Curve 

 Confidence Limits (5% and 95% chance exceedance curves) 

On the bottom left-hand side of the results tab is a table of System 
Statistics for the observed station data (mean, standard deviation, 
station skew) and regional adjustment (regional skew, weighted skew, 
and adopted skew).  Also on the bottom right-hand side of the results 
tab is a table of Number of Events showing the number of historic 
events used in the analysis, number of high outliers found, number of 
low outliers, number of zero or missing data years, number of 
systematic events in the gage record, and the historic record length (if 
historic data was entered). 

This example reports one historical flood event, and a historical period 
of 132 years, between 1843 and 1974.  The reported statistics reflect 
the use of the historical data adjustment outlined in Bulletin 17B 
Appendix 6.  The report file (described below) shows the initial 
computation of the statistics and frequency curve before the historical 
data was used, and the resulting statistics and frequency curve after 
the historical data is taken into account. 

In addition to the tabular results, a graphical plot of the computed 
frequency curves can be obtained by pressing the Plot Curve button 
at the bottom of the analysis window.  A plot of the results for this test 
example is shown in Figure B-42. 
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Figure B-42.  Plot of the Frequency Curve Results for Test Example 6. 

 

The tabular and graphical results can be sent to the printer or the 
windows clipboard for transfer into another piece of software.  To print 
the tabular results, select Print from the bottom of the analysis 
window.  To send the tabular results to the windows clipboard, 
highlight the data you want to send to the clipboard and then press 
the Control-C key sequence.  To print the graphical results, first bring 
up the graphical plot and then select Print from the File menu.  To 
send the graphic to the windows clipboard, select Copy to Clipboard 
from the File menu. 

In addition to the tabular and graphical results, there is a report file 
that shows the order in which the calculations were performed.  To 
review the report file, press the View Report button at the bottom of 
the analysis window.  When this button is selected a text viewer will 
open the report file and display it on the screen.  Shown in Figure B-43 
is the report file for Test Example 6. 

The report file contains a listing of the input data, preliminary results, 
outlier and historical data tests, additional calculations needed, and 
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the final frequency curve results.  Different types and amounts of 
information will show up in the report file depending on the data and 
the options that have been selected for the analysis. 

Figure B-43.  HEC-SSP Report File for Test Example 6. 
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Example 7: Analyzing Stage Data 

This example demonstrates how to use the General Frequency analysis 
to analyze stage data.  The data for this example is annual maximum 
stage data for a reservoir.  The period of record used for this example 
is from 1948 to 2004.  To view the data, right-click on the data record 
labeled "Reservoir Stage" in the study explorer and then select 
Tabulate.  The data will appear as shown in Figure B-44. 

 
Figure B-44.  Tabulation of the Peak Stage Data for Example 7. 
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To plot the data for this example, right-click on the data record and 
then select Plot.  A plot of the data will appear as shown in Figure B-
45. 

Figure B-45.  Plot of the Reservoir Stage Data. 

 

A General Frequency analysis has been developed for this example.  
To open the General Frequency analysis editor for Test Example 7, 
either double-click on the analysis labeled Stage Analysis Test 7 
from the study explorer, or from the Analysis menu select open, then 
select Stage Analysis Test 7 from the list of available analyses.  
When test 7 is opened, the General Frequency analysis editor will 
appear as shown in Figure B-46.  For this analysis, the Do Not Use 
Log Transform option was selected, the Weibull plotting position 
method was selected, the default Confidence Limits were selected, 
and no modification was made to the time window. 
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Figure B-46.  General Frequency Analysis Editor for Test Example 7. 

 

Shown in Figure B-47 is the General Frequency analysis editor with the 
Options Tab selected.  Features on this tab include the Low Outlier 
Threshold, adding Historic Date to the analysis, an option to 
override the default Frequency Ordinates, and Output Labeling.  
The 0.1 percent frequency ordinate was added to the User Specified 
Frequency Ordinates table.    
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Figure B-47.  General Frequency Analysis Editor with Options Tab Shown for 
Test Example 7. 

 

Once all of the General and Optional settings are set or selected, the 
user can choose to perform an Analytical or Graphical analysis.  In this 
example, a graphical analysis was performed on the peak stage data.  
Shown in Figure B-48 is the Graphical tab.  The frequency curve was 
entered manually into the User-Defined Graphical Curve table.  
When the Compute button is pressed, the program plots the graphical 
frequency curve along with the annual maximum peak stage values.   
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Figure B-48.  General Frequency Graphical Tab Shown for Test Example 7. 

 

In addition to the table and plot available on the Graphical tab, a plot 
of the graphical frequency curves can be obtained by pressing the Plot 
Graphical Curve button at the bottom of the analysis window.  A plot 
of the results for this test example is shown in Figure B-49. 
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Figure B-49.  Plot of the Frequency Curve Results for Test Example 7. 

 

Graphical results can be sent to the printer or the windows clipboard 
for transfer into another piece of software.  To print the graphical 
results, first bring up the graphical plot and then select Print from the 
File menu.  To send the graphic to the windows clipboard, select Copy 
to Clipboard from the File menu. 

In addition to the tabular and graphical results, there is a report file 
that shows the order in which the calculations were performed.  To 
review the report file, press the View Report button at the bottom of 
the analysis window.  When this button is selected a text viewer will 
open the report file and display it on the screen.  Shown in Figure B-50 
is the report file for Test Example 7. 

The report file contains a listing of the input data, preliminary results, 
outlier and historical data tests, additional calculations needed, the 
final computed frequency curve results, and the user-defined graphical 
frequency curve.  Different types and amounts of information will show 
up in the report file depending on the data and the options that have 
been selected for the analysis. 
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 Figure B-50.  Report File for Test Example 7. 
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Example 8: Using User-Adjusted Statistics 

This example demonstrates how to use the General Frequency analysis 
and enter user-adjusted statistics.  The data for this example is from 
an analysis that computed local runoff for the Rio Grande at 
Albuquerque.  The data includes unregulated daily average flows 
generated by rainfall-runoff from areas downstream of upstream 
reservoirs.  The period of record used for this example is from 1944 to 
2000.  To view the data, right-click on the data record labeled "Rio 
Grande at Alb Local Runoff" in the study explorer and then select 
Tabulate.  The data will appear as shown in Figure B-51. 

 
Figure B-51.  Tabulation of the Peak Flow Data for Example 8. 
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To plot the data for this example, right-click on the data record and 
then select Plot.  A plot of the data will appear as shown in Figure B-
52. 

Figure B-52.  Plot of Data for Example 8. 

 

A General Frequency analysis has been developed for this example.  
To open the General Frequency analysis editor for Test Example 8, 
either double-click on the analysis labeled Local Runoff at Alb Test 8 
from the study explorer, or from the Analysis menu select open, then 
select Local Runoff at Alb Test 8 from the list of available analyses.  
When test 8 is opened, the General Frequency analysis editor will 
appear as shown in Figure B-53. 
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Figure B-53.  General Frequency Analysis Editor for Test Example 8. 

 

Shown in Figure B-53 are the general settings that were used to 
perform this frequency analysis.  For this analysis, the Use Log 
Transform option was selected, the Weibull plotting position method 
was selected, the default Confidence Limits were selected, and no 
modification was made to the Time Window.   

Shown in Figure B-54 is the General Frequency analysis editor with the 
Options Tab selected.  Features on this tab include the Low Outlier 
Threshold, an option to use Historic Data, an option to override the 
default Frequency Ordinates, and Output Labeling.  All defaults 
settings were selected for this example.     
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Figure B-54.  General Frequency Analysis Editor with Options Tab Shown for 
Test Example 8. 

 

Once all of the General and Optional settings are set or selected, the 
user can choose to perform an Analytical or Graphical analysis.  In this 
example, an analytical analysis was performed.  Shown in Figure B-55 
is the Settings tab for the analytical analysis.  As shown, the 
distribution selected for this example is LogPearsonIII.  The Skew 
option was set to Use Station Skew and the Do Not Compute 
Excepted Probability option was selected.  
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Figure B-55.  General Frequency Analysis Editor with Settings Tab Shown for 
Test Example 8. 

 

Press the Compute button to perform the analysis.  Once the 
computations have been completed, a message window will open 
stating Compute Complete.  Close this window and then select the 
Plot tab within the analytical analysis.  The analytical plot window 
should look Figure B-56. 
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Figure B-56.  The Plot Tab for Test Example 8. 

 

As shown in Figure B-56, the Plot tab contains a graph of the 
systematic data, the computed frequency curve, and the confidence 
limits.  The right side of the plot tab contains a table of Computed 
Statistics and User Statistics.  The user has the option to enter a 
mean, standard deviation, adopted skew, and equivalent years of 
record in the User Statistics table.  The Compute button must be 
pressed after User Statistics have been entered in order for the 
program to compute a frequency curve using the user statistics.   

As mentioned at the beginning of this example, the annual peak flows 
were based on daily averaged flows.  In order to compute an 
instantaneous peak flow frequency curve, a relationship between daily 
averaged flows and the corresponding instantaneous peak flows was 
developed.  This was done by plotting daily averaged flow and the 
corresponding instantaneous peak flow for selected flood events.  
Using this relationship, a Mean of 3.731 was computed and entered in 
the User Statistics table and the analytical analysis was recomputed.   

Figure B-57 shows that the frequency curve computed from the user-
adjusted statistics is added to the graph.  This figure also shows that 
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the user does not have to enter values for all statistics in order for the 
program to compute a user-adjusted frequency curve.  The program 
will use statistics computed from the systematic and historic data if the 
statistics are not defined in the User Statistics table.  In this example, 
the program used the computed statistics for standard deviation, 
adopted skew, equivalent years of record and the user-defined mean 
of 3.731 when computing the user-adjusted frequency curve.  

Figure B-57.  Plot Tab with User Adjusted Statistics and Frequency Curves for 
Test Example 8. 

 

Select the Tabular Results tab to see information for both the 
computed and user-adjusted frequency curves.  As shown in Figure B-
58, the Frequency Curve table contains the percent chance 
exceedance, computed curves (Log-Pearson III results), and the 
Confidence Limits (5% and 95% chance exceedance curves) for both 
the computed and user-adjusted statistics.  

On the bottom left-hand side of the results tab is a table of System 
Statistics for the observed station data (mean, standard deviation, 
station skew) and regional adjustment (regional skew, weighted skew, 
and adopted skew).  Also on the bottom right-hand side of the results 
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tab is a table of Number of Events showing the number of historic 
events used in the analysis, number of high outliers found, number of 
low outliers, number of zero or missing data years, number of 
systematic events in the gage record, and the historic record length (if 
historic data was entered). 

Figure B-58.  General Frequency Editor with Results Tab Selected for Test 
Example 8. 

 

In addition to the tabular results, a graphical plot of the computed 
frequency curves can be obtained by pressing the Plot Analytical 
Curve button at the bottom of the analysis window.  A plot of the 
results for this test example is shown in Figure B-59. 
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Figure B-59.  Plot of the Frequency Curve Results for Test Example 8. 

 

The tabular and graphical results can be sent to the printer or the 
windows clipboard for transfer into another piece of software.  To print 
the tabular results, select Print from the bottom of the analysis 
window.  To send the tabular results to the windows clipboard, 
highlight the data you want to send to the clipboard and then press 
the Control-C key sequence.  To print the graphical results, first bring 
up the graphical plot and then select Print from the File menu.  To 
send the graphic to the windows clipboard, select Copy to Clipboard 
from the File menu. 

In addition to the tabular and graphical results, there is a report file 
that shows the order in which the calculations were performed.  To 
review the report file, press the View Report button at the bottom of 
the analysis window.  When this button is selected a text viewer will 
open the report file and display it on the screen.  Shown in Figure B-60 
is the report file for Test Example 8. 

The report file contains a listing of the input data, preliminary results, 
outlier and historical data tests, additional calculations needed, and 
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the final frequency curve results.  Different types and amounts of 
information will show up in the report file depending on the data and 
the options that have been selected for the analysis. 

Figure B-60.  Report File for Test Example 8. 
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Example 9: General Frequency – Graphical Analysis 
This example demonstrates how to create a Graphical Analysis within a 
General Frequency analysis.  The data for this example is from an 
analysis that computed regulated flow for the Rio Grande at 
Albuquerque.  The data includes regulated daily average flows from 
upstream reservoirs routed downstream to Albuquerque.  The period 
of record used for this example is from 1974 to 2002.  To view the 
data, right-click on the data record labeled "Rio Grande at Alb Reg 
Flow" in the study explorer and then select Tabulate.  The data will 
appear as shown in Figure B-61. 

 
Figure B-61.  Tabulation of the Peak Flow Data for Example 9. 
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To plot the data for this example, right-click on the data record and 
then select Plot.  A plot of the data will appear as shown in Figure B-
62. 

Figure B-62.  Plot of Data for Example 9. 

 

A General Frequency analysis has been developed for this example.  
To open the General Frequency analysis editor for test example 9, 
either double-click on the analysis labeled Reg Flow Rio Grande Test 
9 from the study explorer, or from the Analysis menu select open, 
then select Reg Flow Rio Grande Test 9 from the list of available 
analyses.  When Test 9 is opened, the General Frequency analysis 
editor will appear as shown in Figure B-63. 
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Figure B-63.  General Frequency Analysis Editor for Test Example 9. 

 

Shown in Figure B-63 are the general settings that were used to 
perform this frequency analysis.  For this analysis, the Use Log 
Transform option was selected, the Weibull plotting position method 
was selected, the default Confidence Limits were selected, and no 
modification was made to the Time Window.   

Shown in Figure B-64 is the General Frequency analysis editor with the 
Options Tab selected.  Features on this tab include the Low Outlier 
Threshold, an option to use Historic Data, an option to override the 
default Frequency Ordinates, and Output Labeling.  All defaults 
settings were selected for this example.     
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Figure B-64.  General Frequency Analysis Editor with Options Tab Shown for 
Test Example 9. 

 

Once all of the General and Optional settings are set or selected, the 
user can choose to perform an Analytical or Graphical analysis.  In this 
example, a graphical analysis was performed.  Shown in Figure B-65 is 
the Graphical analysis tab.  As shown, a graph containing the 
systematic data and graphical curve is on the left side and a table 
containing the user-entered frequency curve is on the right side of the 
window.  The frequency curve was entered manually into the User-
Defined Graphical Curve table.  When the Compute button is 
pressed, the program plots the graphical frequency curve along with 
the annual maximum flow values.  For this example, a reservoir model 
was used to route synthetic hydrographs through the reservoir 
network upstream of Albuquerque using current operating criteria.  
This was done for the 0.2, 0.5, 1.0, 2.0, 10, 20, and 50 percent 
events.  Output from the model was input into the Frequency 
Ordinates table.  For the more frequent events (10 year and below), 
the graphical curve was fit to the data visually.  This example shows 
how a reservoir network can influence the frequency curve.  Notice 
how the frequency curve is flat for the 20 through the 1 percent 
chance events.  The reservoir network is able to control flooding in this 
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range.  This example also shows that as flood events become larger, 
the reservoir network has less influence on controlling downstream 
flooding.  

Figure B-65.  Graphical Tab Shown for Test Example 9. 

 

A graphical plot of the graphical frequency curve can be obtained by 
pressing the Plot Graphical Curve button at the bottom of the 
analysis window.  A plot of the results for this test example is shown in 
Figure B-66. 
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Figure B-66.  Plot of the Frequency Curve Results for Test Example 9. 

 

The graphical results can be sent to the printer or the windows 
clipboard for transfer into another piece of software.  To print the 
graphical results, first bring up the graphical plot and then select Print 
from the File menu.  To send the graphic to the windows clipboard, 
select Copy to Clipboard from the File menu. 

In addition to the tabular and graphical results, there is a report file 
that shows the order in which the calculations were performed.  To 
review the report file, press the View Report button at the bottom of 
the analysis window.  When this button is selected a text viewer will 
open the report file and display it on the screen.  Shown in Figure B-67 
is the report file for Test Example 9. 

The report file contains a listing of the input data, preliminary results, 
outlier and historical data tests, and additional calculations needed.  
Different types and amounts of information will show up in the report 
file depending on the data and the options that have been selected for 
the analysis. 
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Figure B-67.  Report File for Test Example 9. 
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Example 10: Volume Frequency Analysis, Maximum 
Flows 

This example demonstrates how to perform a Volume Frequency 
analysis for maximum flows.  The data for this example was derived 
from an analysis where a time-series of daily average unregulated 
flows were computed for the Rio Grande at Albuquerque.  The period 
of record for this example is from 1941 to 2002.  To view the data, 
right-click on the data record labeled "Rio Grande at Alb Unreg 
Daily" in the study explorer and then select Plot.  The data will 
appear as shown in Figure B-68. 

Figure B-68.  Plot of Daily Average Flow for Example 10. 

 

A Volume Frequency analysis has been developed for this example.  To 
open the Volume Frequency Analysis editor for test example 10, either 
double-click on the analysis labeled Unreg Flow Rio Grande Test 10 
from the study explorer, or from the Analysis menu select open, then 
select Unreg Flow Rio Grande Test 10 from the list of available 
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analyses.  When test 10 is opened, the Volume Frequency Analysis 
editor will appear as shown in Figure B-69. 

Figure B-69.  Volume Frequency Analysis Editor for Test Example 10. 

 

Shown in Figure B-69 are the general settings that were used to 
perform this frequency analysis.  For this analysis, the Use Log 
Transform option was selected, the Weibull plotting position method 
was selected, Analyze Maximums was selected, the Calendar Year 
option was selected, and no modification was made to the Time 
Window.   

Shown in Figure B-70 is the Volume Frequency Analysis editor with the 
Options Tab selected.  Features on this tab include an option to 
override the default Flow Duration values, an option to override the 
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default Frequency Ordinates, and Output Labeling.  Both the flow-
duration and frequency ordinate tables were modified. 

Figure B-70.  Options Tab Shown for Test Example 10. 

 

Once all of the General and Optional settings are set or selected, the 
user can extract the volume-duration data from the time-series of 
daily flows.  Select the Duration Data tab and press the Extract 
Volume-Duration Data button at the bottom of the table.  The table 
should then fill with the flow-duration values, as shown in Figure B-71. 
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Figure B-71.  Volume-Duration Data Table for Test Example 10. 

 

Once the data has been extracted, the user must choose to perform an 
Analytical or Graphical analysis.  In this example, an analytical 
analysis was performed.  Shown in Figure B-72 is the Settings tab for 
the analytical analysis.  As shown, the distribution selected for this 
example is LogPearsonIII.  The Skew option was set to Use Station 
Skew and the Do Not Compute Excepted Probability option was 
selected.  
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Figure B-72.  Settings Tab Shown for Test Example 10. 

 

Press the Compute button to perform the analysis.  A message 
window will open stating that a few of the annual maximums occurred 
during the beginning of the year.  The message suggests that the user 
change the year/season specification to capture independent events.  
You want to minimize the possibility that the same flood event is used 
for consecutive years.  Press the OK button to finish the compute.  
Once the computations have been completed, a message window will 
open stating Compute Complete.  Close this window and then select 
the Tabular Results tab within the analytical analysis.  The results 
table should look Figure B-73.  The top portion of the results table 
contains the percent chance exceedance for all durations (the report 
contains confidence limits).  The bottom portion of the results table 
contains the statistics for all duration. 
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Figure B-73.  Tabular Results Tab for Test Example 10. 

 
 
As shown in Figure B-74, the Plot tab contains a graph of the 
systematic data and the computed frequency curves.  Notice how 
some of the frequency curves look like they might cross if the lines 
were extended.  The Statistics tab can be used to modify the 
computed statistics to ensure that the frequency curves are consistent. 
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Figure B-74.  Plot Tab for Example 10. 
 

For this example, the standard deviation and the adopted skew values 
were modified to make sure the volume frequency curves were 
consistent.  As shown in Figure B-75, the check boxes next to mean, 
standard deviation, and adopted skew were checked and then user-
adjusted statistics were entered into the table for all durations.  The 
Compute button must be pressed after adjusted statistics have been 
entered in order for the program to recompute the frequency curves 
using the user-adjusted statistics.  Figure B-76 shows the Plot tab 
after the user-adjusted statistics were entered on the Statistics tab.  
Results on the Tabular Results tab will also update when user-
adjusted statistics are entered on the Statistics tab.    
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Figure B-75.  Statistics Tab for Test Example 10. 



Appendix B – Example Data Sets HEC-SSP User's Manual 

B-84 

Figure B-76.  Plot Tab for Example 10 After the Statistics were Adjusted on the 
Statistics Tab.  

 

In addition to the Tabular Results and Plot tabs, graphical plots can be 
opened by selecting the Plot Duration Data or Plot Analytical 
Curve buttons at the bottom of the analysis window.  A plot of the 
results for this test example is shown in Figure B-77. 
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Figure B-77.  Plot of the Frequency Curve Results for Test Example 10. 

 

The tabular and graphical results can be sent to the printer or the 
windows clipboard for transfer into another piece of software.  To print 
the tabular results, select Print from the bottom of the analysis 
window.  To send the tabular results to the windows clipboard, 
highlight the data you want to send to the clipboard and then press 
the Control-C key sequence.  To print the graphical results, first bring 
up the graphical plot and then select Print from the File menu.  To 
send the graphic to the windows clipboard, select Copy to Clipboard 
from the File menu. 

In addition to the tabular and graphical results, there is a report file 
that shows the order in which the calculations were performed.  To 
review the report file, press the View Report button at the bottom of 
the analysis window.  When this button is selected a text viewer will 
open the report file and display it on the screen.  Shown in Figure B-78 
is the report file for Test Example 10. 
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The report file contains a listing of the input data, preliminary results, 
outlier and historical data tests, additional calculations needed, and 
the final frequency curve results.  Different types and amounts of 
information will show up in the report file depending on the data and 
the options that have been selected for the analysis. 

Figure B-78.  Report File for Test Example 10. 
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Example 11: Volume Frequency Analysis, Minimum 
Flows 

This example demonstrates how to create a low flow Volume 
Frequency analysis.  The data for this example was downloaded from 
the USGS.  It is comprised of daily average flow for the Chattahoochee 
River at Cornelia, Georgia.  Drought conditions were occurring in the 
region at the time of this analysis.  Among other things, a low flow 
analysis can be used to determine the severity of a drought.  The 
period of record for this example is from 1957 to 2007.  To view the 
data, right-click on the data record labeled "Chattahoochee River" in 
the study explorer and then select Plot.  The data will appear as 
shown in Figure B-79.   

Figure B-79.  Plot of Daily Average Flow for Example 11. 

 

A Volume Frequency analysis has been developed for this example.  To 
open the Volume Frequency Analysis editor for test example 11, either 
double-click on the analysis labeled Low Flow Analysis Test 11 from 
the study explorer, or from the Analysis menu select open, then 
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select Low Flow Analysis Test 11 from the list of available analyses.  
When test 11 is opened, the Volume Frequency Analysis editor will 
appear as shown in Figure B-80. 

Figure B-80.  Volume Frequency Analysis Editor for Test Example 11. 

 

Shown in Figure B-80 are the general settings that were used to 
perform this frequency analysis.  For this analysis, the Use Log 
Transform option was selected, the Weibull plotting position method 
was selected, Analyze Minimums was selected, and the Calendar 
Year option was selected.  The Calendar Year option was selected 
because low flows are possible in late September, early November.  
Starting the year on January 1 minimizes the possibility of using the 
same low flow event in multiple years.  An end date of 31 December 
2007 was entered in the Time Window Modification.  This end date 
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was specified because not all the data for the summer of 2008 was 
available at the time of the analysis.    

Shown in Figure B-81 is the Volume Frequency Analysis editor with the 
Options Tab selected.  Features on this tab include an option to 
override the default Flow Duration values, an option to override the 
default Frequency Ordinates, and Output Labeling.     

Figure B-81.  Options Tab Shown for Test Example 11. 

 

Once all of the General and Optional settings are set or selected, the 
user can extract the volume-duration data.  Select the Duration Data 
tab and press the Extract Volume-Duration Data button at the 
bottom of the table.  The table should then fill with the flow-duration 
values, as shown in Figure B-82. 



Appendix B – Example Data Sets HEC-SSP User's Manual 

B-90 

Figure B-82.  Volume-Duration Data Table for Example 11. 

 

Once the data has been extracted, the user must choose to perform an 
Analytical or Graphical analysis.  In this example, an analytical 
analysis was performed.  Shown in Figure B-83 is the Settings tab for 
the analytical analysis.  As shown, the distribution selected for this 
example is LogPearsonIII.  The Skew option was set to Use Station 
Skew and the Do Not Compute Excepted Probability option was 
selected.  
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Figure B-83.  Settings Tab Shown for Test Example 11. 

 

Press the Compute button to perform the analysis.  A message 
window will open stating that a few of the annual maximums occurred 
during the beginning of the year.  The message suggests that the user 
change the year/season specification to capture independent events.  
You want to minimize the possibility that the same flood event is used 
for consecutive years.  Press the OK button to finish the computation.  
Once the computations have been completed, a message window will 
open stating Compute Complete.  Close this window and then select 
the Tabular Results tab within the analytical analysis.  The results 
table should look Figure B-84.  The top portion of the results table 
contains the percent chance exceedance for all durations (the report 
contains confidence limits).  The bottom portion of the results table 
contains the statistics for all durations. 
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Figure B-84.  Tabular Results Tab for Test Example 11. 

 

As shown in Figure B-85, the Plot contains a graph of the systematic 
data and the computed frequency curves.  Notice how some of the 
frequency curves look like they might cross if the lines were extended.  
The Statistics tab can be used to modify the computed statistics to 
ensure that the frequency curves are consistent.   
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Figure B-85.  Plot for Test Example 11. 

 

For this example, the standard deviation and the adopted skew were 
modified to make sure the volume frequency curves were consistent.  
As shown in Figure B-86, the check boxes next to mean, standard 
deviation, and adopted skew were checked and then user-adjusted 
statistics were entered into the table for all durations.  The Compute 
button must be pressed after adjusted statistics have been entered in 
order for the program to recompute the frequency curves using the 
user-adjusted statistics.  Figure B-87 shows the Plot tab after the 
user-adjusted statistics were entered on the Statistics tab.  Results in 
the Tabular Results table will also update when user-adjusted 
statistics are entered on the Statistics tab.    
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Figure B-86.  Statistics Tab for Test Example 11. 
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Figure B-87.  Plot Tab for Test Example 11. 

 

In addition to the Tabular Results and Plot tabs, graphical plots can be 
opened by selecting the Plot Duration Data or Plot Analytical 
Curve buttons at the bottom of the analysis window.  A plot of the 
results for this test example is shown in Figure B-88. 
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Figure B-88.  Plot of the Frequency Curve Results for Test Example 11. 

 

The tabular and graphical results can be sent to the printer or the 
windows clipboard for transfer into another piece of software.  To print 
the tabular results, select Print from the bottom of the analysis 
window.  To send the tabular results to the windows clipboard, 
highlight the data you want to send to the clipboard and then press 
the Control-C key sequence.  To print the graphical results, first bring 
up the graphical plot and then select Print from the File menu.  To 
send the graphic to the windows clipboard, select Copy to Clipboard 
from the File menu. 

In addition to the tabular and graphical results, there is a report file 
that shows the order in which the calculations were performed.  To 
review the report file, press the View Report button at the bottom of 
the analysis window.  When this button is selected a text viewer will 
open the report file and display it on the screen.  Shown in Figure B-89 
is the report file for Test Example 11. 

The report file contains a listing of the input data, preliminary results, 
outlier and historical data tests, additional calculations needed, and 
the final frequency curve results.  Different types and amounts of 
information will show up in the report file depending on the data and 
the options that have been selected for the analysis. 
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Figure B-89.  Report File for Test Example 11. 
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Example 12: Duration Analysis, BIN (STATS) Method 

This example demonstrates how to use the Duration analysis.  The 
data for this example is daily average flow from the Fishkill Creek 
(Beacon NY) USGS stream gage.  The period of record used for this 
example is from 01 Oct, 1944 to 30 Sep, 1968.  To view the data, 
right-click on the data record labeled "Fishkill Creek-Daily Flow" in 
the study explorer and then select Plot.  The data will appear as 
shown in Figure B-90. 

 
Figure B-90.  Plot of the Daily Average Flow for Example 12. 

 

A Duration analysis has been developed for this example.  To open the 
analysis editor for Test Example 12, either double-click on the analysis 
labeled Fishkill Creek Test 12 from the study explorer, or from the 
Analysis menu select open, then select Fishkill Creek Test 12 from 
the list of available analyses.  When Test 12 is opened, the duration 
analysis editor will appear as shown in Figure B-91. 
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Figure B-91.  Duration Analysis Editor for Test Example 12. 

 

Shown in Figure B-91 are the general settings that were used to 
perform this duration analysis.  For this analysis, the Bin (STATS) 
method was selected, the x-axis scale was set to Linear, the y-axis 
scale was set to Linear, and the Annual duration period was selected.   

The Options Tab is shown in Figure B-92.  Features on this tab 
include Output Labeling, the Percent of Time Exceeded ordinates, 
and Bin Limits.  The Bin Limits panel is active in this example 
because the Bin (STATS) method was selected on the General tab.  
The User-Defined bin limits method was selected and the bin limits 
were entered manually.   
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Figure B-92.  Duration Analysis Editor with Options Tab Shown for Test 
Example 12. 

 

Once all of the General and Optional settings are set or selected, the 
user can choose to compute the analysis by pressing the Compute 
button.  Once the computations have been completed, a message 
window will open stating Compute Complete.  Close this window and 
then select the Results tab, shown in Figure B-93. 
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Figure B-93.  The Results Tab for Test Example 12. 

 

As shown in Figure B-93, the Result tab contains both tabular and 
graphical results.  The Tabular Results tab contains a table with 
information about the bins, like the lower bin limit, the number of 
values in the bin, the accumulated number of values greater than or 
equal to the lower bin limit, and the percent of time equaled or 
exceeded for each bin.  Tabular results also include a table of the 
duration curve interpolated to the percent of time exceeded ordinates 
defined on the Options tab.  The Plot tab contains a graph of the 
duration curve, shown in Figure B-94.  The plot includes the computed 
duration curve and the duration curve interpolated to the user-defined 
percent of time exceeded ordinates.  The duration curve plot can also 
be opened by pressing the Plot Duration Curve button at the bottom 
of the analysis window.   
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Figure B-94.  Plot Tab for Test Example 12. 

 

The tabular and graphical results can be sent to the printer or the 
windows clipboard for transfer into another piece of software.  To print 
the tabular results, select Print from the bottom of the analysis 
window.  To send the tabular results to the windows clipboard, 
highlight the data you want to send to the clipboard and then press 
the Control-C key sequence.  To print the graphical results, first bring 
up the graphical plot and then select Print from the File menu.  To 
send the graphic to the windows clipboard, select Copy to Clipboard 
from the File menu. 

In addition to the tabular and graphical results, there is a report file 
that shows the input data and results for the analysis.  To review the 
report file, press the View Report button at the bottom of the 
analysis window.  When this button is selected a text viewer will open 
the report file and display it on the screen.  Shown in Figure B-95 is 
the report file for Test Example 12. 
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Figure B-95.  Report File for Test Example 12. 

 

 

 



Appendix B – Example Data Sets HEC-SSP User's Manual 

B-104 

Example 13: Duration Analysis, Rank All Data Method 

This example demonstrates how to use the Duration analysis.  The 
data for this example is daily average flow and the period of record is 
from 01 Apr, 1899 to 28 Jan, 2010.  To view the data, right-click on 
the data record labeled "Wondering River-Franklin" in the study 
explorer and then select Plot.  The data will appear as shown in Figure 
B-96. 

 
Figure B-96.  Plot of the Daily Average Flow for Example 13. 

 

A Duration analysis has been developed for this example.  To open the 
analysis editor for Test Example 13, either double-click on the analysis 
labeled Duration Curve Test 13 from the study explorer, or from the 
Analysis menu select open, then select Duration Curve Test 13 
from the list of available analyses.  When Test 13 is opened, the 
duration analysis editor will appear as shown in Figure B-97. 
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Figure B-97.  Duration Analysis Editor for Test Example 13. 

 

Shown in Figure B-97 are the general settings that were used to 
perform this duration analysis.  For this analysis, the Rank All 
DataValues method was selected, x-axis scale was set to Linear, the 
y-axis scale was set to Log, and the Annual duration period was 
selected.   

The Options Tab is shown in Figure B-98.  Features on this tab 
include Output Labeling, the Percent of Time Exceeded ordinates, 
and Bin Limits.  The Bin Limits panel is not active in this example 
because the Bin (STATS) method was not selected on the General tab. 
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Figure B-98.  Duration Analysis Editor with Options Tab Shown for Test 
Example 13. 

 

Once all of the General and Optional settings are set or selected, the 
user can choose to compute the analysis by pressing the Compute 
button.  Once the computations have been completed, a message 
window will open stating Compute Complete.  Close this window and 
then select the Results tab, shown in Figure B-99. 
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Figure B-99.  The Results Tab for Test Example 13. 

 

As shown in Figure B-99, the Result tab contains both tabular and 
graphical results.  The Tabular Results tab contains a table of the 
duration curve interpolated to the percent of time exceeded ordinates 
defined on the Options tab.  The Plot tab contains a graph of the 
duration curve.  The plot includes the computed duration curve and 
the duration curve interpolated to the user-defined percent of time 
exceeded ordinates.  The duration curve plot can also be opened by 
pressing the Plot Duration Curve button at the bottom of the 
analysis window, shown in Figure B-100.   
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Figure B-100.  Plot Tab for Test Example 13. 

 

The tabular and graphical results can be sent to the printer or the 
windows clipboard for transfer into another piece of software.  To print 
the tabular results, select Print from the bottom of the analysis 
window.  To send the tabular results to the windows clipboard, 
highlight the data you want to send to the clipboard and then press 
the Control-C key sequence.  To print the graphical results, first bring 
up the graphical plot and then select Print from the File menu.  To 
send the graphic to the windows clipboard, select Copy to Clipboard 
from the File menu. 

In addition to the tabular and graphical results, there is a report file 
that shows the input data and results for the analysis.  To review the 
report file, press the View Report button at the bottom of the 
analysis window.  When this button is selected a text viewer will open 
the report file and display it on the screen.  Shown in Figure B-101 is 
the report file for Test Example 13. 
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Figure B-101.  Report File for Test Example 13. 
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Example 14: Duration Analysis, Manual Entry 

This example demonstrates how to use the Duration analysis and enter 
the duration curve manually.  To open the analysis editor for example 
14, either double-click on the analysis labeled Manual Duration 
Curve Test 14 from the study explorer, or from the Analysis menu 
select open, then select Manual Duration Curve Test 14 from the 
list of available analyses.  As shown in Figure B-102, the “None” data 
set was selected for this analysis.  The Manual Entry tab becomes 
active when the “None” data set is selected (the Result tab will 
become inactive).    

Figure B-102.  Duration Analysis Editor for Test Example 14. 

 

The y-axis scale was set to Log while all other default options were 
selected on the General and Options tabs.  Figure B-103 shows the 
Manual Entry tab for Test Example 14.  A variable name of “FLOW” 
and units of “cfs” were entered as well as the duration curve.  The 
program will plot the duration curve when the Compute button is 
pressed.         
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Figure B-103.  Duration Analysis Editor with Options Tab Shown for Test 
Example 14. 

 

The duration curve plot can also be opened by pressing the Plot 
Duration Curve button at the bottom of the analysis window, shown 
in Figure B-104.   
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Figure B-104.  Plot Tab for Test Example 14. 
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Example 15: Coincident Frequency Analysis, A and B 
can be Assumed Independent 

This example demonstrates how to create a coincident frequency 
analysis.  Figure B-105 illustrates the scenario for Example 15.  The 
goal of this example is to develop a stage-frequency curve at a point 
along the tributary (variable C) given flows on the tributary (variable 
A) and flows in the mainstem (variable B).  Large flows on the 
mainstem do cause backwater along the tributary and thus affect the 
stage at the point of interest.  The data for this example comes from 
an existing flow frequency curve for Variable A and an existing flow 
duration curve for Variable B.  An HEC-RAS model was used to 
simulate the response of Variable C (stage at the point of interest) for 
multiple combinations of flow on the tributary and flow in the 
mainstem.   

 

 
Figure B-105.  Scenario for Example 15.  

 

A Coincident Frequency analysis has been developed for this example.  
To open the Coincident Frequency Analysis editor for test example 15, 
either double-click on the analysis labeled Coincident Freq Test 15 
from the study explorer, or from the Analysis menu select open, then 
select Coincident Freq Test 15 from the list of available analyses.  
When test 15 is opened, the Coincident Frequency Analysis editor will 
appear as shown in Figure B-106. 
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Figure B-106.  General Tab Shown for Test Example 15.  

 

Shown in Figure B-106 are the general settings for this coincident 
frequency analysis.  For this analysis, the A and B can be Assumed 
Independent (Marginal Frequency Curve for A) option was 
selected.  This would be determined by performing a correlation 
analysis between variables A and B; little correlation would indicate 
that variables A and B could be assumed independent.  The number of 
variable B index values was set to 9, the Data Name was set to 
“Stage” and the Data Units to “feet”, and the y-axis scale was set to 
Linear.   

Shown in Figure B-107 is the Coincident Frequency Analysis editor with 
the Variable A Tab selected.  The Manual Entry option was selected 
and a Data Name of “Flow” and Data Units of “cfs” were entered.  
The frequency curve values were manually entered into the Variable 
A Frequency Curve table.  



HEC-SSP User's Manual Appendix B – Example Data Sets 

 B-115 

Figure B-107.  Variable A Tab for Test Example 15. 

 

Shown in Figure B-108 is the Coincident Frequency Analysis editor with 
the Variable B tab selected.  The Duration Curve from Test 13 was 
selected in the drop-down list.  Once selected, the duration curve table 
automatically fills with the computed ordinates from the duration 
curve.  In the Develop Probabilities from Duration Curve panel, 
the Define Automatically option was selected.  This option uses a 
predefined probability pattern to discretize the duration curve into 
index points.  The Generate Table button was pressed in order 
activate the predefined probability pattern.  In this example, the first 
index value is 3005.92 (cfs).  This value is taken at the midpoint 
between percent of time exceeded values at 100 and 60 percent (from 
Duration Curve Test 13).  This index value is assigned a probability of 
40 percent; this flow value could be expected 40 percent of the time.  
The second index value is 8095.9.  This value is taken at the midpoint 
between percent of time exceeded values at 60 and 40 percent and is 
assigned a probability of 20 percent.        
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Figure B-108.  Variable B Tab for Test Example 15. 

 

Once the Variable A and Variable B tabs have been completed, the 
user can populate the response curves table.  Figure B-109 shows the 
Response Curves tab for Test Example 15.  The Same Variable A for 
Each Index option was selected and the Import Variable A button 
was pressed to automatically copy values from the Variable A tab and 
fill in the Variable A column.  The remaining columns in the table 
were populated with results from a hydraulics model.  For example, 
the first value in the second column is 479.16.  This value is the stage 
at the point of interest given a flow of 60219.18 (cfs) on the tributary 
(variable A) and a flow of 3005.92 (cfs) on the mainstem (variable B).  
A total of 108 simulations were required from the hydraulics model to 
fill in the response curves table.  Figure B-110 shows a plot of the 
response surface.  The plot shows variable A (x-axis) and variable C 
(y-axis).  For this example, the response surface shows that flows 
greater than 53000 (7th index point) on the mainstem affect the stage 
at the point of interest on the tributary.  When the flow in the 
mainstem is below 53000 (cfs), only the flow on the tributary affects 
the stage at the point of interest.  
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Figure B-109.  Response Curves Tab for Example 15. 

 

 
Figure B-110.  Response Curves Plot for Example 15. 
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Press the Compute button to perform the analysis.  Once the 
computations have been completed, a message window will open 
stating Compute Complete.  Close this window and then select the 
Results tab.  The results tab should look Figure B-111.  The left 
portion of the results tab contains the computed variable C frequency 
curve and the right portion of the results tab contains a plot of the 
computed variable C frequency curve.   

Figure B-111.  Results Tab for Test Example 15. 

 

The tabular and graphical results can be sent to the printer or the 
windows clipboard for transfer into another piece of software.  To print 
the tabular results, select Print from the bottom of the analysis 
window.  To send the tabular results to the windows clipboard, 
highlight the data you want to send to the clipboard and then press 
the Control-C key sequence.  To print the graphical results, first bring 
up the graphical plot by pressing the Plot button from the bottom of 
the analysis.  Then select Print from the File menu.  To send the 
graphic to the windows clipboard, select Copy to Clipboard from the 
File menu. 

In addition to the tabular and graphical results, there is a report file 
that shows input data and results.  To review the report file, press the 
View Report button at the bottom of the analysis window.  When this 
button is selected a text viewer will open the report file and display it 
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on the screen.  Shown in Figure B-112 is the report file for Test 
Example 15. 

Figure B-112.  Report File for Test Example 15. 

 

 

 



Appendix B – Example Data Sets HEC-SSP User's Manual 

B-120 

Example 16: Coincident Frequency Analysis, A and B 
can not be Assumed Independent 

This example demonstrates how to create a coincident frequency 
analysis when variables A and B are not independent.  Figure B-113 
illustrates the scenario for Example 16.  The goal of this example is to 
develop a stage-frequency curve at a point along the tributary 
(variable C) given flows on the tributary (variable A) and flows in the 
mainstem (variable B).  Large flows on the mainstem do cause 
backwater along the tributary and thus affect the stage at the point of 
interest.  The data for this example comes from existing conditional 
flow frequency curves for Variable A and an existing flow duration 
curve for variable B.  An HEC-RAS model was used to simulate the 
response of variable C (stage at the point of interest) for multiple 
combinations of flow on the tributary and flow in the mainstem.   

 

 
Figure B-113.  Scenario for Example 16.  

 

A Coincident Frequency analysis has been developed for this example.  
To open the Coincident Frequency analysis editor for test example 16, 
either double-click on the analysis labeled Coincident Freq Test 16 
from the study explorer, or from the Analysis menu select open, then 
select Coincident Freq Test 16 from the list of available analyses.  
When test 16 is opened, the Coincident Frequency analysis editor will 
appear as shown in Figure B-114. 
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Figure B-114.  General Tab Shown for Test Example 16.  

 

Shown in Figure B-114 are the general settings for this coincident 
frequency analysis.  For this analysis, the A and B can not be 
Assumed Independent (Conditional Frequency Curve for A) 
option was selected.  This would be determined by performing a 
correlation analysis between variables A and B; a correlation 
coefficient in the range of 0.3 – 0.7 would indicate that variables A and 
B could not be assumed independent.  The number of variable B index 
values was set to 9, the Data Name was set to “Stage” and the Data 
Units to “feet”, and the Y-Axis scale was set to Linear.   

Shown in Figure B-115 is the Coincident Frequency Analysis editor with 
the Variable A Tab selected.  A Data Name of “Flow” and Data 
Units of “cfs” were entered.  A separate frequency curve for variable A 
was developed for each index value defined on the Variable B tab.  For 
example, the frequency curve in the “Flow P(A|B1)” column is the 
variable A frequency curve for the 1st variable B index value.  The 
variable B tab shows the 1st index value, 3005.92, is assigned a 
proportion of time of 40 percent.  Therefore, the 1st variable A 
frequency curve was developed using annual peak flows on the 
tributary when flows in the mainstem were in the range of the 1st 
variable B index value.  For this example, a multivariate lognormal  
random number generator was used to develop a large enough data 
set so that variable A frequency curves could be computed for each 
variable B index value.  The random numbers were generated using 
statistics from the annual peak flows occurring on the tributary, 

http://www.google.com/search?hl=en&&sa=X&ei=Ktp2TObFDI-isQPRmtWgDQ&ved=0CBEQBSgA&q=multivariate+lognormal&spell=1�
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statistics from the coincident (same day) flows occurring on the main 
stem, and the covariance between the two datasets.    

Figure B-115.  Variable A Tab for Test Example 16. 

 

Shown in Figure B-116 is the Coincident Frequency analysis editor with 
the Variable B Tab selected.  No duration curve was selected for this 
example.  In the Develop Probabilities from Duration Curve panel, 
the User-Specified Index Points and Probability Ranges option 
was selected.  The probabilities and index values were defined 
manually and the Generate Table button was pressed in order to 
compute the Break Points.   
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Figure B-116.  Variable B Tab for Test Example 16. 

 

Once the Variable A and Variable B tabs have been completed, the 
user can populate the response curves table.  Figure B-117 shows the 
Response Curves tab for Test Example 16.  The Different Variable A 
for Each Index option was selected.  When selected, a separate 
Variable A column is added for each variable B index value.   For 
example, the first Variable A column is linked to the C = f(A,B1) 
column.  The second variable A column is lined to the C = f(A,B2), and 
so on.  The Import Variable A button was pressed to automatically 
copy values from the Variable A tab to fill in appropriate Variable A 
column.  The remaining columns in the table were populated with 
results from the hydraulics model.  For example, the first value in the 
second column is 473.95.  This value is the stage at the point of 
interest given a flow of 42464 (cfs) on the tributary (variable A) and a 
flow of 3005.92 (cfs) on the mainstem (variable B).  A total of 108 
simulations were required from the hydraulics model to fill in the 
response curves table.   
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Figure B-117.  Response Curves Tab for Example 16. 

 

Press the Compute button to perform the analysis.  Once the 
computations have been completed, a message window will open 
stating Compute Complete.  Close this window and then select the 
Results tab.  The Results tab should look Figure B-118.  The left 
portion of the results tab contains the computed variable C frequency 
curve and the right portion of the results tab contains a plot of the 
computed variable C frequency curve.   
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Figure B-118.  Results Tab for Test Example 16. 

 

The tabular and graphical results can be sent to the printer or the 
windows clipboard for transfer into another piece of software.  To print 
the tabular results, select Print from the bottom of the analysis 
window.  To send the tabular results to the windows clipboard, 
highlight the data you want to send to the clipboard and then press 
the Control-C key sequence.  To print the graphical results, first bring 
up the graphical plot by pressing the Plot button from the bottom of 
the analysis.  Then select Print from the File menu.  To send the 
graphic to the windows clipboard, select Copy to Clipboard from the 
File menu. 

In addition to the tabular and graphical results, there is a report file 
that shows input data and results.  To review the report file, press the 
View Report button at the bottom of the analysis window.  When this 
button is selected a text viewer will open the report file and display it 
on the screen.  Shown in Figure B-119 is the report file for Test 
Example 16. 
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Figure B-119.  Report File for Test Example 16. 
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Example 17: Curve Combination Analysis, Combine 
Flow Frequency Curves 

This example demonstrates how to create a curve combination 
analysis to combine multiple flow frequency curves.  In this example, a 
flow frequency curve from a log-Pearson III analysis will be combined 
with information from a hydrology model, frequency precipitation 
applied to a calibrated rainfall-runoff model, and an estimate of the 
PMF.  The frequency of the PMF is set to 0.00737 percent for this 
example.   

A Curve Combination analysis has been developed for this example.  
To open the Curve Combination Analysis editor for test example 17, 
either double-click on the analysis labeled Curve Combination Test 
17 from the study explorer, or from the Analysis menu select open, 
then select Curve Combination Test 17 from the list of available 
analyses.  When test 17 is opened, the Curve Combination Analysis 
editor will appear as shown in Figure B-120. 

 
Figure B-120.  General Tab Shown for Test Example 17.  

 

Shown in Figure B-120 are the general settings for this curve 
combination analysis.  The number of curves to combine was set to 3, 
“flow” was entered as the Data Name, and “cfs” was entered as the 
Data Units.  The Data Type of “Flow” and Y-Axis Scale of “Log” 
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were selected.  “Order Statistics” was selected as the Confidence 
Limits Method.  Finally, a frequency of 0.00737 was added to the 
User Specified Frequency Ordinates table.  

Shown in Figure B-121 is the Curve Combination analysis editor with 
the Frequency Curves tab selected.  Frequency curve 1 was imported 
from an existing Bulletin 17B analysis.  The Existing Study Analysis 
option was selected and then the Bulletin 17B analysis named 
“Reservoir Inflows” was selected.  The second frequency curve was 
entered manually using output from a hydrology model.  The third 
frequency curve contains an estimate of the PMF.  After the frequency 
curves were defined, a weight was specified for each ordinate in the 
frequency curves.  The program uses these weights when computing 
the combined frequency curve.      

Figure B-121.  Frequency Curves Tab for Test Example 17. 

 

Shown in Figure B-122 is the Curve Combination analysis editor with 
the Confidence Limits tab selected.  Since the Order Statistics 
method was selected as the confidence limits method, the user must 
define an equivalent years of record for each frequency curve ordinate.  
The program uses the equivalent years of record when computing the 
confidence limits using the order statistics method.  When the 
Compute Confidence Limits button is selected, the program will first 
compute the combined frequency curve and then compute the 
confidence limits around the computed frequency curve using the 
order statistics method.   



HEC-SSP User's Manual Appendix B – Example Data Sets 

 B-129 

 
Figure B-122.  Confidence Limits Tab for Test Example 17. 

 

Press the Compute button to perform the analysis.  Once the 
computations have been completed, a message window will open 
stating Compute Complete.  Close this window and then select the 
Results tab.  The results tab should look Figure B-123.  The left 
portion of the results tab contains the computed frequency curve with 
confidence limits and the right portion of the results tab contains a plot 
of the computed combined frequency curve.   
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 Figure B-123.  Results Tab for Test Example 17. 

 

The tabular and graphical results can be sent to the printer or the 
windows clipboard for transfer into another piece of software.  To print 
the tabular results, select Print from the bottom of the analysis 
window.  To send the tabular results to the windows clipboard, 
highlight the data you want to send to the clipboard and then press 
the Control-C key sequence.  To print the graphical results, first bring 
up the graphical plot by pressing the Plot button from the bottom of 
the analysis.  Then select Print from the File menu.  To send the 
graphic to the windows clipboard, select Copy to Clipboard from the 
File menu. 

In addition to the tabular and graphical results, there is a report file 
that shows input data and results.  To review the report file, press the 
View Report button at the bottom of the analysis window.  When this 
button is selected a text viewer will open the report file and display it 
on the screen.  Shown in Figure B-124 is the report file for Test 
Example 17. 
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Figure B-124.  Report File for Test Example 17. 

 

 

 

 

 

 

 

 



Appendix B – Example Data Sets HEC-SSP User's Manual 

B-132 

Example 18: Curve Combination Analysis, Combine 
Stage Frequency Curves 

This example demonstrates how to create a curve combination 
analysis to combine multiple stage frequency curves.  In this example, 
a stage frequency curve that was fit graphically to observed annual 
maximum stage data will be combined with information from a 
hydrology model, frequency precipitation applied to a calibrated 
rainfall-runoff model, and the maximum stage from the probable 
maximum flood simulation.     

A Curve Combination analysis has been developed for this example.  
To open the Curve Combination Analysis editor for test example 18, 
either double-click on the analysis labeled Curve Combination Test 
18 from the study explorer, or from the Analysis menu select open, 
then select Curve Combination Test 18 from the list of available 
analyses.  When test 18 is opened, the Curve Combination Analysis 
editor will appear as shown in Figure B-125. 

 

 
Figure B-125.  General Tab Shown for Test Example 18.  
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Shown in Figure B-125 are the general settings for this curve 
combination analysis.  The number of curves to combine was set to 3, 
“Stage” was entered as the Data Name, and “feet” was entered as 
the Data Units.  The Data Type of “Stage” and Y-Axis Scale of 
“Linear” were selected.  “Order Statistics” was selected as the 
Confidence Limits Method.  The Frequency of PMF panel was used 
to estimate the frequency of the PMF event using observed regional 
maximum precipitation.  The 72-hour PMP for a storm of 450 square 
miles was 29.2 inches and the greatest regional 72-hour observed 
precipitation for a 450 square mile storm was 19.5 inches.  The 
recommended values for the low and high range of the PMF were 
entered and the Compute Frequency of PMF button was pressed.  
This resulted in an estimated probability for the PMF of 0.0000737 or 
0.00737 percent.  This value was added to the User Specified 
Frequency Ordinates table.  

Shown in Figure B-126 is the Curve Combination analysis editor with 
the Frequency Curves tab selected.  Frequency curve 1 was entered 
manually by copying the graphical frequency curve from the Reservoir 
Inflows general frequency analysis.  The second frequency curve was 
entered manually using output from a hydrology model.  The third 
frequency curve contains an estimate of the maximum stage from the 
PMF.  After the frequency curves were defined, a weight was specified 
for each ordinate in the frequency curves.  The program uses these 
weights when computing the combined frequency curve.      
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Figure B-126.  Frequency Curves Tab for Test Example 18. 

 

Shown in Figure B-127 is the Curve Combination Analysis editor with 
the Confidence Limits tab selected.  Since the Order Statistics 
method was selected as the confidence limits method, the user must 
define an equivalent years of record for each frequency curve ordinate.  
The program uses the equivalent years of record when computing the 
confidence limits using the order statistics method.  When the 
Compute Confidence Limits button is selected, the program will first 
compute the combined frequency curve and then compute the 
confidence limits around the computed frequency curve using the 
order statistics method.   
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Figure B-127.  Confidence Limits Tab for Test Example 18. 

 

Press the Compute button to perform the analysis.  Once the 
computations have been completed, a message window will open 
stating Compute Complete.  Close this window and then select the 
Results tab.  The results tab should look like Figure B-128.  The left 
portion of the results tab contains the computed frequency curve with 
confidence limits and the right portion of the results tab contains a plot 
of the computed combined frequency curve.   
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Figure B-128.  Results Tab for Test Example 18. 

 

The tabular and graphical results can be sent to the printer or the 
windows clipboard for transfer into another piece of software.  To print 
the tabular results, select Print from the bottom of the analysis 
window.  To send the tabular results to the windows clipboard, 
highlight the data you want to send to the clipboard and then press 
the Control-C key sequence.  To print the graphical results, first bring 
up the graphical plot by pressing the Plot button from the bottom of 
the analysis.  Then select Print from the File menu.  To send the 
graphic to the windows clipboard, select Copy to Clipboard from the 
File menu. 

In addition to the tabular and graphical results, there is a report file 
that shows input data and results.  To review the report file, press the 
View Report button at the bottom of the analysis window.  When this 
button is selected a text viewer will open the report file and display it 
on the screen.  Shown in Figure B-129 is the report file for Test 
Example 18. 
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Figure B-129.  Report File for Test Example 18. 
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